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Trust In Security

hat is it about screensavers that gets a million unsuspecting people
Wclicking on a worm every time? Every year brings new e-mail worms
that are the fastest ever and the largest ever, yet they all use the same
simple social-engineering trick. They exploit trust. If you are in someone’s

address book, you are likely to have trusted relationship with them. Thanks
very much for the screensaver, friend.

Why should you care, or even need to know about updates? They should just
happen in the background, without any need to know at all. There is already
too much complexity to deal with; no point in adding another decision-mak-
ing to the loop, when you can’t really make an informed decision. How do you
know how severe a flaw in your OS is? Every flaw is severe, if you are connect-
ed to the Internet.

Sumod Hajela

Anti-virus and firewall software let you update automatically. And users under- Assistant Editor

stand why they need to do so, see the importance of that need, and let them
et on with their business. An OS update, on the other hand, means that you Le i

J \ S ; ’ Every flaw is

have to choose with trepidation, from a list of updates presented to you.

The update for the critical flaw that knocked Windowsupdate.com off the SEVere, If yOLI

Internet was around for weeks before the attack occurred. Why did users

choose not to update their Windows? How does lack of trust sound? are ConneCted
77

Trustworthy computing means things don’t go wrong. It means that if things to the Internet

go wrong, your business won’t be disrupted while things get fixed. It means

that your data and your privacy are secure.

There is no trust. Things go wrong all the time. Patches that are intended to fix
the things that go wrong, mess up things that weren’t wrong in the first place.
And few people actually believe that when Microsoft is scanning your com-
puter, they are not going to read everything you want to keep hidden. They
don’t, but the impression is the only thing that counts. Security is all about
trust. If the good guys don't build trust, the bad guys win. And the ‘good’ guys
in this picture, have a long road ahead.

And while we wait, all we can do is cross our fingers and choose to update.
r C )
"’{L*.a-ﬂ-frf
V-

f
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FREEWARE

Crimson Editor 3.45
Size: 0.78 MB
Mindware\Software\Dev Tools

HTML Page Guardian 3.0.0715
Size: 1.07 MB
Mindware\Software\Dev Tools

iDailyDiary
Size: 1.45 MB
Mindware\Software\Home

Quotes
Size: 1.87 MB
Mindware\Software\Home

Download Express 1.4
Size: 0.38 MB
Mindware\Software\Internet

SurfSaver 2.3
Size: 5.33 MB
Mindware\Software\Internet

GIMP for Windows 1.2.5
Size: 5.85 MB
Mindware\Software\Multimedia

VCDEasy 1.1.6
Size: 9.95 MB
Mindware\Software\Multimedia

VirtualDub 1.5.4
Size: 0.59 MB
Mindware\Software\Multimedia

EasyOffice 2001 with PDF Filter 5.72
Size: 76 MB
Mindware\Software\Office

Fresh Diagnose
Size: 1.11 MB
Mindware\Software\System

Password Shield 1.0
Size: 0.56 MB
Mindware\Software\System

PGPfreeware 8.0.2
Size: 8.44 MB
Mindware\Software\System

]
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KNOW YOUR CD
PLAYWARE\ARENA\EXTRAS

This section brings you a
selection of new levels,
upgrades, patches, add-
ons, maps and other stuff
to make your gaming expe-
rience better. This month
we have patches for Chaser,
WarCraft Ill: The Frozen
Throne and Humvee Assault. =

The Chaser patch upgrades the game

MUST TRY SOFTWARE

The Hulk

In this 3D action fighter you fight a
stream of soldiers in a gas station and

then face off a tank. The Hulk's various
punches and shooting moves work in
combination with directional move-
ments and each other, so a controller
works better than the keyboard.

Size: 166 MB

Playware\Arena\Games

PowerDVD 5

The PowerDVD trial version offers com-
plete DVD playback, with a plethora of
tweakable features just to suite your taste.
It supports worlds leading standards for
DVD playback on a PC. It supports Dolby

(ol |

] to v1.47 and fixes prob-
lems pertaining to sound,
anti-cheat and server
memory allocation. The
WarCraft patch fixes
some map crashes while
the Humvee Assault patch
addresses problems such
as random crashes and
slow loading times.

Digital, Dolby Headphone, Dolby Pro
Logic Il, DTS and SRS TruSurround XT
audio features.

Size: 6.5 MB

Mindware\Software\Multimedia

WindowBlinds

WindowBlinds is a desktop enhancement
software. It changes the look of windows
completely. After installing the program,
you will have a fully skinnable user inter-
face. You can change many things such
as the style of the title bars, buttons, tool-
bars, etc. The current version uses a

Microsoft certified way of extending Win-
dows XP to support additional ‘visual
styles’. Apart from cosmetic effects, it also
adds skins on the title bars of windows,
MP3 players etc. The software also pro-
vides customised control over the double-
click, and the right-click actions on the
title bar, and many other enhancements.
Size: 5.05 MB

Mindware\Software\Home
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BY DEMAND

You get to choose what goes on Digit Interactive.
This month, you have chosen:

Yahoo! SiteBuilder 1.0.1
> Size: 15.4 MB
Mindware

The Great Escape
» Size: 240 MB
Playware

Expect these on the October 2003 CDs

WEB SPECIAL

Where there is -
a WLL, there is
a way

N

lij ' 2
It’s starting off carrier wars !
all over the country, but
can WLL-CDMA services
possibly be the ones to ig

get India connected?
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Mio 8380

® What is it?

It is the first cell phone
designed by Microsoft and
Intel that will be manufac-
tured by Mitac—a Taiwan-
based PC manufacturer. Mio
will cost between $565 and
$598. It goes on sale in
Europe later this year.

m What does it comprise?
It uses Microsoft’s Smart-
phone 2002 and Intel’s
PXA255 200 MHz processor.
It is a GSM with a 65,000-
colour 2.2-inch TFT-LCD
screen. It also has a digital
camera with features such
as auto-focus and auto-
brightness controls. Mio
also has PC tools such as
Internet Explorer, Outlook
and MSN Messenger

® Why should | use it?
Mio allows users to do tasks
such as managing docu-
ments, e-mailing, and down-
loading multimedia files in
the familiar Windows inter-
face. It can play mp3 files
and videos in MPEG-4
compression format.

snhapshot

35 million
Americans

download

MUSIC files

and aboyt_
26 million

share files online.

Source: Pew Internet and American
Life Project
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Unzippin stuck zips

verybody’s favourite
Ecompression format, the

zip format, may soon be
incompatible across different
decompression tools. It all
started with the introduction
of the AES encryption feature
in two of the popular zip
tools—WinZip and PKZip.
PKZip implemented AES
encryption, but didn’t disclose
any details. Later on, when
WinZip implemented it, the

resulting  encrypted
archive turned out to
be incompatible. How-
ever, by default,
WinZip and PKZip use
the same non-encrypt-
ed version that is com-
patible with the long-
stable standard zip format, and
should be usable by all. The
encrypted archives though,
will not be compatible across
different tools, at least for now.

You will either have to avoid
using the encryption feature or
be sure that the recipients
know which tool was used to
zip and lock.

Arcade Ahoy!

hough not quite in the
league of Electronic Enter-
tainment Expo (E3), the Classic
Gaming Expo 2003 that took
place over the 9th and 10th
August brought together over
1200 vintage
@ gamers to Las
E - Vegas. With
L=}
the expo cele-
brating everything about the
gaming industry’s colourful
past—from ancient coin-oper-
ated arcade games, to those
built for the Apple I, Amiga,
Atari 2600 and the Com-
modore 64—this was a celebra-
tion of the history as well as
simplicity, charm, and appeal
of yesteryear’s games. The event
also brought together video
gaming legends including
Activision  designer  Steve
Cartwright and Rob Zydbel,
both of whom worked on sev-
eral Atari VCS game titles. The
event’s highlights included an
exhibition that puts hundreds
of ancient gaming devices and
memorabilia on display, as well
as the chance to play over 50
arcade games for free.

High Speed Wireless Multimedia

he Institute of Electrical

and Electronics Engineers
(IEEE) has put forth its new
802.15.3 standard for wireless
personal area networks
(WPAN) that allows data trans-
fer rates up to 55 megabits
per second, thus substantially
increasing the 1 mbps speed.
According to the IEEE, it allows
up to 245 wireless devices to be
connected within 300 feet.

The distance plays an
important role in speed. For a

distance of 300 ft, the trans-
mission speed would be 22
mbps, while for a distance of
165 ft, the users will get the
maximum speed of 55 mbps.
This standard has come up
due to a demand for connect-
ing multiple devices at low cost
and running high-bandwidth
applications. In order to min-
imise costs, the need of external
components has been kept low
and the required two chips fit
within a compact Flash Card.

To phone a Thief

hieves are now sure to

have a tough time
selling stolen mobile
phones. Phonetrack,
launched by Phone-
track  Africa Ltd,
inserts identification
marks, such as the
owner’s photo-
graphs and alter-
nate phone numbers into the
mobile phones permanently.
“Our facility configures the
handset’s motherboard, mak-
ing it hard to erase the photo

ILLUSTRATIONS: Mahesh Benkar

and the alternative phone
numbers because doing
this  would mean
destroying the phone,”
says Ernesta Jalipa,
director of Phonetrack.

The company is
currently working on a
software that
would enable
it to block the handset in case
of theft, by using the phone’s
serial number. Re-activation of
the hand set will be possible
after recovery.

= Microsoft to release Office 2003 on October 21, 2003 = Nokia to acquire Sega technology for multiplayer Internet-based gaming

FEM 12
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Google’s news
for you

oogle is now going

beyond just giving you all
the search results in the world.
A new feature in Google News
lets you monitor a topic and
receive e-mail alerts just as
news reports on that topic
break out. Still under beta test-
ing, the
Google
News Alerts
tool  pro-
vides you
daily notifi-
cations or
bulletins as
the news is reported.

A number of Web-based
services such as Yahoo! and
MSN have begun showing a
keen interest in the search
engine business and are gear-
ing up for the big fight with
Google. Yahoo! has already
attempted to even out the
competition by providing cus-
tomised news alerts too.

statattack

Stamp of Identity

Snail mail could soon be get-
ting smarter, if recent
research by the US Postal Ser-
vice (USPS) is successfully
implemented. According to its
study, mail could be more effi-
ciently tracked and delivered, if
sender identification tech-
niques are built into the
postage systems of the future.
The USPS is looking into creat-
ing personalised stamps that
embed digital identification

information. It claims that not
only will this enhance tracking,

Tell us more, and WIN!
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Microsoft: Copycat Monopoly?

federal jury in the US

ordered Microsoft to pay a
sum of US$ 520 million as
damages to Chicago based
Eolas (Embedded Objects
Linked Across Systems) and
the University of California.
Eolas claimed that Microsoft
used its system of placing
small interactive content such
as applets on Web pages with
Internet Explorer that was
bundled along with Windows.
The University of California

Whao cares?
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holds the patent to the system
while Eolas owns the technol-
ogy rights.

The final damages figure
was calculated to be US$ 1.47
as royalty per unit for the 354
million copies of Windows,
sold from November 1998 to
September 2001. Microsoft
said that the patent did not
have any validity and that it
would be filing an appeal
against the verdict and the
damages awarded.

Sony wades
through
gloomy waters

Sony PS2 sales dropped by
almost 2 million as com-
pared to last year. To remove the
gloom, Sony is planning to pro-
vide a push

for its next SOOI Y
generation

products—the PSP portable
gaming console and the PSX
home entertainment system.
The PSP is Sony’s answer to the
Nintendo Game Boy Advance—
the undisputed leader in the
portable console gaming indus-
try. The PSX is tipped to be an
entertainment system integrat-
ed with a Playstation. Both
appear to be quality products
that could capture the market if
appropriately priced.

but also ensure overall security
of the mail system. However,
civil liberty activists are quick to
point out that this violates the
right to privacy and free speech
as it denies you the option of
sending mail anonymously.

redalert
Backdoor.Sdbot.P

Backdoor.Sdbot.P—a variant
of Backdoor.Sdbot—is a back-
door Trojan Horse that affects
all Windows systems. The
infected system allows unau-
thorised remote access. The
Trojan infects the %System%\
Mscedit32.exe file, modifies
certain registry values and
takes control of the IRC client
in the infected PC, using
which it downloads and
executes files to launch DOS
attacks on a target defined by
the creator.

Remove the Trojan by dis-
abling system restore and
reverse the changes made to
the registry. Also update the
virus definition. Visit ttp://
securityresponse.symantec.com/
avcenter/venc/data/backdoor.sd
bot.p.html for further details.

W32.Sobig.F@mm
This is a mass mailing and net-
work-aware worm that infects
all Windows systems. It scans
the host for files with exten-
sions such as txt, wab, htm,
etc., and sends a copy of itself
to all the addresses it finds in
these files. The worm uses its
own SMTP engine to propa-
gate and attempts to create a
copy of itself on accessible
network shares. It uses a fake
sender address (admin@
internet.com) when it
propagates itself. Visit
http://securityresponsel.
symantec.com/sarc/sarc.nsf/
html/w32.sobig.f@mm.html to
download the removal tool.
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Microsoft
under siege

new worm, let loose on the

Internet last month, infect-
ed Windows 2000 and XP sys-
tems by exploiting a security
flaw. According to Symantec,
around 423,000 systems were
affected. Named the Blaster
worm, it contained code to
launch a scheduled DDOS
attack on the windowsup-
date.com site on August 16th.
The worm was programmed to
attack http://windowsupdate.com,
from where Microsoft had been
redirecting users to http://win-
dowsupdate. microsoft.com, which
is the actual URL. Eventually, it
overcame the attack by dis-
abling the automatic re-direc-
tion. A removal tool is available
at http://securityresponsel.syman-
tec.com/sarc/sarc.nsf/html/w32.blas
ter.worm.removal.tool.html.

A variant of the Blaster
worm—Nachi—uses the same
security hole to enter the host to
remove the Blaster worm file. It
then downloads the patch auto-
matically from the Micro-soft
site and closes the security hole.

In another incident, a DOS
attack on its premier site,
Microsoft.com, caused it to be
inaccessible for around two
hours. Claiming that this was
not an attack by the Blaster
worm, the company officials
said that they were investigat-
ing the occurrence together
with the FBI.

shapshot

In 2003, over 13
million smart
phones are

expected to be

sold—many of them

powered by the

Symbian OS

Source: IDC

Microsoft now atop

your TV

M icrosoft announced a tie-
up with Time Warner
Cable and Comcast Corp,
which dominate the US cable
TV market, to conduct field tri-
als of its set-top box software.
Time Warner will test TV Inter-
active Program Guide (IPG)
software while Comcast will
test Microsoft’s TV Foundation
Edition, along with IPG.

IPG enables users to find
shows and customise viewing.
On the other hand, the TV
Foundation Edition allows
operators to create channels
that can be easily found and

bought by the consumers, as
well as broadcast a variety of
other services and applications
such as games, news and
weather updates. Another soft-
ware—Microsoft TV Advanced
—enables the cable to be shared
as an Internet connection, thus
saving cost to the consumer.
Microsoft has also signed
up with three companies in
Mexico, which have already
begun sending out set-top
boxes with Interactive Pro-
gram Guide (IPG), Founda-
tion Edition software and
Microsoft TV Advanced.

Mexican rice-chips

Microchips that provide
information  ranging

from identification to health
records are now being sold in
Mexico. The chip, dubbed as
VeriChip, is the size of a rice
grain and can be
implanted painless-
ly in the arm or

hip, using a

syringe-like
device. Health
officials and
security guards
can read data
stored on the
chip using a
scanning device.
The chip costs $150

and has an annual fee of $50.
The scanning device has a
price tag of $1,200. Currently,
the chip can be tracked from
a distance of 5 miles. But its
developers, Applied Digital
Solutions Inc, have
announced plans to
produce a chip that
could be tracked using
satellites. This would
also help tracking
down kidnapped peo-
ple and missing
individuals.
This technolo-
gy is already
used in US for
tracking pets.

SCO Updated

anta Cruz Operation(SCO)

has announced a license
scheme to legalize their copy
of Linux, according to which,
all end-users using Linux ker-
nel 2.4, or later, need to get
the SCO Intellectual Property
License. The prices vary

from $699 to run Linux
on asingle CPU server, _i ’

sco

to $199 for a desktop
PC. Incidentally, $7.3

million of its revenues in the
third quarter of this year came
from its SCO source licensing
division.

In a related development,
Aduva Inc has come up with
OnStage that removes any
code violating the
SCO license and

downloads
alternate code
automatically.

e
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Attaboy ATi!

Microsoft has teamed up with
ATi to design graphics chips for
the successor to the Xbox. ATi
also has a similar deal with Nin-
tendo to design graphics chips
for the GameCube console.

Hypertransport

IBM, Texas Instruments, EMC
and four other companies
have joined the HyperTrans-
port consortium—a move
that will increase its usage.
IBM has already used
HyperTransport in its
PowerPC 370 chip.

) zeroes

GNU

For nearly three months, a
cracker gained access to the
primary FTP servers of the
GNU project. The attack was
discovered only in late July this
year, but officials confirmed
that no code was altered to
insert any malicious code.

USB Sticks

The small and easy-to-use USB
sticks have gained notoriety
for being used to smuggle
data from offices. Security
firms are coming up with
products to restrict their usage
in workplaces.

Tell us more, and WIN!
fum to panz 106

= Debian Linux-one of the largest volunteer distributions of Linux-turns 10 = Sony unveils a new 8-megapixel digital camera targeted at professionals.
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HAM to the rescue

he recent power outage

crisis that swept across
the eastern United States
also put the high-tech com-
munication links used by
emergency services in a
quandary. It was up to the
HAM radio enthusiasts to
keep the police services, fire
fighters, Red Cross officials
and other workers connected
in what is now defined as
the US’s most extensive
power outage since 1977.
With battery backups and no
need for servers and cell

phone towers, American
Radio Relay League (ARRL)
volunteers were in contact
with the Red Cross and the
Office of Emergency Manage-
ment, within five minutes of
the power going down. The
volunteers, for instance, con-
nected one hospital to its
ambulance fleet as it went out
of power. Officials estimate
that between 800-1000 ARRL
volunteers were handling
communications on the 15th
and 16th of last month, till
power was restored.

Wi-Fi traffic
jam

esearchers at the Centre

Nationale de la Recherche
Scientifique (CNRS), Paris,
claim to have found a critical
flaw in wireless LAN technol-
ogy used for Internet hot-
spots that could cause a slow
user accessing the network
to slow down everyone con-
nected to the same access
point. The problem lies with
the CSMA/CA (Carrier Sense
Multiple Access/Collision
Avoidance) access protocol
that is supposed to grant
equal access to the hot spot
by all connected devices.
This means that users capable
of higher speed will get only
as much bandwidth as the
slowest user.

This will not be apparent
to most Web surfers though.
The speed bottleneck whilst
accessing the Internet through
wireless LAN is usually not due
to the LAN, but the actual
Internet connectivity support-
ing the LAN. Considering
this, the 1 MB limitation
shouldn’t be too restrictive.
But users accessing large files
within the LAN will definitely
feel the pinch.

Txt-a-flop
Ignoring the the fact that
the current multi-million
dollar movie lack originality
or just fail to impress, indus-
try pundits have a new
explanation for the nose-
diving ticket sales. And if
you would believe the movie
makers, the blame is being
placed on teenagers, who
send their friends text
messages via cell phone with
their verdict on the movie.
These messages spread at
an alarming pace causing
higher rates of average

audience drop-off—the num-
ber of less viewers in the
subsequent week.

Five years ago, the average
drop-off between the opening
weekend and the next week-
end was 40 per cent. Movie
makers point out that this
summer’s average is 51 per
cent and drop-off effects are
visible on the second day after
opening. A good example is
Terminator 3: Rise of the
Machines that witnessed a 56
per cent drop over the first
week itself.

Peace, brother

eagate has tied up with the
National Insurance Compa-
ny (NIC) in India for ‘Peace
of Mind'—an
insurance poli-
cy for new PCs
with a Seagate
hard disk that will cover a wide
range of computer compo-
nents, regardless of the brand.
However, it does not cover
the PC’s plastic casing, mouse,
keyboard and any other exter-
nal peripherals.
Lately, resellers and cus-
tomers have been complaining

& seagate.

about the higher failure rate of
Seagate drives and ‘Peace of
Mind’ seems to be a part of its
effort to clean
up its act.

Under this
three-year
insurance policy, consumers
will be reimbursed for repair or
replacement of parts, regardless
of whether the PC is branded
or assembled. Currently, VMS
India Ltd has been appointed
as the one point contact for
registering the policy as well as
claim related queries.

§pam’s the
name

It’s official, and its true—it
may soon be illegal to use
the term spam, at least for
Seattle based company, Spa-
mArrest. The name ‘Spam’
was copyrighted decades
back by Hormel Foods, who
package their version of pork
with the same name.

Though spam has gained
notoriety recently as unso-
licited commercial e-mail,
and most people would not
immediately associate it with
pork, Hormel isn’t amused,
and has filed a legal petition
with the US Patent and
Trademark Office to desist
SpamArrest. The spat started
when SpamArrest, which
specialises in blocking junk
e-mail, decided to trademark
its name. Hormel decided to
fight back, claiming that the
name was too close for com-
fort. However, legal analysts
say that the case may not be
as watertight as Hormel
would like it to be.

Back at you
Anti-spam activists are hav-
ing a field day plastering
New Zealander, Steve Atkin-
son’s address and personal
details all over the Web.
Atkinson, the man behind
the spam that promoted
male potency products,
reportedly sent close to 100
million messages a day
before a newspaper article
revealed his personal details.
He has now been spammed
back by frustrated victims
with a vengeance—his
servers were forcibly relocat-
ed to another network, and
he has decided to get out of
the spam business.

= The safety monitoring system of USA’s David-Besse nuclear power plant was disabled for over five hours due to the Slammer worm attack
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pulse =
= News

More gadgets,
more bins

he US government has

made it mandatory for all
air travellers to get gadgets
such as laptops, cell phones,
radios, pagers, music players,
digital camera, etc, checked at
the security. Travellers will
have to place them in separate
checkpoint security bins to be
scanned with an X-ray.

Post 9/11, The Transporta-
tion Security Administration
(TSA) started ordering trav-
ellers to place their laptops in
these bins. However, ever since
reports claiming that Al-
Qaeda could use common
electronic items carried by air
travellers to hide weapons,
every gadget is being checked.

Experts advice travellers to
sync their devices and take
backups, in case the gadgets
get damaged.

Tell us more, and WIN!
furn tn page 106

Club Nintendo

intendo, the popular

Japanese video game
maker has announced a new
customer loyalty program
called ‘Club Nintendo’. The
scheme has been compared to
a frequent flyers programs.
Sign up for the program and
you will be awarded points
every time you make a Nin-
tendo software purchase. You
can exchange these points for
free gifts such as a limited edi-
tion control for the Game-
Cube, which will not be com-
mercially available. The com-
pany’s president, Mr. Satoru

lwata, is hopeful that the
new program will help boost
sales by increasing customer
loyalty and improving brand
value. Club Nintendo will be
launched in Japan and the
United States by the end of
the year and hopes to have
3,00,000 to 5,00,000 users
sign up for the program with-
in the first year itself.

Nintendo will also return
to selling simpler software
for a larger audience of
customers rather than con-
stantly increasing the com-
plexity of its games.

P has decided to launch
more than 100 products
in anticipation of a competi-
tive holiday shop-
ping season that
would begin
shortly. The prod-
uct launch covers
the traditional
strong points of the company
such as imaging products and
home computing products.
A noteworthy product is
the HP Photosmart 7960
Photo Printer—a top-of-the-
line industry level printer for
quality photo printing; The

73

A Hundred-product launch

HP Scanjet 4600 ‘See-Thru’
scanner that was launched is
characterised by a radical
ultra-thin vertical
design for wuse in
cramped conditions.
The HP Photosmart
Mobile camera allows
you to create, edit
and transfer images on the
go. Another product launch
of interest was the DVD
Movie Writer dc3000 that
allows you to transfer video
from tape onto a disk easily,
using the analog video
capture facility.

quoteworthy

“We certainly would
urge third parties
who want to continue
(hosting the MSN
software) to contact
us before October 15
when they will no
longer be able to
access the network”

Microsoft spokesman,

Sean Sundwall. Microsoft is
making it mandatory to
upgrade to MSN Messenger
5, or higher and Windows
Messenger 4.7.2009, or
higher, that are not yet com-
patible with third-party multi-
ple instant messenger clients

“Technology works
well when used to
help qualified and
well-trained human
beings. Technology
can never replace the
human being.”

Issac Yeffet, the founder of
Yeffet Security Consultants,
an airline security firm, and
former EI-Al head of global
security, stating that mere
technology cannot improve
airport security; the people
manning the machines
should be trained and

equipped properly

Nokiais tipped
to capture more than
40 per cent

of the cell phone
market in 2004
and should sell

more than 203
million units
worldwide.

Source: Strategy Analytics

tomorrow’stechnology

Analyse me

Cognitive computing looks
at developing machines
that accurately assess user
intent, and learn from previ-
ous interactions. Researchers
at the Sandia National Labora-
tories, USA, are working on
developing a computer along
with a software that could
eventually think like a person.
Earlier systems tend to work
within logical processes, some-

thing that we humans don’t
always do. Later, the focus
shifted to machines that could
be considered as synthetic
humans—those that looked at
the more logical cognitive pat-
terns as well as organic factors.
Cognitive psychologist, Chris
Forsythe, and his team then
moved to looking at integrat-
ing robotics with models of
human cognition, and realised

that the model could be
used to create intelligent
machines. Currently, the

Sandia team is looking at
‘extraordinarily  perceptive
techniques’ with cognitive
systems to aid analysts and
critical decision makers in
jobs that involve interpreting
meaningful patterns based on
large data volumes derived
from diverse sources.

= Microsoft releases warnings of critical Internet Explorer, MDAC flaws = Dell cuts prices of notebooks, desktops, servers and peripherals as well
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DVD disparity

Sumod,

Thanks for the Linux DVD. We hope that Digit will maintain its trendsetting ways by

moving away from CDs, and bundling only DVDs with every issue. You are also

helping the environment by bundling 4.7 GB worth of software on one disk, instead

of many. | liked Vipul Shah’s column on spam, and look forward to more. Also,
please devote an article to GPRS, and tell us more about the hand-

~=, sets and services available.

Hello sir,

Thank you for the most useless thing | ever got. Not
a single person | know has a DVD-ROM drive. Can
you imagine the frustration? None the less, it was
good thinking to give us poor readers such valuable
programs and OS's that we cannot use!

Naved A ) e
. . | . o .
Via e-mail Yo -, | 3 ¢ Meeta P Doshi
1 ] o L - -
\ - r .Q:?,.' Via e-mail
Hi Digit, = i
| have been reading Digit for a number of "i'} < Sir,

My congratulations to you on the wonderful DVD, | was looking for-
ward to the Linux issue for many months. I've installed Red Hat, and it's
running perfectly. This e-mail is sent using Ximian Evolution (an Outlook
clone) that | got from your DVD. You should have covered installing and
removing applications a little more. Also, many applications that you
gave in the software section of the DVD were already in the
distributions—Evolution, for example. You could have used

years, and compliment you for the excel-
lent coverage. So, at first glance, | was very
happy to see Linux software with your Aug 03
issue, but was disappointed and disheartened
to find that these are on DVD, and not a CD. |
am sure you know that most of us have CD-
ROMs! Hence, you have disappointed us.
Please carry the Linux distributions on future CDs.

o W
ILLUSTRATIONS: Mahesh Benkar
that space to give us some more goodies!

Colonel JK Maindiratta Hari Krishna P
Via e-mail Via e-mail
Dear Sir, Hi,
| am a subscriber of Digit and a true fan. Keep it up! Please review DVD-Writers, as

What made you think that the majority of your read-
ers have DVD drives?

Gopal Goswami

Via e-mail

| am sure many of us are eagerly awaiting that.

Sarfaraz Khan
Via e-mail

can- Linux know—how

Hi Digit,
Your DVD rocky...
dlstributions_

Thanks for the pointer Rajesh. Though this method involves the
dreaded ‘command line’, it does indeed eliminate the need to write CDs.
We have a complete step-by-step workshop for doing this on
www.thinkdigit.com for those of our readers who feel comfortable with

a text mode Linux install process.

Rajesh Goli
Via e-mail

Your vote counts

This month’s question:
Question: What is the your primary means of Internet

access?
m  Dial-up
®  Broadband

Q. Your reason for not trying out Linux yet...

e 21.4%

> 21.6%

Too hard to
install/use

Don’t know why
| should try

®  Mobile phone

My favourite
application missing

Linux rules my desk

Response: 1,940 Log on to www.thinkdigit.com and vote
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Points to ponder...

Dear Sumod,

I have three points to make:

1. Set aside economics for a moment,
and there’s just one reason why the
general user prefers Windows over
Linux—'familiarity’. While we
might consider having Linux as
the ‘second’ OS, a central shift to
Linux is unlikely anytime soon.

| suggest you have a column
dedicated to it in Digit. After

all, in real life, as in technology,
familiarity is pretty much everything when it comes to mass accept-
ance and usage.

2. You've given imaging tips on Paint Shop Pro, Illustrator and
Photoshop, but missed out on Ulead Photolmpact 8, which, in my
opinion, far exceeds the capabilities of Paint Shop Pro, and even gives
Photoshop a run for its money. This software has never been featured,
even in past reviews. You even included a Photolmpact demo, in a
recent issue, but ignored its potential—I say this as a long-term
Photolmpact user with a legal and registered license.

3. The August issue of Digit was being sold by ‘agents’ at CST station,

e to carry SgSE,
shift in the Linux
pution. Until & couple of

Dear Vicky,
The reason W_hy
despite our wish

peen abl

e have not
W lines the

to do so, under

Mumbai, on August 1 itself, and that too for only 50 bucks. As a sub- 1o profiting from distri istribute any
marketplace t0 P nload and di
scriber, | got the same issue late the next day, and | think | pay a little years ago, you could freely dO\rI]V‘ have to pay for it if you
more than that. Amusing, but true! Linux distribution, and W\?lell\%grsyare expecting 10 makf]
i . Now, . distribution, muc
\';‘_atfal Jé_\lyafamaﬂ Wantedﬁsglr?ﬁ?g sale of copies of thzlr d‘sgfx\t;?r\\/endofs
ia e-mai i money . SuSE and som
; d software. ! on these
- ; like any other b - distribution for free
Dear Natraj, , ; d we do accordingly lined to share their GIST - ou will have to pay
i tion on Linux usage, an . declin istributions, Y
Weagree Wit Y= E br?c? rV:howing how to perform everyday tasks in grounds. If you want SuSE d
have a regular worksnop for them.

S Ca“e?hl:r;{usx ;I\(I)Oe;zfiy edition at Mumbai CST station, the S(()jgrtc‘e—
i AS fOL ious Mumbai CST is where we load our copies for dis r;
5 Q_Ulte rour d tﬁe country every month. During this Ioadmg procesd,
oot arogl?es inevitably 'fall off* the trains, with some helping htagsi

Z?Tsu?:en These 'fallen’ copies are the onest yo;estete;) F;Zdedlﬁz r?] o G f U

) of our country, .

thnit(:g' fbaecfto (gfeli\l\fg Ltjt,lzfltnc()ju:nd(i)ssttribution team has learned the hard way. 0 p S
al

m Kaushal Pai has point-
ed out that ‘Learn how
to Install and uninstall
Linux the easy way’,
should have pointed to
page 92, instead of page
62, as said on the index
page.

Graphics Drivers on CD
Hi Digit,

I.may not be the first one to notice it, but
s_lons of Windows Media Player, DirectX,
tials section of the Mindware CD every m
your Playware CD by creating a section t
_Iyst, audio, or video drivers. With nVi
Increase with the latest drivers,

consider this as a gamer’s plea Hi Saurabh,

YOu manage to include the same old ver-
Winzip, Acrobat Reader, etc., in the essen-
onth. I think you should do the same with
h_at will include the latest Detonator, Cata-
dia promising a 30 per cent performance

® An unfortunate design
error caused the capacity
and spindle speed values

on the hard disk tables to

. . _ . shift down, on pages 60
for more Fps. That's a great suggestion! However, there is little point in carrying these d61 Pag
Saurabh Maj i i an )
caurabh Majumdar drivers every month. We will ensure that our readers have access to
Via e-mail B such critical drivers, as well as motherboard drivers from Via and Intel, Notice any goof-ups?

as and when they are updated. Write to goof@jasubhai.com

Send your letters marked ‘Readers Letters’ to the Digit office:
E-mail: readersletters@jasubhai.com

D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul, Navi Mumbai 400 706,
Phone: 022-7629191/9200 Fax: 022-7629224
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features “u technology next

A closer look at some of today’s mobile power sources and
a peek at what'’s just around the corner

PDA in one hand, laptop in anoher,

when all of a sudden, the battery
dies. Blank, black screens both,—who you
gonna call? Owners of such gadgets find
themselves becoming less mobile than
ever, and are always on the lookout for
some place to plug-in and charge up.

So here you are, the snazzy bigshot—

The kind of battery that is required to
run these devices all day, whilst utilising
all their features, can only be found
under the bonnet of a car. Unless we're
willing to lug a monster of a battery
around for our mobile devices, we’re in
desperate need of better power solutions.

Power storage technologies have
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advanced quickly over the last few years.
But these advances have been outpaced
by the requirements of newer, more fea-
ture-packed portable devices. All batteries
used today rely on chemical reactions to
produce current. The only difference is
the chemicals used, and their construc-
tion. Engineers constantly struggle to
extract the most out of batteries—tireless-
ly trying new materials and constructions
to squeeze out maximum performance.

Batteries can be classified as primary
or secondary cells—secondary cells can be
recharged, whilst primary cells cannot.
Most power hungry portable devices run
on secondary cells.

The ideal battery should offer very
high energy densities, have a long service
life, and be really light and tiny. Good
batteries today, have only some of these
qualities. Hence we always settle for a
compromise, with the choice of battery
being determined by the device it is made
for. A mobile phone would need a tiny
battery, whereas a UPS system would need
the maximum possible power, with less
stress laid on its weight.

The most common battery types are:
Lead acid: The lead acid battery has been
around for more than a hundred years.
These are bulky, and only suitable for appli-
cations where weight is not a factor—car
batteries are the best example. This type of
battery is capable of delivering high power
useful for starting your car, but it has a rel-
atively low energy density and high self-
discharge. This is why your car doesn’t start
after your long vacation. Lead acid is the
most economical battery for larger power
applications, and is the preferred choice for
hospital equipment, wheelchairs, emer-
gency lighting and UPS systems.

Nickel cadmium (NiCd): NiCd bat-
teries have been around since the
1950s. They have matured over
time, and continue to deliver

good performance for situations
where long service life is most
important. These batteries
perform well past a thousand
cycles, but require proper
maintenance to do so. The
problem with NiCd batter-
ies is their low energy den-
sity and the memory effect.

NiCds also remain popular

because they are cheap, but
contain toxic chemicals that
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Handspring’s
new Treo 600
is the sign of
things to
come. It’'s a
full PDA with
a high-speed
processor,
integrated cell
phone, colour
display and a
digital camera
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are harmful for the environment.
Nickel-metal hydride (NiMH): The
main advantage of NiMH over NiCd is the
increased energy density, giving up to 30
per cent more power from the same size.
They also do not suffer the same extent of
memory effect as NiCd cells, but have a
lower cycle life. They are preferred for cell
phones and laptops due to their increased
energy density and the absence of harm-
ful toxic metals.

Lithium ion (Li-ion): Today’s star per-
former, the Li-ion cell is fast replacing
other technologies, especially as its cost
price continues to fall. Lithium’s light
weight and excellent electro-chemical
potential lets Li-ion batteries provide high
voltage and excellent capacities with
reduced weight. This is crucial for cell
phones, where the battery makes up most
of the weight of the device. Current Li-ion
technology provides twice the energy den-
sities of NiCd cells. Li-ion batteries are also
the easiest to maintain, since they have no
memory-effect problem and the self-dis-
charge is much less than other chemistries.
Li-ion is not without its drawbacks though.
Li-ion batteries do not last very long—typ-
ically a year or two before performance
starts to rapidly deteriorate. And this hap-
pens even if the battery is not in use.
Another drawback is that the pack must
have a protection circuit to regulate volt-
age during charge and use. They feature in
higher-end cell phones, laptops, digital
cameras and other expensive electronics.
Lithium ion polymer (Li-polymer):
Li-polymer is a derivative of the standard
Li-ion with huge potential. The difference
here is the type of electrolyte used—a solid
polymer electrolyte with a little electrolyte
gel added to increase ion conductivity. This
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means the battery is safer and more stable
than the standard Li-ion ones, and more
importantly, smaller. They can be flexible
and incorporated into the device’s protec-
tive casing, or even into your clothing,
measuring as little as 1 mm in thickness.
Li-polymer batteries perform about as
well as standard Li-ion batteries, with near-
ly the same capacities and no real cost
advantage. The packaging and size are the
promises that have led mobile phone man-
ufacturers to adopt this technology—the
packaging can be made of foil, like food
wraps. In the future though, capacities
should increase, as techniques to eliminate
the gel electrolyte and maintain safe oper-
ating temperatures are being researched.

Fill "er up

By far the most promising future power
source for mobile devices is the fuel cell.
Combustion engines use the pressure gen-
erated by igniting the fuel and convert it
into mechanical energy, to move your car.
Fuel cells do not burn fuel like a combus-
tion engine. They convert hydrogen and
oxygen into water, producing electricity
and heat as a by-product. The process is
silent, clean, and uses fuel very efficiently.
The cells will continue to produce power, as
long as hydrogen and oxygen are supplied.

How do they work?

Like batteries, fuel cells generate electrici-
ty through a chemical reaction. Hydrogen
enters the cell at the anode where a chem-
ical reaction separates the electrons. The
positively charged hydrogen atoms travel
through the electrolyte to the cathode. The
electrons are carried through a wire to the

@ Maintenance

Nickle-based batteries: Nickel based bat-
teries (NiCd or NiMh) suffer from memory-
effect build-up which reduces the perform-
ance of the battery. This memory effect has
been greatly reduced with newer technolo-
gies, but still remains an issue. This is caused
due to excessive charging, or repeated
charging without discharge. To avoid the
problem, do not leave batteries in the
charger for more than a few hours after the
charger indicates full charge. Also, periodi-
cally discharge the batteries completely. If
you do this at regular intervals, the usage
patterns between discharges become less
important. Using higher quality chargers
also improves the service life of your battery.
Lithium-based batteries: Lithium batteries

load (the device using the power), and
back to the cathode to complete the cir-
cuit. Oxygen enters the cell through the
cathode, and reacts with the positively
charged hydrogen atoms and the electrons
from the electrical circuit to form water.
This water is drained from the cell. Some
fuel cell designs incorporate extra equip-
ment to extract hydrogen from common-
ly available fuels such as natural gas and
methanol, for added convenience. These
systems are far less polluting than the
internal combustion engine.

The types of fuel cell differ basically in
the type of electrolyte used. Each type has
its own unique characteristics. For exam-
ple, the efficient, high powered alkali fuel
cells, which generated power for the Apol-
lo spacecraft, used a solution of potassium
hydroxide as an electrolyte. But these run
at temperatures close to 200 degrees cel-
sius, and risk electrolyte leakage.

Proton Exchange Membrane (PEM)
cells use a thin permeable membrane of
polymer as the electrolyte. The technolo-
gy was invented by General Electric in the
1960s. They are less efficient than alkali
cells but work at much more reasonable
temperatures, making them more suited
to consumer applications.

Micro Fuel Cells (MFC) will be used in
most portable devices of the future, and the
first prototypes generated 10 milliwatts of
power. The US Department of Defence has
funded the research through the Defence
Advance Research Projects Agency
(DARPA), to feed the mission critical
devices of tomorrow’s soldier. These troops
will be carrying around a lot of fancy
power-hungry gizmos that are currently

do not suffer from memory-effect like NiCd
and NiMh batteries do. In fact, they last
better if they are not fully discharged every
time they are used. Some engineers claim
that batteries with the ability to indicate the
level of charge do suffer from ‘digital mem-
ory'—a term used to refer to the inaccurate
indication of the level of charge. This indi-
cation becomes increasingly inaccurate
over time. To resolve this you can perform
a full discharge about once a month to
recalibrate this indicator. Lithium batteries
degrade when exposed to heat, so avoid
exposure to heat and operate the batteries
in a cooler environment whenever possible.
Do not buy spare batteries if you don’t plan
to use them for a while.
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being tested with relatively heavy Li-ion
packs which last up to 8 hours. MFCs could
drastically reduce the weight carried, and
give much longer run times with the added
benefit of almost instant recharging.

Japan’s NEC recently unveiled a lap-
top running on a methanol fuel cell
instead of a standard battery. The device
runs for about 5 hours in continuous
operation, and is expected to rise to as
much as 40 hours in 2 years time. Even
when the cell does run down, it will only
take a quick refill of fuel to get you up and
running, instead of the long recharges
associated with typical batteries. NEC’s
Japanese rival Toshiba has also
announced a similar fuel cell powered
laptop. Keep an eye out for both in 2004.

A company called Smart Fuel Cell has
also developed a usable micro fuel cell for
laptops and expects to produce 100,000
units by 2004. The prototype holds 120
ml of methanol and generates about 150
Wh—enough to power a 15 W notebook
computer for 10 hours. Recharging sim-
ply means changing the cartrige.

NTT DoCoMo, who provide third gen-
eration (3G) mobile services in Japan, also
have plans to commercialise fuel cell pow-
ered 3G phones, as early as 2004. With
large colour screens, high-speed Internet
access and video conferencing, current 3G

diithedi}

phones are plagued by low battery life. It
is hoped that the new phone will at least
match the battery life provided by their
current 2G models. Users can carry around
a cigarette lighter type container, that will
recharge the phone’s fuel cell.

Fuel cells unfortunately may be cum-
bersome to deal with, just like non-
reusable batteries. Consumers don’t like
the idea of having to go out and buy
replacement fuel packs. Smart Fuel Cell’s
laptop cell comes with tamper-proof
methanol cartridges that snap into the
device. But, this raises the issue of recur-
ring cost to the user, where he has to go
out and buy fuel. Methanol cartridges
should cost about $5 (Rs 230). The only
other alternative is to feed in fuel manualy,
which isn’t a tempting prospect either.

Availability of the right fuel will be
another issue for initial adopters. It will
probably be a while before you can go to a
convenience store and ask for a refill can of
methanol or hydrogen. The solution to
this problem does not lie in making hydro-
gen widely available, but rather, in mak-
ing fuel cells that use readily available
fuel—beer, for example, or for that matter
almost any type of alcohol served locally.
Researchers at St Louis University have car-
ried out development on a technology
called the Biofuel cell. A Biofuel cell uses

Jargon Buster

Electrolyte: This is a chemical com-
pound which, when fused or dissolved in
certain solvents, usually water, will con-
duct an electric current. All electrolytes in
the fused state, or in solution, give rise to
ions which conduct the electric current.
Energy density: This is the ratio of the
amount of energy in the cell, to the
weight or volume of the cell. It can be
measured in watt-hours per pound, or
watt-hours per cubic inch.

Cycle Life: This defines the number of
times a battery may be charged and dis-
charged. Every time a battery is charged
and discharged it uses one cycle.
Capacity: The amount of energy a bat-
tery can store is its capacity. Measured in
amp hours or milliamp hours, this is the
length of time the battery can supply
the required voltage.

maH: The milliamp-hour rating indicates
the number of milliamps the cell can
produce per hour. This means that a
1,000 milliamp-hour battery could pro-
duce 10 milliamps for 100 hours, or 100
milliamps for 10 hours, or (theoretically)
1,000 milliamps for 1 hour, or even
2,000 milliamps for 30 minutes.
Memory Effect: Nickel-based batteries in
particular, tend to ‘remember' their usual
discharge point. For example, if you con-
stantly recharge your battery after 50 per
cent consumption, after a period of time,
the remaining 50 per cent of your battery
chemicals become ineffective. This causes
the effective battery life to become only
50 per cent of what it was.

Self Discharge: A percentage of capacity
that the battery will discharge for a given
time, while the battery is not in use.

enzymes to catalyse the reaction. This
means you could theoretically take any
type of alcohol and pour it into your
device—and it would be cheap too. One of
the researchers claims that once the sys-
tem is fully optimised, one to three drops
of alcohol could power your cell phone for
amonth. Fuel cells also require air (for the
oxygen) and do emit minute amounts of
carbon dioxide and water vapour. A micro
fuel cell maker claims that the quanities of
water vapour emitted are similar to the
amount you have on your palm right now
and should not be of concern.

One way or another, there is no stop-
ping fuel cells. US President George Bush
has asked congress for $1.2 billion to fund
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Motorola’s Freecharge. Charge on the go!

research into hydrogen fuel cells. Most of
this research will look into larger applica-
tions such as replacing petrol engines in
cars. Private companies are falling over
themselves to develop fuel cells for
portable devices as these would command
a high premium in the relatively affluent
mobile phone and laptop markets.

What else can be done?
One age-old solution to the failing battery
is the solar panel idea. For years, calculators

have had dual power sources—button bat-
teries and a solar panel. The concept actu-
ally works very well for such low power
devices, but today’s high tech cell phones
and laptops require a really large surface
filled with solar cells to generate enough
power to run them, defeating the idea of
miniaturisation. A new type of solar cell
tackles that problem. It is inexpensive and
flexible, so that you can integrate it into
your clothes which occupy a huge surface
area. Scientists from the University of Cal-
ifornia at Berkeley have made a hybrid
nanorod-polymer solar cell which is about
one-thousandth as wide as a human hair.
The cells could be spin-cast onto almost
any material, including fabric, as they are
plastic-based, but deliver only 2 per cent
efficiency—as compared to 30 per cent by
today’s cutting edge solar cells. The
nanorod-polymer cells can’t power your
devices but they can provide an auxiliary
power source to charge batteries slowly.
Another way to make batteries better is
to simply make them charge faster. Amer-
ican battery maker Rayovac has developed
a method to fully charge NiMH batteries
in just 15 minutes—and getting to 90 per

1/4 AD

cent of full charge
in just 10 minutes.
This is achieved
by adding battery
monitoring, called
‘in-cell charge
control,” which
monitors the state
of the chemical
reaction during
charging. The bat-
teries will also give
better  perform-
ance than stan-
dard ones. They
will have a capaci-
ty of 2,000 maH
compared to the
normal 1,600
maH for AA cells.
While fast charg-
ing is definitely a
plus, it’s totally
useless if you sim-
ply have no place
at all to plug in.
Motorola
addresses just that
with its hand-
cranked charger
for cell phones.
Known as
FreeCharge, it

retails for $50 (Rs 2,350) and is based on
technology from a company called
FreePlay. A handle drives a generator,
which charges its own NiMH battery,
which in turn charges your phone. The
internal battery takes 35 minutes of wind-
ing to charge fully. Thankfully, you can
wind for only as long as you want, not the
full 35 minutes. The company reckons you
can get 4 to 6 minutes of talk time out of a
45 second work out.

A bizarre idea thought up by an engi-
neer at Compag uses human power, but no
extra effort. The idea is to use your key-
strokes to provide recharging power for
devices such as laptops. This could either
reduce the size of battery required, or
lengthen the device’s running time. The
design fits tiny magnets and wire coils onto
keys. Each keystroke generates a small cur-
rent that gets stored in a capacitor. The bat-
tery is slowly recharged from there Accord-
ing to the inventor, this could potentially
extend the battery life of a laptop to 10
hours—albeit after a lot of typing. The mag-
nets do add weight, but this weight is small
enough to be offset by lighter displays and
other components.

The prospects of certain future tech-
nologies reaching the market depend
heavily on power storage technologies for
them being co-developed. A flexible
screen, based on electronic ink, will
require a power source comparable to
itself. An Israeli company called Power
Paper has developed a battery that is
paper-thin. The anode and cathode are
literally inks that are printed onto paper
or other flexible materials. Unlike con-
ventional cells, the power paper design
requires no metal casing. The cell will pro-
vide 1.5 volts and is 0.5mm thick. Smart
cards, disposable cell phones, intelligent
clothing and even medical devices are
possible applications of the technology.

Making devices faster and increasing
functionality is what manufacturers stress
on. But some are taking notice of the lim-
itations of current battery technology,
and are trying to counteract with devices
that are smarter. Intel’s Centrino, for
example, is optimised for limted power
consumption. Optimisation of power
usage is the simplest way to increase bat-
tery time. As batteries continue to
advance and workable fuel cells are made,
your portable devices will become truly
portable, freeing us from the worry of that
dreaded battery dying.

KAIZAD VAIIFDAR
kaizad_vajifdar@thinkdigit.com
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SD-AV30 SD A/V »» |
j One-stop digital solution

The SV-AV30 is a 4-in-1 that allows you to take
your world of audio and video with you. You
................... can record up to 90 minutes of smooth motion
video in the MPEG4 format, at a resolution of
320 x 240. It holds up to 3 hours of MP3 or
AAC-compressed audio files, and can be used to
take photographs in the JPEG format.

y

_____ Powered by cutting-edge
' o tech wizardry,here are a
. o, few toys to lust after

Nokia Fun Camera Y
Click away in style ¥

The Fun Camera is compatible with Nokia MMS phones,
via a Pop Port connection. It also has a built-in 1.5 m
flash, and comes with 8 MB of internal memo-
ry. The images can be taken at three dif-
ferent resolutions—with a maxi-
mum resolution of

A Hitachi G1000
4 SMS delight AR AR

The Hitachi G1000 uses the Pocket PC
------------ 2002 OS and has a 400 MHz processor
""""""" with 32 MB of RAM. It has a rotating
camera which can be used to take
pictures at a resolution of 640 X 480
pixels. It also has a full text QWERTY-
style keyboard.
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GU87 Mobile Photo Phone  »»
Cellular dream come true

GU87 has a TFT colour display supporting
65,536 colours. The device also supports
16 polyphonic ring tones. The design is
sophisticated and the clamshell is sleek.

Sony CLIE PEG-UX50
The CLIE factor

The CLIE PEG-UX50 handheld uses the ' .

Palm OS and supports all Palm software. W VIR R S
The screen flips and rotates up to 180
degrees for easy viewing and working. The
CLIE:supports Bluetooth devices and:uses: b :. il iy b et i s R
the Sony handheld engine.

v |-Trigue 3450
Speaking of perfection

The stylish I-Trigue speakers support
bi-amplification and lateral firing
transducers for top notch audio

quality. The speaker system has two
Titanium micro drivers. It outputs

; IEE 9 W RMS per channel, with an inspiring
R ) 30 W RMS subwoofer!
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It looks good and the technology is glitzy, but does it do the job?

o ensure that our readers have all the infor-

I mation they need to make an informed buy-

ing decision, reviewers at the Digit Test Cen-

tre conduct comprehensive tests to evaluate the

latest hardware, software and technology services

in accordance with international standard evalu-
ation processes and methodologies.

Our test results may be presented either as
Comparison Tests, or as individual reviews in the
Bazaar section. The representation of the results is
different for each in the interests of clarity, but the
test process for both is identical in all respects.

Of all the products we test, only the best make
it to the A-List.

Comparison Tests

In the comparison tests, we compare the per-
formance of products within a particular category.
Each product is evaluated under different param-
eters such as performance, value for money, fea-
tures, ergonomics, etc.

Weightages are then applied to the various
test parameters according to their importance for
that particular category of products. These weigh-
tages are then used to arrive at scores for features,
ergonomics and performance for each individual
product. A detailed test process is included with
each comparison test, and explains the parame-
ters that were taken into consideration, along with
weightage allocation and reasons for the same.

In Bazaar
The evaluation of products in Bazaar also covers
the same parameters such as performance, ease of
use, value for money, build quality and features of
the product.
Here, each of these parameters is rated on a
scale of 5, which is represented by arrows (->).
The greater the number of arrows, the better
the product. This simple five-point rating system
is designed to give you an easy-to-interpret assess-

ment of a product. For example, a product that
receives a value for money score of five arrows
signifies an outstanding buy.

The Awards

Digit awards outstanding products by selecting
a Best Performance and Best Value winner in
each comparison test. The winner of the Best
Performance Award will be the product that scored
the highest in the performance segment combined
with rest of the package including features,
ergonomics, bundled accessories etc. This award
represents the best performing product in our tests
in terms of the complete package that is offered to
a customer. The winner of the Best Value Award
will be the product that scores the highest in our
value for money parameter which is derived
taking into account the ratio of a product's
ergonomics, performance and features to its price.
The product winning this award offers a good
combination of performance and features at a
great price. Since value for money takes into
account all scores for all parameters including the
price, this score will be used to arrive at a grade
(e.g. A+) for each product.

The 5-point Rating System used in Bazaar

expectations

»»»nr  Excellent: A brilliant combination of price, performance and features—far beyond

»rrrr  Good: A good buy, better than most products in its category

~»»p»  Average: Reasonably competent but nothing spectacular about the product

~»»»» Mediocre: Does not live up to expectations, needs improvement in many areas

application

=~»»» > Poor: has serious drawbacks and needs improvement before it can be used for its target
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HOCUS

FOCUS

31 cameras are all it takes for a perfect picture of the
digital camera scenario in India

he traditional film-based Single Lens Reflex (SLR) camera has always

enjoyed an upper hand over digital cameras. Be it an amateur or a

seasoned professional, the learning curve always starts with an SLR

camera, rather than a digital one. Quite obviously, the reason behind

this is the price. But then why are the manufacturers still raving and

ranting about the megapixel digital camera when the world seems
to be happy, clicking away with the trusty, albeit bulkier, old SLRs. So is the world
really ready to chuck them and adopt their digital conterparts?

The prime advantage of a digital camera (or a digicam, as it is popularly
known), is the manner and efficiency in which it lets you get classy photos. You
don’t need to load blocky film rolls into dull dark compartments, dole out cash
to have them developed, and some more cash to get them printed. All you have
to do is focus, click and then transfer the images onto a PC, or get them printed
right away! Furthermore, since the images are in the digital format, you can make
copies of them as per your convenience, or send and share them across the world
without spending a broken penny. It has to be granted that SLR cameras provide
unmatched image quality that cannot be surpassed by electronic sensors, but with
the recent advancements in CCD sensor technology and image processing algo-
rithms, digicams are on their way to wiping out any differences in that aspect of
photography. Already, high-end professional digicams offer image quality that is
on par with their film-based counterparts.

And the weather isn’t much different in the low-end and mid-range digicam
country either. Though they aren’t as abundant in advanced features, as their city
cousins, the professional digicams, they still manage to cramp in an assortment
of some of the best features boasted by the latter. But are they selling? Well, in the
last couple of years, the acceptance of digital cameras has increased tremendous-
ly. Currently the digicam market is growing at a rate of 75 per cent per year—an
evident enough testimony to the fact the popularity of these pocket rockets is
growing, and that even seasoned professionals are slowly, but surely, going digi-
tal. And like the trend of every technology shows, such demand only means (or
so we hope), that the prices will drop further, making it quite possible that we’ll
consider buying a digicam as often as we think of upgrading our PC configuration.

The Indian market seems to be gearing for such a scenario, with ample choice
of models for every budget and function-oriented enthusiast. We tested 32 cam-
eras, divided into the categories of Toycams, Mid-range and Low-end cameras.
And to stress our point, we, also, consulted a leading professional in the stream
of photo-journalism who shoots using only digicams.ﬁ]

SANKET NAIK & ALIASGAR PARDAWALA
sanket_naik@thinkdigit.com & aliasgar_pardawala@thinkdigit.com
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you’ve heard correctly. Not only are they cheaper than ever

before, manufacturers are also bringing out models that are
so basic that they can hardly be called low-end. Instead, we chose
to call them toy cam(era)s. Toy cams are basic, no-frills per-
formers that strive to provide decent picture quality and features
at the lowest possible price—most of them can be used as Web
cameras as well. These cameras are meant for users who just want
to take pictures and transfer them on to their PCs, and cost less
than Rs 15,000.

Another breed of cameras are the pseu-
do full-size models, which look like full-sized
digital cameras, but don’t offer the advanced
features mandatory to that kind. These are |
the gadgets that most folks have been head- |
ing towards, mainly for the consideration = |
they show for the buyer’s pocket.

So are these toy cams just playthings, as i
their name seems to suggest? Is their only
allure their price? Exactly what we intend to
find out!

I f you’ve heard that the prices of digital cameras are falling,

The Olympus C150 is ergonomically well

Test Analysis

We tested these cameras on various param-
eters such as the features offered, size, weight, overall ergonom-
ics of the camera and performance. (See box, ‘How We Tested’).
For performance, we took into account the details captured in
a photograph, the colour reproduction, and the brightness and
contrast levels of the final output.

designed

Features

Let’s zoom into the various features that these cameras offered.
The picture resolution is of vital importance to get a crystal clear
image—the higher the resolution supported, the better the qual-
ity of photos. In this regard, the twin cameras from BenQ—the
DC3410 and the DC2300, the PC-CAM 850 from Creative and
the Olympus C150 support a resolution of 2,048 X 1,536—excel-
lent for toycams.

Cameras with optical zoom are better for distant photog-
raphy, say when trying to capture a distant house on the edge
of a cliff. But none of these cameras come with optical zoom—
instead they try to compensate for lost ground with digital
zoom. Unfortunately, using digital zoom compromises picture
quality, so one can only use it only when it is absolutely nec-
essary. The BenQ siblings and the PC-CAM 850 were the only
cameras with 4X digital zoom. All the others either had no
zooming capabilities, or were limited to 2X.

Auto focus and macro focusing are other important param-
eters that you should keep in mind when buying a camera.
Auto focus helps you focus on a subject automatically, but for
a camera lacking it, you need to move either forward, or back-
ward, to focus. The same applies to macro focusing, where your
subject is extremely close to your lens, and you need to take a
perfect picture without any blurring. The Olympus C150 has
auto focus as well as a macro focus range of just 20 to 50 cms,
thus helping you to take the perfect picture. The creative PC-
CAM 850 was the only camera without focus features, making
it a typical point and shoot camera. Only what’s in the focus
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will appear in the image, resulting in a very flat image with
hardly any depth of field.

All the cameras had white balance settings, except for the
Frontech Wondercam and Logitech Click smart 510. All came
with four preset white balance options, and you can choose
one depending on the environment you’re shooting in. They
are better for shooting indoors, where one has the option to
switch from fluorescent to tungsten, depending on the lighting
in the room.

All the cameras store images in the compressed JPEG for-

mat, thus saving on space while preserv-
ing image quality.

Physical features and ergonomics
Physical features play an important role
! in the ergonomics of any handheld
device, even the camera—the placement
of the flash, lenses and light sensors must
be such that they are not obstructed by
your fingers. Unlike other portable gadg-
ets, cameras can be too light. The perfect
camera has to have just the right balance
of size and weight—heavy enough to keep
your hand steady when shooting, and
small enough to be pocketable.

The Olympus C150 Camedia was the best camera in this seg-
ment, as far as physical features and ergonomics are concerned.
It fits perfectly in your palm, and the contoured front lens cover
provides a good grip and stability, making up for the lack of a
rubber grip. Another camera worth mentioning here is the PC-
CAM 850. Its small size makes it ideal for one-handed operation,
which makes it great companion for outdoor shooting. The cam-
eras from BenQ were slim, long and pocketable, while the cam-

®
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What is depth of field?

Depth of Field (DOF) determines the capturing of multiple sub-
jects with the same lucidity, as the prime subject on which the
focus is set. You can achieve a better DOF by tweaking the aper-
ture, f-stop and zoom. These settings are not provided in a nor-
mal point-and-shoot camera. The lack of these setings make the
pictures look flat.

Smaller the aperture (opening of the overlapping blade) size,
greater will be the DOF. f-stop is an adjustment that controls the
lens’ diameter. The f-stop number increases with the decrease in
aperture size. Many cameras allow you to manually set the f-stop
to enhance the DOF.

A small aperture size allows less light to hit the CCD. There-
fore, set a slower shutter speed, preferably to the factory settings
for sufficient light to get in through the lens so that the image is
not underexposed.

Since the aperture opening will be less, the amount of light
hitting the CCD will also be less. The shutter speed will have to be
kept slower (at the factory setting), so that enough light gets in
through the lens and image is not left underexposed so as to
appear dull.
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How We Tested

We evaluated the cameras on the following parameters:
Features

We awarded points based on the various features

and capabilities of the camera, such as CCD (Charged Couple
Device) resolution, maximum image resolution supported, optical
and digital zoom, focusing types, metering modes, white balance
implementation, flash modes, shutter speed, storage, battery type
and video-out capabilities.

Ergonomics

We noted various aspects of the camera’s build, and looked for fea-
tures that enhanced its user-friendliness—aspects such as how com-
fortable it was to hold, the ease with which the menu can be navi-
gated, the size of the buttons, the placement of the flash and
whether it avoids the finger-over-flash syndrome, and the inclusion
of special menu-navigation buttons. The size and weight of a digital
camera were also taken into consideration.

Performance

Image test: We created a target scene to test the camera’s CCD
ability to reproduce colour and capture details correctly. The light-
ing was kept constant. We shot this scene by mounting the camera
on a tripod, and chose the highest possible resolution setting. We
used the camera’s flash and set other settings, such as the white
balance, metering and flash modes to Auto mode.

The target scene consisted of a table with flowers that provided a
wide tonal range. Gradations in shading and specular highlights
were brought out through shiny metallic objects, such as the table
clock and the metallic stand with the candle wrapped in plastic. The
table also had objects such as curtain lace, a table-cloth, stack of
books and the flower vase—all of which provided plenty of minute
details. The cameras were graded on the level of accuracy with
which each of these details was captured.

For the reference value, we shot the test scene with a profes-
sional film camera, and then scanned it on a very high-end scan-
ner, the same one we use to scan all the images published in Digit.
Next, we logged the values for each of the three components
using the histogram function in Photoshop. The components had
the following reference values: red = 147, green = 113, blue = 118

and luminosity= 124. These were compared with the values
obtained from each camera to measure the deviation of the images
from the optimal reference point.

Details test: To check for the accuracy with which details were
reproduced, we divided the entire test scene into three basic zones
that helped to analyse three characteristics of the camera. The first
zone, comprising varying shades of colour, determined the cam-
era’s colour capturing and reproduction capability. The second
zone comprised elements with details, such as wrinkles on the face
of the doll, and the keyboard text. This allowed us to analyse the
camera’s focusing ability. The third zone consisted of objects with
finer details such as the design of the curtain lace, etc. The exact
reproduction of these details gave an indication of the camera’s
detail capturing ability.

RGB test: To measure colour reproduction, we took a close-up of an
RGB circle, printed it on glossy paper, with the flash switched off. The
test RGB circle image was created in QuarkXpress so as to get true
red, green and blue colours, wherein the Histogram function in Pho-
toshop shows the value as 255 for each colour.

Zoom test: To test the zooming capability of the digicams, we
employed the 3X and 6X zoom cameras to take photographs of
a stationary target placed at approximately 15 feet. Based on
these photographs, we then analysed how close the cameras
could zoom onto the subject to provide clean, non-granulated
images.

Actual person test: In the actual person test, we shot the photo-
graph of a person under uniform lighting conditions with the cam-
era mode set to Auto. This yielded the real life performance of a
camera under indoor lighting. In the final image, we looked for
proper skin tone reproduction, white balance, uniform tonal repro-
duction under florescent lighting, etc.

Value for money

This is evaluated based on the performance and features offered by
the camera as compared to its price. Therefore, greater the per-
formance and features, and lower the price, higher will be the
value for money offered by a camera. We computed this value by
dividing the sum of the camera’s performance and features by its
price to obtain a value for money index.

1 Flowers, and the small ornament with variety of colours on

it, was used in the test scene to test the colour reproduction of
the digital cameras.

2 The Digit CDs, the keyboard and the wrinkles of the face of the
doll tested the cameras ability to focus across the length of the
frame uniformly.

3 For testing the cameras ability to pickup details, we introduced
the metallic figure with shining thread around its neck and waist
and the lace curtain as the background.

4 The metallic table pen stand, with clock and the glass filled
with green liquid were used to check the camera capability in
reproducing the specular effects (i.e the shiny effect created by
the reflection of light on metallic and glass objects).

5 Here, we checked the camera’s ability to pick up the variation
from dark to light regions.
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eras from Frontech and Vivitar simply lacked feel—they were too

light and lived up to their intended ‘toyness’.

Coming to menu navigation, some cam-

eras offer easy icon-based menu naviga-
tion, while others have a linear navigation
system controlled by one button. Samsung
Digimax 210 had the best menu navigation
of them all, with a superb tactile four-way
button. All cameras, except for the Vivitar
Vivicam 20, came with a memory upgrade
slot, supporting an SD card, a Smart media,
or an xD-picture card. Frontech was gener-
ous to offer 64 MB of internal memory
with its Wonder CAM—a memory that not
even higher-end cameras offer—followed

480 resolution. The file sizes are small (about 780 KB), which

means it can hold about 15 images—a decent enough capacity

The Creative PC-Cam 850 has a high res-

for a toycam.

Except for the Vivicam 20 and Won-
dercam, all the other cameras sported
neat LCD screens. This comes in handy
when previewing a frame in real time,
before clicking the image. It also lets
you preview the pictures you take, so
that you can decide whether you need
to do a retake.

On the power front, most cameras
run on AA batteries—the Logitech

Clicksmart 510 was the only camera that
required four AAA batteries. Most cameras

olution of 2048 x 1536

by the Olympus C150 with 32 MB. All the
rest of the cameras had a mere 8 MB to 16

MB internal memories. The Vivitar ViViCam 20 had 8 MB of
internal memory, which is enough, considering its low 640 x

either use two AA batteries, or come with
built-in chargeable batteries—such as the

BenQ DC3410. This can be both, good or bad, depending on the
scenario—good because you don’t need to keep replacing bat-

cC.rir
SCIORIE
BOARD
CATEGORY TOYCAMS
Beng Beng Creative Frontech Frontech Logitech
. Model DC3410 DC2300 PC-Cam 850 Wonder CAM Regal Cam ClickSmart 510
Max. Image resolution 2048 x 1536 2048 x 1536 2048 x 1536 1280 x 1024 1280 x 1024 1280 x 960
% Digital Zoom ax ax 4x NA 2x O
= Autofocus NA ] focus free NA 0 0
:{ Macro focus range (cm) 30 to 40 18 to 25 35 NA 20 to 25 40 to 91
i White balance settings Auto, 4 modes Auto, 4 modes Auto, 3 modes NA Auto, 3 modes na
% Red-eye reduction O0 O m] NA O O
Compressed image format JPEG JPEG JPEG JPEG JPEG BMP
%] Dimensions (I x w x d) cms 98 x 58 x 27 94 x 66x 40 NA NA 9.3x5.6x3.8 NA
§ Weight (grams) 135 140 0 100 120 NA
é Memory types supported SD card SD card SD card SmartMedia SD Card SmartMedia
g Memory included (MB) 16, internal 8, internal 16, internal 64 8, built-in 8, SmartMedia
z8 LCD Monitor O ] 0 O O O
B4 Battery form factor Built-in AA AA AA AA AAA
e Image Test (Photoshop) 2.6 1.6 10.65 1.8 0.4 1.85
4 Details Test (0-2 each) 4.25 6 1.75 2 3.25 0
5] RGB Target Test 0 4.87 0 3.47 1.97 1.75
el Zoom Test 2.5 2.5 2 1 1 0
P Period of warranty (Years) 1 1 1 1 1 1
&l Number of authorised service centres 18 18 NA 8 8 25
&1 Number of cities where service centres are present 8 8 NA 8 8 8
B Camera feature (30%) 13 13 13 13 13 13
o] Physical feature (15%) 8 8 8 6 8 6
gl Performance (50%) 9.35 24.96 14.4 18.26 6.621 36
§ Ergonomics (5%) 3 3.2 35 1 2 2.9
g Value for money 8.14 1 8.8 12.76 7.92 4.84
Grade [T+ L&) LC+ [0 ] = >
Contact BenQ India Pvt Ltd  BenQ India Pvt Ltd  Creative Labs Asia Jupiter Jupiter Logitech Far
International Ltd International Ltd East Ltd
Bl Phone 022-25705231 022-25705231 9820357713 022-22001211 022-22001211 022-24905149
g Fax 022-25705235 022-25705235 NA 022-22001214 022-22001214 022-24904145
Pl E-mail salesenquiryin@ salesenquiryin@ rajshekhar_bhatt@ frontech@ frontech@ response@
© beng.com beng.com ctl.creative.com bomb.vsnl.net.in bomb.vsnl.net.in logitech.com
Web site www.beng.co.in www.beng.co.in www.Creative.com  www.jil-jupiter.com www.jil-jupiter.com www.logitech.com
Price 9,899 9,799 9,599 6,500 8,200 11,250

* Not awarded the value for money since is too poor for us to reccomend buying it
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teries and its only a one-time investment, but bad if you're
outdoors, and run out of battery.

Performance

In the red spectrum deviation test, the Samsung Digimax 201
showed the least deviation—Iless than 10 per cent. Similarly, the
BenQ DC2300 and Olympus C150 Camedia were the only cam-
eras that were close to the Samsung 201’s performance. The Log-
itech ClickSmart 510 performed the worst, with a deviation of
greater than 25 per cent—essentially this means that if you shoot
something that is red in colour, the photograph will show it as
some other colour.

For the green spectrum deviation test, the Frontech Wonder
CAM hit the bull’s eye, with absolute zero deviation. The Sam-
sung 210 showed its mettle again by recording a deviation of
less than 5 per cent. Both the cameras from Vivitar performed
pathetically, with a deviation of over 25 per cent. The Logitech
510 also yielded below average scores.

The Frontech Wonder CAM again showed excellent colour

TOYCAMS

Olympus Samsung ViVitar Vivitar
€150 Digimax201 *ViViCam 20 ViViCam 3625 \
2048 x 1536 1600 x 1200 640x480 1600 x 1200
3.3x 2X ] 2X
0 NA O NA
20 to 50 18.06 to 25 23to 31 30.48 to 76.2
Auto; 4 modes Auto; 4 modes Automatic Auto; 4 modes
O | 0 O
JPEG JPEG BMP JPEG
6.7xM.2x4.0 9.39 X 6.6 x 4.06 9.8 x3.55 x6.02 NA
166 140 180 150
xD-Picture Card SD/MMC NA SD card
32 8, internal 8, built-in 8, built-in
O | O O
AA AA AA AA
9.2 1.3 0.4 0.4
5.25 6.75 0 2
413 6.63 1.75 1.97
2.5 2 1 1
1 1 1 1
8 12 6 6
8 8 NA NA
13 13 13 13
8 8 6 8
21.08 26.6 3.15 5.37
2.9 2.7 2 3.2
9.9 1 *15.18 6.82
(&) [&]) D >

Komal International Matrix Agency Anirox Technologies  Anirox Technologies

Ltd Ltd

022-22611274 022-23004061 033-228282372 033-228282372

022-22610219 022-23054631 033-22823086 033-22823086

indiaolympus@ matrixmk@vsnl.com vivek@anirox.com  vivek@anirox.com

vsnl.net
www.olympus.com www.samsungcamera.com  www.vivitar.com www.vivitar.com
9,995 9,995 3,500 9,500

Image size

Digital cameras come with 8 to 16 MB of built-in memory, and
more often than not, you will find this far too less to store your
photographs. The size of a high-quality image taken by a 3
megapixel camera will be around 2 to 2.5 MB. This permits you
to click not more than eight high-quality images. However,
choosing lower resolution brings down the file size to about
300 KB, and lets you store more images. Opt for a high resolu-
tion only when the image being captured is to be printed.
Images that are to be stored on your PC will look lively even at
a lower resolution.

Almost all cameras include the movie-capturing feature.
Some of them allow you to store video as much as the storage
space allows, whereas the others restrict the video storage to a
certain time limit. At an average, you can store just about 5
minutes of video footage at a resolution of 640 x 480. Hence, it
isn’t a very good idea to use the digital camera to make movies
while you are on the move and away from your PC.

depth in the blue spectrum deviation test, with a deviation of less
than 5 per cent. The Samsung 201 showed a deviation of more
than 10 per cent here. The BenQ DC3410, the Logitech 510 and
the Vivitar cameras all performed badly with deviations as high as
30 per cent. Such deviations are unacceptable and will lead to dark-
er images, even in sufficiently lit indoor settings.

In the luminosity test, the Samsung reclaimed its crown, with
negligible deviation. The Frontech Wonder CAM was the only cam-
era that gave the Samsung some competition here, deviating only
aper cent more. The cameras from Vivitar, Logitech and BenQ were
a total disappointment, with deviations as high as 30 per cent.

Samsung also topped the specular effects and gradation test,
with the BenQ twins coming in a close second. Overall, the Sam-
sung Digimax 201 emerges as an outright winner, with excellent
colour response, bright luminous images and a capability to catch
all effects perfectly.

In the details test, the BenQ DC2300, Olympus C150 Came-
dia and Samsung Digimax 201 were the only cameras that were
able to produce vibrant-looking photographs. The Creative PC-
CAM 850, Logitech Clicksmart 510 and Vivitar ViViCam 20 per-
formed the worst in this test—the pictures taken by them were
simply too dark to earn any marks. Similarly, none of the cameras
were able to reproduce Zone 2 of the details test, where we were
looking for the text on the keyboard and the wrinkles on the doll’s
face. Only the Olympus C150, BenQ DC3410 and Samsung Digi-
max 210 managed to give decent output. In Zone 3 of the details
test, we were expecting to see finer details, such as the pattern on
the curtain in the background, but
the results were disappointingly
poorer than Zone 2. Only
the BenQ DC 2300, Cre-
ative PC-CAM 850 and
Samsung Digimax 201
gave decent results.
The rest of the cam-
eras couldn’t detect
finer details, especial-
ly the Logitech Clicks-
mart 510, and both
the Vivitar models.
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The Logitech Clicksmart 510 yielded dark
photographs
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Jargon Buster

Artifacts: Artifacts are distortions in an image that are produced
by either the image sensor (CCD/CMOQOS), or the optical system.
Sometimes the image processing algorithms and the compression
algorithm (JPEG) are also responsible for Artifacts.

Digital zoom: Digital zoom is the magnification of an image by
the internal image processing algorithm. It is similar to the zoom
function in Adobe Photoshop. Due to the interpolation in real-
time, digital zoom can appear to be jerky.

DPOF: Digital Print Order Format is a system format that

allows a digital camera, or any other image capturing device, to
define how images are to be printed on DPOF compatible
printers.

View-finder: A view-finder is the window that you use to bring
a subject into the frame. The types of view finders are Optical,
EVF and the TTL. The Optical view-finder lets you view the sub-
ject through a small glass opening in the camera. An EVF (Elec-
tronic View Finder), simply projects a live image onto a small
LCD screen, as would be seen on an LCD monitor. The TTL
(Through The Lens) view-finders are the best, and are often
seen on high-end digital cameras. The image is relayed from
the lens through a mirror system directly onto a focus screen.
TTL and EVF view-finders are more accurate because they are
not affected by parallax errors.

Aperture priority: Aperture priority is a digital camera mode in
which you set the aperture range, and the camera automatically
adjusts the shutter speed to expose an image correctly. This is

Overall, the DC2300 from BenQ came out tops in the details
test, with the Olympus C150 and Samsung Digimax 201 follow-
ing with decent performances. The Logitech and the Vivicam 20
were major disappointments.

In the RGB target test, the Samsung Digimax 201 was the only
camera that was able to realistically reproduce the RGB target, with
only a slight deviation in the green spectrum, which, we found,
was a tough spectrum to reproduce across the board. The BenQ
DC2300 came in second, and the Olympus C150 Camedia came
in third. The Creative PC-CAM 850 and the Frontech Regal CAM
performed the worst—when we analysed the pictures, the RGB
target contained more black than any other colour.

In the zoom test, the BenQ siblings and Olympus C150 were
on par, taking the best looking close-up shots of the target, with-
out loosing on either picture quality, or details. The Samsung
Digimax 210 put up a brave fight, but lost on details. The Fron-
tech Regal CAM, and Vivitar ViViCam 3625 were total disap-
pointments, again.

And the winner is...
The market is flooded with these toycams, and their main appeal
is their low prices. But, only after using these cameras in differ-

www.think " [{.com
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useful to capture depth of field, or for special effects.

Shutter priority: In the Shutter priority mode, the shutter-speed
of a camera is set to full range, and the camera calculates the
best aperture to expose the image correctly. Shutter priority is
used to creating blurry effects when you want to show a fast
moving subject.

Manual focus: Manual focus allows you to disable the automatic
focusing of the camera, and focus on the subject by moving the
lens manually. Manual focus is used to take macro photographs,
or when shooting in low-light conditions.

Macro: A macro is a magnified image of a small subject. Any
image captured at a ratio higher than 1:1 is called a macro,
whereas anything less than 1:2 is called a close-up.

ISO speeds: In film photography, the ISO value of a film repre-
sents the film’s sensitivity. The lower the ISO speed, more the
light required to create an image. In a digital camera, the CCD
sensor takes care of this. A 200 ISO rated digital camera is recom-
mended, as CCD is slower than film. Digital cameras also offer
the advantage of on the fly ISO changing, but remember that
higher I1SO speeds tend to create noise in images.

Interpolation: Interpolation is an imaging method used to
increase the size of a digital image. Digital cameras often use
interpolation to produce digital zoom. Most image editing
packages also support interpolation, to resize images. The trade
off is the loss in image quality, which varies depending on the
algorithm used.

ent conditions
does one realise
that the images
are not at par with
the point-and-shoot
film cameras.

We suggest you
invest Rs 10,000 in the
Samsung Digimax, and
get a proper digital
camera with a few
manual override set-

The Digimax 201 hit the RGB right
on the target

tings and a digital
zoom, rather
than getting
stuck with a glori-
fied Web cameras that
just don’t deliver. The
Beng DC2300 is another
rﬂut camera which will not
— 4 - disappoint—it offers
Opt for the Frontech Wonder CAM if you decent image quality,
are committed to a small budget colour reproduction
and the flash also
helps. Logitech was a major disappointment, especially since it
manufactures world-class input devices and Web cameras. The
Frontech Wonder CAM was not impressive in the tests, but could
be a popular choice for those with shoe string budgets, as it is
priced at just Rs 6,500.
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Canon PowerShot A300

Fuji FinePix A303

Shot of power

he Canon PowerShot A300 is an entry-level 3.2 mega pixel

camera, which is capable of delivering 2048 x 1536 resolutions.
The camera has a 33 mm focal length equivalent to a 35 mm lens.
Targeted at the price-conscious user, it does not feature optical
zoom, which keeps its price under Rs 20,000. However, it does have
5.1X digital zoom—the highest in its class—that can only be used
outdoors, since it leads to visible pixilation when the subject is
brought too near after zooming. The camera supports an 1SO set-
ting of up to 400 that is needed when you have poor lighting, and
while using a high-shutter speed of 1/2000. Also, bundled along is
an external 16 MB Compact Flash memory, which can hold not
more than 10 to 12 high-resolution images. Therefore, use the
lower setting of 1024 x 768, or 1600 x 1200 for images that are not

aimed for printing. Memory can
i 3 be upgraded, since it’s not built-
i in.

On the performance front,
the camera did not disappoint
us. The test image was clear and
the colours were brilliant. The

— A300 also managed to repro-

duce the colour pink of the
coloured pencil, which was difficult even for some of the more
expensive cameras. The details that it picked up were not crystal
clear, but decent enough given its lens. It also produced impres-
sive specular effects on the metal clock and the liquid-filled glass,
which was difficult to produce for most low-end cameras. It dis-
appointed us a little when it was tested with the RGB target, as
it failed to pick up green. Instead, the green pie on the test print
was very dark. Hence, preview images involving greenery before
uploading them on your PC. It also returned average results when
tested for zoom. The zoomed subject appeared out of focus and
washed out.

The A300 weighs 175 gms, and is powered by two AA batter-
ies. The price of Rs 19,995 makes it the most affordable option in
its class, considering the features such as shutter speed range and
aperture adjustments that it comes with. It sure offers better value
for money to those in need of a low cost, feature-rich camera.

-ar

Canon PowerShot A300

+ Decent features, light weight Performance BEhER

A bit ive for its feat Features EEEER
-/ .| expensive for its features Ergonomics T
Price: Rs 19,995 Value for money & k & k K

Good features, bad build

FinePix A303 has an impressive list
of features such as the 3.24
megapixel CCD that can be used to
capture high-resolution images. The
3X optical and the 3.2X digital zoom
give you breathtaking landscape pho-
tographs. Different white balance set-
tings, such as incandescent, fluorescent and
sunny, let you adjust the camera to different lighting
conditions. The shutter speed range of 1/2 to 1/2000, coupled
with the metering mode and the Exposure Value compensation set-
ting, can be adjusted depending upon the lighting conditions. The
Finepix A303 is bundled with a 16 MB xD-Picture card, which is
insufficient, if you click a picture using maximum settings—you
are likely to run out of storage space after 12 to 15 pictures, since
each would amount to 1.2 MB. It weighs 200 gms without the two
AA batteries, which is a bit heavy.

It managed to reproduce the pink and yellow of the coloured
pencil, but they were not as vibrant as they were in the reference
image. This camera, like the FinePix F402, produced images that
were dark at the corners. Hence you manually need to choose a
different metering mode. The specular effect was produced per-
fectly, with the precise amount of light reflecting on the metal
and glass. The camera also scored on focusing where the tiny arm
of the clock was visible, along with the keyboard text. However,
the image of the wall curtain (with the fine mesh), developed
untidy light and dark colour bands. This could be due to the low
colour-depth supported. It also returned a darker image when
tested for actual person test.

Priced at Rs 27,000, it is a bit expensive as compared to other
cameras with better features. The ergonomics are also average,
making it inconvenient to carry it around for a long while.

“A light-weight, simple aim-and-shoot digicam that could spell
wonders for the I-don’t-know-how-to-shoot amateur. Though
the price is a little high. A good buy if priced between Rs
22,000 to Rs 24,000.

—Sherwin Crasto

+ Good on features Fuji FinePix A303 a

— Flimsy build quality Performance EEk kR

Price: Rs 27,000 Features LAY
Ergonomics EERERER
Value for money k & k k k
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Mr. Spiderman

Go Wireless.
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Canon PowerShot A60/A70

Sony DSC-P72 and DSC-P32 Digital cameras

Sibling rivalry
Canon hasintroducedtwo . =
cameras with very little = - e X
difference between them, to ;E_,L B i
] Sk e

cater to budget buyers and

enthusiasts. The A60 and = = 550 2. %
A70 have a long list of com- { T q\l.

mon feature—both support a B -.,.' i
shutter speed from 15 sec- = -

onds to 1/2000th of a second,
which is one of the widest ranges in their class. You get sufficient-
ly bright pictures under poor light conditions. Both support 1600
X 1200 and 2048 x 1536 resolutions, but are bundled with 16 MB
Compact Flash. Canon should have bundled at least 32 MB with
the A70, as it supports higher resolution settings. Both these
devices need four AA batteries to run. The camera provides man-
ual overriding of many settings but tweaking the settings requires
the LCD to be on, which consumes a lot of power. Therefore, it is
advisable to use auto settings as
far as possible, and an optical
viewfinder, instead of an LCD,
while shooting. Both these
devices allow you to capture
pictures in black and white,
and sepia modes that can be
used to make project reports
and presentations that are
pleasing to the eye. The cam-
eras also allow you to set the expo-
sure value from +2 to -2 EV. Use this setting if you understand the
kind of output that will come out after setting the EV.

There was hardly any difference in their performance, with
the A70 taking a 2 per cent lead over A60 because of a 3.2 mega
pixel CCD. As far as luminosity goes, the test image quality of
the A60 was better than the A70—the A60 came up with a more
pleasing and brighter image. But when picking the colour blue,
the A70 performed than the A60. On the other hand, the A70
shone in the details test where one could see each individual
thread on the lace. This can be attributed to better focusing and
higher resolution support. The A70 also generated a smooth
specular effect, which was a little blunt in A60.

The A60 and A70 are available for Rs 24,995 and Rs 29,995,
respectively. Both these cameras only differ in optical and digi-
tal zoom, and CCD size. The looks and button placement are also
similar with the same body used. Given the quality they deliver
and features set they carry, their price seems just right.

Canon PowerShot A60 @

+ Good features Performance Bk kR

— Expensive Features EEEE
Price: Rs 24,995 Ergonomics EEEE
Value for money k k k &

Canon PowerShot A70

77779 LR e

+ Good ergonomics with decent Performance EEE K
features Features EEER
— Does not live up to the features. Ergonomics Bk kR
Price: Rs 29,995 Value for money k k k &
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Cute couple

Sony’s Cyber-shot DSC-P72 and DSC-P32 are identical in all
respect, except for the fact that the P72 comes equipped with
a 3X optical zoom, whereas the P32 has a fixed focus lens.
The cameras don a sil-
ver finish on a plastic
body that has one end
rounded off. The back
has a cluster of buttons
that consists of a mode
selector switch, four
menu navigation but-
tons and an Enter button.
Three other buttons—used for menu activation and
deleting the picture in the play mode—are lined along the LCD
monitor that acts as a view-finder. The cameras do have rubber
padding for a firm grip.

Both sport the a 3.2 megapixel CCD sensor, with a maximum
resolution of 2048 X 1536. They have five white-balance modes,
and shutter speeds ranging from 2 secs. to 1/1000 of a second. ISO
speeds range from 100 to 400, thus allowing for improved CCD
gain in poor lighting. They also have five flash modes for vary-
ing lighting conditions.

The cameras were nearly on
par with each other in terms of per-
formance. In the image test, the
P32 reproduced images that had
good tonal balance than the P72.
Also in the luminosity test, the P32
turned up better photos than the
P72. However, where the specular
effect and gradation in shading is concerned, the P72 scored due
to its optical zoom. Similarly, in the details test, the P72 scored
over the P32, only by reproducing the finer details better. The P32
crushed the P72 in the RGB test by reproducing the target in its full
vibrancy. In the zoom test, again the P72 armed with its superior
optical zoom lens, performed better than the P32. So was the case
in the actual person test, only the margin was wider. The DSC-P32
and DSC-P72 cost Rs 19,990 and Rs 24,990, respectively—too much
to ask for with those features and performace.

s i:-'

=)

“Very, very, very, sharp images with a strong depth-of-field.
Too many buttons. And thankfully is a Made-in-Japan. Is well
priced, looks different in comparison with other digicams and
is a Sony.»

—Sherwin Crasto

Sony DSC-P32 @
Performance EEEEE
+ Good features at an attractive Features EEREEE
price Ergonomics EkkER
— None Value for money k k & k k
Price: Rs 19,990
Sony DSC-P72 @
Performance EEkEk
+ Good features, form factor Features EEEEER
— Small and cramped LCD monitor | Ergonomics LN
Price: Rs 24.990 Value for money k k k k k
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CASIO QV-R3

SAMSUNG 350SE

SONY P32

As is obvious, the image produced by the Kodak DX6340 has good
tonal balance all across—all the colours are vibrant, and the details
immaculately reproduced. Whereas, the image reproduced by the
Samsung 350SE completely lacks luminosity and is quite dark and
dull. The photograph taken with the Casio Exilim had similar results

[EM 54

SONY P72

and the image lacked lustre. The images resulting from the Nikon
3100 shows good tonal balance and specular effects. Similarly, the
Olympus C350 also reproduced the test scene with great detail, but
lacked luminosity.The Sony images lacked details but had good
colour balance.
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Fuji FinePix F402

Nikon CoolPix 3100

All looks, no juice

he F402 is yet another designer camera with a sleek square

look. The best part about it is that it has no standard on or
off button. Instead, the camera has a big flap on its front that
slides open, and powers the camera. The blue LED on this flap
is the indicator of its power mode. The camera is just 2.2 cms
thick and weighs 125 gms, making it very pocketable. It is
equipped with a 2.1 megapixel CCD, which churns out 2304 x
1728 resolution images. The camera supports ISO setting from
200 to 1600—a range normally found in more expensive cam-
eras. It also supports shutter speeds from 1/2 to 1/2000 of a sec-
ond, making sure that you capture fast moving objects and
images in poor light conditions. The 6 cms to 65 cms macro
focus range lets you get a good close-up on subjects such as
petals and leaves to give you an excellent image. The camera
stores the images in a 16 MB xD-Picture card that’s bundled
along. A custom Li-ion battery and an AC adapter also come
along with the camera.

The F402 delivered very average-looking test images, as it
could not focus even in the auto mode. Due to this, the key-
board text was not readable and the flower petals looked blur-
ry. The camera reproduced colour well, but it was not on par
with others. It was the same with specular effects; it created a
very blunt reproduction of the liquid-filled glass and the metal
table clock. The image was
bright in the middle and dark = ===
in the corner, indicating that
the camera metering mode in
auto setting was not proper. It
returned dark images when
tested in a sufficiently-lit
room. The 3.6X digital zoom
does a decent job of getting a
distant object nearer.

The F402 is priced at Rs
30,000, which makes it very
costly, especially because it lacks
optical zoom, and also has a limited manual
override. This camera, like the Exilim EX-M1, is foppish eye-
candy that will only appeal to a select few.

Fuji FinePix F402 0
Performance EEREER
+ Slim form factor Features EEEER
- Very expensive Ergonomics EEERR
Price: Rs 30,000 Value for money & & k k k

An outdoor’s camera

f you are looking for a camera that takes great pictures, then

meet the Nikon CoolPix 3100. This 3.2 mega pixel camera deliv-
ers 2048 x 1536 resolution images, which is enough for printing
even on A4 size media. The 3x optical and the 4x digital zoom
capture the finest details of the subject. The CoolPix 3100 is light
and shaped such that it fits in your palm perfectly, and at the same
time, offers an enhanced grip—even when you hold the camera
with one hand. The macro focus range is as low as 4 cms. The cam-
era is very compact, and weighs a little over 200 gms. Depending
on the number of elements in the picture, you can store a mini-
mum of 16 images and a maximum of 25 on the 16 MB Compact
Flash memory—you can go up to 90 images, if taken at a resolu-
tion of 1024 x 768. The camera
brings two AA Ni-MH rechargeable

R '_'.h — T 11 i
batteries, and a charger. The only (— e ] S — o,
The CoolPix delivered image | 4. .
quality equalled only by the Kodak ! \ ¢
DX 6340. The test image was com- '
pletely focused and the alphabets

=
was also impressive, with very live-
ly reflections and a smooth effect on metal. It also reproduced the
wrinkles on the cloth, something most cameras could not do.
However, it disappointed us in the actual person test. The white
era is good for outdoor photography, and delivers excellent results
with a little tweaking, such as manually setting the exposure set-
ting, or using slower shutter speeds to get brighter images.
It’s priced at Rs 25,500, which is a little on the higher side, tak-

problem is that it drains the nor- P | A
. - . - : L * llh‘:ﬂ"f

mal alkaline batteries in no time. i - S,

on the CD and the keyboard text |

were readable. The specular effect

wall appeared grainy, and the skin tones were darker than the actu-

al colour. It yielded average results in the zoom test too. The cam-

ing into consideration that the camera consumes a lot of power

when used with normal alkaline batteries.

“Fits exactly in the palm and has a wonderful colour correc-
tion, even if kept on the auto white balance mode. A smart
digicam, which is worth buying if priced about Rs 2000 less.”

—Sherwin Crasto

Nikon CoolPix 3100 @
+ Great ergonomics, chic looks Performance EEERER
— Super hungry for alkaline Features EkkRR
batteries Ergonomics EEEER
Price: Rs 25.500 Value for money k k & k k

Mr. Christopher
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losing your way.
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Kodak CX6330

Kodak DX6340

Picture perfect, wallet-friendly

he CX6330, the younger sibling of the Kodak DX6340, is

targeted at budget buyers. In fact, it is the cheapest offer-
ing in its class, and sports some features that are great for its
price. For instance, it sports a 3.1 mega pixel CCD that can
deliver 2032 x 1524 resolution images. The 3X optical and the
3.3X digital zoom take care of different types of photography.
Be it in macro mode, or landscape mode—you are assured of
capturing the subject flawlessly. The 13 to 70 cm macro mode
allows you to take snaps of subjects as small as a needle, with-
out losing focus or
colour. It has all the
features of a low-end
camera, such as expo-

[ 'i sure  compensation
| from +/- 2.0 EV, burst
| mode and colour
mode  (black and

'-__ white, sepia and

RS e colour). The CX6330
runs on two AA batter-
ies that are bundled with it. The camera weighs just 175 gms,
which makes it light, and easy to carry around. It also offers
better ergonomics, which means that you will not have to sit
and spend hours learning how to navigate the menu, and find-
ing you way around the buttons. The camera brings along an
in-built memory of 16 MB memory, with support for SD/MMC
card. The images are saved in the compressed JPEG format,
meaning that you can easily store up to 15 images at maxi-
mum mode, and more than 25 images at lower settings.

When it came to performance, the device delivered accept-
able image quality. The colour reproduction was much better
than its more expensive counterparts. The specular effects were
also very smooth and pleasing to the eye. The focus, however,
was a little off target, and therefore not all parts of the frame
were clear. This is one shortcoming that can be overlooked if
the CX6330 is to be used for general purpose image capturing.
The camera delivered disappointing results in the RGB test,
where both the colours, green and blue, were not captured
properly. These two regions appeared very dark, indicating that
you can only shoot subjects standing within flash range.

The camera’s 3X optical and 3.3X digital zoom is also
commendable, as it will not disappoint those who usually
like to capture distant objects, mostly outdoors. When tested
for the actual person test, the camera gave a fairly decent
image quality, with better white balance results and proper
colour reproduction.

The CX6330 is priced at just Rs 16,900, which is quite rea-
sonable for the kind of lens, feature and performance it packs
into it. CX6330, like DX6340, is compatible with Printer dock
EasyShare 6000. As far as features and performance goes,
CX6330 is the best camera money can buy.

Kodak CX6330 e
Performance EEREER
+ Good value for money Features EEkEKk
— Poor ergonomics Ergonomics EEEER
Price: Rs 16,900 Value for money k k k k k
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Snap ‘n’ save

he 3.1 megapixel Kodak DX6340 is great in performance, and

intelligently priced. It can deliver a resolution of 2032 X 1524.
It sports a Schneider 4X optical zoom and 3.5X digital zoom lens,
which is more than enough for most types of photography. It
also has a good list of features. The 10 to 60 cms macro mode
range allows you to capture subjects with vivid colours and clear
focusing. The camera has multiple picture modes such as shut-
ter priority, aperture priority, sport, night, and so on. Novices
can just select the mode according to their need and click, mak-
ing it a simple point-and-shoot camera. At maximum settings,
the image size is lower than 1 MB, unlike other cameras. This is
particularly good for a camera that has a built-in memory of 16
MB,and no additional storage media bundled. However, it sup-
ports the SD/MMC card to increase the storage capacity.

The Kodak DX6340 is light and easy on the hand—the but-
tons are placed within reach. The camera’s hot-button transfers
the image directly to the PC, which
speeds up the process. It is compatible
with the EasyShare Printer Dock
6000, which can print images from
the camera directly.

The Kodak DX6340
delivered some of the
best results in its class.
The test image was

very clear with no § {|
dark or bright spots. *
The colours were |'I_'l

reproduced accurate-
ly—especially the pink BT
and yellow. The wrinkle
on the cloth was also picked up in detail, displaying the lens’
prowess. The image was well-focused, thus giving the much-
needed depth. However, it failed to detect the fine lace of the
curtain in the detail test. In the zoom test, it picked up the fine
roots on the tree at a distance of 12 to 15 feet. It also managed
to deliver much better pictures than the rest in the actual person
test. The white colour of the background image was picked up
accurately, hence proving that camera sets the white balance pre-
cisely. The same was the case with the overall luminance and
colour reproduction.

Smartly priced at Rs 20,900, it is the cheapest model in its
class. With so many features and a good image-quality, the Kodak
DX6340 should be the choice of users across the board.

“Is fast, cheap, with built-in memory, good features, but the
flash, at close range, is a little heavy though the camera is very
light. Bears excellent colour corrections and skin tones. Sports
a dependable Li-ion battery for longer life. But what scares me
most is the Made-in-China tag. That is what makes it cheap, |
guess”

—Sherwin Crasto

Kodak DX6340 e
+ Good features at a better price Performance EkbER
— Too much of zoom jars the pic- Features EEkEkk
ture. Ergonomics EEEEER
Price: Rs 20,900 Value for money k k k k k
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Olympus C350

Casio QV-R3

Low on price, high on features

he C350 belongs to the Camedia series of digital cameras

from Olympus. Similar in size and shape to its younger sib-
ling, the C150, this camera packs in quite a number of features
at a very attractive price. It runs on two normal AA alkaline bat-
teries, and features a nice LCD display to preview your subject
before you actually shoot it. The menu navigation is not as intu-
tive as the others in this category, such as the ones from Canon
and Fuji.

As far as physical features and ergonomics are concerned,
the C350 was the best in this segment. It fits perfectly in your
palm, with the contoured front lens cover providing a good
grip. Its design is pretty plane devoid of unnecessary lines jar-
ring its usability.

On the features front, the C350 does not disappoint either;
it has a 2 megapixel CCD sensor, with a 3X optical zoom and
3.3X of digital zoom, giving it a 9X zooming capability. The C-
350 also comes with four preset white balance modes along
with the default Auto mode. Shutter speeds vary from 2 sec-
onds to
1/1000th of a
second, allow-
ing photo-
graphs to be
taken in all
sorts of light-
ing conditions.
A choice of
! seven different

flash  modes
lets you click away in any sort of lighting. The C350 comes with
a huge 32 MB xD memory card.

Coming to performance, the C-350 is on par with the Kodak
DX6340. In the Image test, it produced images with good tonal
balance across the entire frame. The deviation of all the colours
from the reference points was not more than 10 per cent. The
photograph was sufficiently bright, with no dark spots at the
corner of the frame. In the specular test, the C350 produced
mild effects, thus losing some points. However, the gradation
in shading test saw the C350 performing much better, picking
up all the shading effects properly.

The C350 put up a mediocre performance in the details test,
and wasn’t able to reproduce all the required details very well.
In the RGB target test, the camera showed good response to red
and blue. However, the same wasn’t true in the case of green.
In the zoom and actual person test, the C350 yielded more than
decent photographs—it actually did better in this test than our
eventual winner—the Kodak DX6340.

Priced at Rs 19,995, the C-350 offers good value for
money,with a decent enough performance and good features. An
added benefit is the JPEG Exif version 2.2 image compression for-
mat that allows you to add data to the picture that can be used by
a printer to accurately perform image adjustment before printing.

Olympus C350

Performance EE
Features EE
Ergonomics E
Value for money & k

+ Great features at attractive price
- Average performance
Price: Rs 19,995

'F'F'F'F@
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Rugged digicam seeks memory

he Casio QV-R3 is a 3.2-megapixel digital camera that can

capture stills, as well as video. It supports a resolution of
2048 x 1536, and features a 3X optical and a 3.2X digital zoom.
It is small and compact owing to Casio’s Multi-Chip Module
(MCM) technology that integrates the CPU, ASIC and the mem-
ory chip into a single unit.

I1SO selection is set to auto by default, but users can select
ISO 125 or 250, manually. The metering can be configured to
multi, centre-weighted, or spot. It also has filters with such tones
as black and white, sepia, red, green, blue, yellow, pink and pur-
ple. The camera comes with a Li-ion battery and a charger, both
of which add to its convenience and portability. You save sub-
stantially on the running cost of the camera, which is a cause for
concern for most, and the Li-ion battery ensures long battery-life.
The 11 MB internal memory, and the SD/MMC card support pro-
vides for additional memory expansions. The QV-R3 has very
rugged looks, owing to the steel body and is really light. The
menu navigation is also easy and icon-based, so that even a
novice can understand the different settings without much head-
scratching.

The specular effect was high, causing images to be too
bright—the excessive light
caused the numerals on
the clock to disppear. How-
ever, it didn’t disappointin @
the actual person test, -
where it delivered a proper e -
contrast, and set the white k
balance to provide near- | sy
real environment images. |
It also picked up colours :
without any loss under natu-
ral lighting conditions. Hence, the camera can provide good
indoor shoots.

The zoom test returned acceptable results with the object being
very clear. This camera failed to pick up green, and scored as low
as 55.51 out of 255, which is worrying. It needs a bit of tweaking
that involves selecting a lower shutter speeds to let maximum light
enter the camera, for better colour reproduction.

Priced at Rs 29,995, it is a bit expensive, considering that
the built-in memory is just 11 MB. It has no additional memo-
ry card either. However, if you are looking for a rugged camera
that has re-chargeable batteries and a charger, then look
no further.

®
\

—5""._

“Virtually similar to the IXUS4000 and easier on the pocket
too. Isn’t very fast between frames but is still faster than the
standard aim-and-shoot conventinal cameras. Worth the price,
but nothing like a few thousand rupees less to attract the seri-
ous amateur.”

—Sherwin Crasto

Casio QV-R3 e
+ Rugged build-quality Performance EEEEE
— Low internal memory Features EEEREER
Price: Rs 29,995 Ergonomics EEEER
Value for money & & k k k
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Minolta DiMage Xi

Casio Exilim EX-M1

Slim body, no grip

he Minolta DiMage Xi is a slim form factor, which makes it

very portable, and its square body makes it look completely
different from the rest. The finish is very smooth, which may
add to its allure, but gives no place for the user to get a firm grip.
The camera is just 2 cm thick and weighs little over 150 grams.
It sports a 3.2 mega pixels
CCD that generates 2048 x
1536 resolution images. The
DiMage Xi is very thin and
therefore, slight jerking is
inevitable when shooting.
Hence the pictures tend to
turn out blurred. There is no
optical zoom. However, the
4X digital zoom gives you
some space to play around
with the settings. The camera
runs on a customised Li-ion battery, or an AC adapter that comes
along with the camera. It also has a 16 MB Secure Digital card
included as the storage media, which can be upgraded, as and
when required.

On the performance front, the device delivered very focused
images, and also managed to reproduce colour precisely. The
camera was particularly good in picking up the colours yellow
and pink. It also reproduced the green liquid in the glass bril-
liantly. The specular effect was one of the best amongst the cam-
eras of its class, with the reflection in liquid and metal looking
very natural. It also managed to show gradation in shading very
nicely, with the shadow dying out gradually. However, the qual-
ity of the image was very average when tested for the actual per-
son reproduction. Though the image was dull, there was no
colour loss, resulting in a warmer look. The camera averaged in
the zoom test as it was all digital, and therefore when viewing the
image at actual pixels in Photoshop, the image appears to be lit-
tle pixelated. Hence, use the zoom, but don’t blow up the image
to print a particular portion, as the final output will not be sat-
isfactory.

The DiMage Xi is priced at Rs 23,500, which is the right price
for the quality it delivers, and its features. The camera is very
portable and slim, making it a good travel companion.

Minolta DiMage Xi e
+ Individualistic looks, light-weight | Performance EEEER
— Takes too long to save a picture in | Features LN
TIFF format Ergonomics EEEER
Price: Rs 23.500 Value for money k k & k k

All looks, no performance

asio Exilim EX-ML1 is targeted at the class of people who strive

to be noticed. It weighs only 56 gms, is just 3.9 cms thick,
and undoubtedly is the wearable camera that Casio says it is. It
sports a 4X digital zoom and 1600 x 1200 resolutions. This is just
one of the cameras that supports a shutter speed of 1/4th to
1/8000th of a second. However, you cannot set the shutter speed
manually. It runs on a special Li-ion battery, which is much thin-
ner than the normal Li-ion batteries. The Exilim is charged using
the docking station that is bundled along. The docking station
can also be used to download the images to a PC, since a USB port
is absent.

The Exilim EX-M1 is very thin, which makes it a bit difficult
to operate. You also need a firm grip on the body when photo-

graphing, lest the images
. 'r-:r.\
.'r'"
m

appear hazy. The quality | =~ — =

of the images produced
matched our expecta-
tions. The image was a
little brighter (the fixed
lens was to blame), and
the keyboard text and
the clock’s hands were
not clearly visible. This
caused the image to look very flat. It was the same with the colour
reproduction—the colours looked washed out due to high lumi-
nosity levels. The Exilim EX-M1 also failed to reproduce details,
as the pattern on the curtain appeared very flat with foggy edges.
In the RGB target test too, it failed to detect the colour green,
causing it to appear very dark on the screen. However, the Exil-
im EX-M1 did well in the actual person test and reproduced
image was of acceptable quality, assuring us that it could be used
indoors in auto mode.

The Casio Exilim EX-M1 costs a cool Rs 20,995, almost
Rs 4,000 more than other cameras that produce similiar-quali-
ty pictures. There are other cameras in the market that sport
higher specifications and boast of much better features than
the Exilim EX-M1. Hence, this device is only recommended to
those who have deep pockets and are looking for something
radically different, even at the cost of ergonomics and zoom
capabilities.

na

i i

Casio Exilim EX-M1 @
Performance Bk
+ Slim form factor Features EEEEE
— Mediocre performance Ergonomics EkERR
Price: Rs 20,995 Value for money k& k k k k
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Samsung Digimax 350SE
Made for the mob

he 350SE sports the best build quality of all the cameras we

tested, with a solid rugged body shell that can take a beating.
Four AA batteries power the camera. The 240 gms weight has its
own advantages and disadvantages—it makes it stable when shoot-
ing, but cumbersome on a trip. There were just two disadvantages
we faced—one that the lens takes an unusually long time to
extend, and the second being the five-way menu navigation
switch, which is ultra smooth and doesn’t feel tactile.

The Digimax 350SE has a 3.2 megapixel CCD sensor, cou-
pled with a 3X optical zoon lens and 2X digital zoom. It sup-

ports ISO speed, ranging from

100 to 400, which is useful
when taking pictures in poor
light, to increase the CCD
sensitivity. The shutter speed
ranges from 4 seconds to
1/2000th of a second—again
a boon, since you can use it
in any lighting conditions.
Similarly, it has five flash
modes for different lighting

conditions.

It did not reproduce the test image as crisply as it should
have—the quality of the colours deviated as much as 25 per cent,
so did the luminance. Specular effects and gradation shading
effects were also affected by the low brightness. Surprisingly, in
the zoom test, the photograph was quite vibrant, indicating that
it requires a good amount of light.

Priced at Rs 24,995, the 350SE seems a bit expensive with
many other cameras retailing for around the same price, but giv-
ing much better results.

“Is just the right camera for the serious, but very, very low
budget tourist. Good image quality, but isn’t very quick in the
aim-and-shoot category. Also, it is just a little expensive for the
price. Samsung should sell it at about 21,000, if it plans to eat
into the established digicam companies whose products are
far superior.»

—Sherwin Crasto

Samsung Digimax 350SE

+ Very good zoom quality kkk R

Performance k

- Bulky, mediocre performance Features EEREEER
performance. Ergonomics T
Price: Rs 24,995 Value for money k & k k k

Capturing Images Outdoors

Digital cameras are great for shooting out doors. Since this will
involve capturing moving moving objects on film, a few things
need to be attended to.

The first, and foremost is the shutter speed. Most digital
cameras have a shutter speed ranging from 1 second to
1/500th of a second. You can set the shutter speed to its
slowest while capturing the sunset to allow maximum amount
of light to enter, thereby yielding a vibrant and lively image.

[EA 60

Expert Opinion Sherwin Crasto

r Sherwin Crasto, who is currently working with Reutersas a
M senior news photographer, has been using a professional
digital camera right from the time they were introduced. Sher-
win has been a photographer since 1983, and has been associat-
ed with many newspapers—The Indian Post and with Associated
Press for the South Asian region, to name a few, working mostly
as a senior photographer. He was also the chief photographer for
The Independent.

In the year 2000, he received specialised training in war cov-
erage, handling hostile environments, driving skills and first aid
at Heckfield, England. Recently, he had a close shave while cov-
ering the Afghanistan war, when an Afghan rebel opened fire on
his car. He has also spent a day on the American aircraft carrier,
Carl Vinson, from which American fighter planes took off to
bomb key Al Qaeda locations. He covered the hijacking episode
of the Indian Airlines plane at Kandahar. During the Kargil war,
he jumped to save himself from an oncoming mortar and in the
process broke his digital camera.

The mid-air collision between a Saudia Boeing and a Khaza-
khistan plane at Charki Dadri near Delhi, Pope John Paul II's visit to
India and Sri Lanka, former US president, Bill Clinton’s visit to
India, the last solar eclipse of the millennium at the Rann of Kutch,
are some examples of his long list of prestigious assigments.

In the year 2001, Sherwin was awarded the Commonwealth
Photographic Award on Environment for his picture on the burn-
ing of a tiger pelt seized from poachers.

He was also the Photo-Journalist of the year 1997-98, an
award given by the Mahanagar Newspaper.

The shutter speed should be as high as around 1/200th of a
second, when capturing fast moving objects, such as a
speeding car.

Digital cameras also offer white balance settings such as
incandescent, tangent, sunlight, etc. Use these settings to improve
the image quality, and make it look as close to reality as possible.
You can either select pre-defined settings, depending upon the
backdrop, or set them manually.

SEPTEMBER 2003
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BOARD
CATEGORY LOW-END DIGITAL CAMERAS I
Canon Canon Canon Casio Casio Fuji
W voce PowerShot A300 PowerShot A60 PowerShot A70 QV-R3 Exilim EX-M1 FinePix F402
Max. Image resolution 2048 x 1536 1600 x 1200 2048 x 1536 2048x1536 1600 x 1200 2304 x 1728
CCD (megapixel) 3.2 2 3.2 3.2 12 2.1
Focal length (35mm equivalent) 33 mm 35-105 35-105 37.5to 112.5 37 39
Optical Zoom NA 3x 3x 3x NA NA
Digital Zoom 5.1x 2.5x 3.2x 3.2x 4x 3.6x
Macro focus range (cm) 5t0 20 26 to 46 5to 46 14 to 50 100 6to 65
IS0 setting 50, 100, 200, 400 50,100, 200, 400 50, 100, 200, 400 125, 250 na 200, 400, 800, 1600

White balance settings

Auto, custom, Cloudy,

Auto, custom, Cloudy, Auto, custom, Cloudy,

Automatic/fixed Auto, Fluorescent,  Auto, Sunny (Fine Weather),

g Fluorescent, Fluorescent Fluorescent, Fluorescent Fluorescent, Fluorescent (4 modes), manual Daylight, tungsten,  Shady, Fluorescent (Daylight,
E H, Daylight, tungsten H, Daylight, tungsten H, Daylight, tungsten sunlight Warm, Cool), Incandescent
é Shutter speed range 1to 1/2000 15 to 1/2000 15 to 1/2000 2 t01/2000 1/4 to 1/8000 1/2 to 1/2000
Ry Metering modes Equivalent metering, Equivalent metering, Equivalent metering, Multi, Centre wieghted, Multi-pattern 64-zone TTL metering,
Center-weighted, Center-weighted, Center-weighted, Spot Program AE, exposure com-
averaging/Spot averaging/Spot averaging/Spot pensation in manual mode
metering metering metering
Number of flash modes Auto, Red-Eye Auto, Red-Eye Auto, Red-Eye AUTO, ON, OFF, Red eye Auto, Red-Eye Auto, Red-Eye Reduction,
Reduction, Reduction, auto-on, Reduction, auto-on, reduction Reduction, fill flash,  Forced, Suppressed, Slow
auto-on, auto-off auto-off auto-off flash off Synchro
Compressed image format JPEG JPEG JPEG JPEG JPEG JPEG
4l Dimensions (I x w x d) cms 110 x 58 x 36.6 101 x 64 x 31.5 101x 64 x 31.5 5.9 x 9 x3.1 95 x 55.5 x 39.5 T7x 69 x 22
E Weight (grams) 175 215 215 200 56 125
[l Memory types supported Compact Flash Compact Flash Compact Flash SD Memory/MMC SD-MMC xD-Picture Card
g Memory included (MB) 16 16 16 11 (internal) 12 (built-in) 16
@ Battery form factor AA AA AA Li-ion-Custom Li-ion-Custom Li-ion-Custom
I
o
Comfortable to hold (0-5) 3 4 4 4 2 2
&l Rubber grip a 0 O ] [B] ]
3 Menu navigation ease (0-5) Bi5) 35 35 35 3 1315
§ Comfortably sized buttons (0-2) 1.5 15 15 1 4 0.5
7l Special menu navigation buttons Four-way button 0 B] Four-way Joystick Two-way button
Build quality of flaps (memory, video/USB door) average average average good good Average
Image Test (Photoshop) |
Red (mean) 141.81 135.84 138.36 187.48 143.59 137.76
Green (mean) 96.11 96.86 85.45 106.86 90.15 92.61
Blue (mean) 91.25 96 75.95 88.7 75.69 82.91
Luminosity (mean) 109.23 108.43 100.21 128.99 104.52 105.02
Specular Effect (scale of 5) 45 4 35 2.5 1 1
Gradation in shading (scale of 5) 1 1 3 2 3 3
ol Details Test (0-2 each)
Edl Zone 1 Colour reproduction 1.5 1 1 0.5 0.5 0.5
> Zone 2 text and wrinkles 15 15 1 0.5 0.5 0.5
= Zone 3 Details 05 05 15 1 05 1
Gl RGB Target
Red (mean) 123 134.25 255 156.55 131.22 197.98
Green (mean) 41.75 44.25 141.03 55.51 54.68 78.47
Blue (mean) 119.43 113.93 228.86 168.68 137.57 176.37
Zoom Test |
Quality (Scale of 5) 2D 3 2.5 2.5 1 1
Actual Person Image Test |
Quality (Scale of 5) 2 2.5 2.5 2 3 1.5
Ml Period of warranty (Years) 1 1 1 1 1 1
k@ Number of authorised service centres NA NA NA 25 25 1
= Number of cities with service centres 8 8 8 8 8 1
W Camera Features (30%) 16 15 19 13 8 14
§ Physical Features (15%) 4 3 4 6 7
i Performance (50%) 20.22 20.74 22.45 18.53 13.93 15.2
g4 Ergonomics (5%) 33 37 37 37 2.6 29
g Value for Money 10.88 8.68 8.02 6.53 7.27 6.51
Grade LD L4 ) [+ ) ih L+ ) =
Contact Canon India Pvt Ltd Canon India Pvt Ltd Canon India Pvt Ltd Casio India Casio India Jindal Photo Films Ltd
Company Pvt Itd Company Pvt Itd
M Phone 011-26806572 / 7317 011-26806572 / 7318 011-26806572 / 7319 011-26534537 / 41 011-26534537 / 41 022-28504949
,% Fax 011-26807180 011-26807181 011-26807182 011-26534542 011-26534542 022-28504044
§ E-mail Shyam@canon.co.in Shyam@canon.co.in Shyam@canon.co.in kseth@ kseth@ k_mohan/jpl@
casioindiacompany.com casioindiacompany.com jindals.com
Web site Www.canon.co.in Www.canon.co.in WWW.canon.co.in WWW.Casi0.co.in WWW.Casi0.co.in www.fujifilm.com
Price (Rs) 19,995 24,995 29,995 29,995 20,995 30,000




LOW-END DIGITAL CAMERAS

Fuji Kodak Kodak Minolta Nikon Olympus Samsung Sony Sony
FinePix A303 DX6340 CX6330 DiMage Xi COOLPIX 3100 €350 Digimax 350SE P72 P32
2048 x 1536 2032 x 1524 2032 x 1524 2048 x 1536 2048 x 1536 2048x1536 2048 x 1536 2048 x 1536 2048 x 1536
3.24 31 3.1 3.2 3.2 2 3.2 3.2 3.2
38-114 36 to 144 37to M NA 38to 115 NA 34 t0 102 39to 117 33
3x 4x 3x NA 3x 3x 3x 3x NA
3.2x 3.5x 3.3x 4x 4x 3.3x 2x 3x 3.2x
10 to 80 10 to 60 13to 70 25 4cm 20-50 20 to 80 10 to 50 10
100 100, 200, 400 100, 200 50, 100, 200, 400 50, 100 Auto 60-400 100, 200, 400 100, 200, 400 100, 200, 400
Auto, Sunny Auto, Daylight, Auto Auto, Daylight, Warm, Auto, Daylight,  iESP Auto; Pre-set manual Auto,3 modes Auto,4 modes Auto, Daylight,
(Fine Weather), Shady, ~ Tungsten, Fluroscent Cool), Incandescent Tungsten, settings: Daylight, incandescent,
Fluorescent (Daylight, Fluroscent, Overcast, Tungsten & Fluroscent, Cloudy/
Warm, Cool), Incandescent Cloudy/Speedlight Fluorescent
1/2 t0 1/2000 4 t01/2000 1/2 to 1/1400 2 to 171000 4101/3000 2 t01/1000 sec 4 t0 1/2000 2 t0 1/1000 2 t0 1/1000
64-zone TTL metering, Auto exposure, Multi Zone AF Multi segment 256-segment Matrix iESP multi-pattern; Program AE Multi-pattern or Spot Multi-pattern, spot
Program AE, exposure matrix linked to AF area Center Weighted Meter;

compensation in manual
mode

AE Lock w/1R shutter
release position

Auto, Red-Eye Reduction, Auto, Red-Eye

Auto, Red-Eye

Auto, Red-Eye Auto, Red-Eye

Auto, and 5 modes Auto, Red-Eye

Auto, Red-Eye

Auto, Red-Eye

Forced, Suppressed, Slow  Reduction, fill flash, Reduction, Reduction, fill flash,  Reduction, fill flash, Reduction, fill flash,  Reduction, fill flash, Reduction, fill flash,
Synchro, Red Eye+Slow flash off fill flash, flash off flash off flash off, Slow Synchro flash off, flash off, Slow
Synchro flash off Slow Synchro Synchro
JPEG JPEG JPEG TIFF JPEG JPEG JPEG JPEG JPEG
97 x 63.9 x 34.3 10.9x6.45x3.82 10.2x6.5x3.8 89 x71x 20 8.75x6.5x 3.8 6.7x11.2x 4.0 1.4x7.0x4.99 1.95x5.77x3.26 1013 x5.77 x 5.2
200 220 175 143 212 166 240 259 217
xD-Picture Card MMC/SD MMC/SD SD CF xD-Picture Card CF Memory Stick Memory Stick
16 16 built-in 16 (internal) 16 16 32 16 16 16
AA AA AA Li-ion, Custom AA Ni-Mh AA AA AA AA
rechargeable
2 35 35 2 4 13 2.5 35 4
] O ] O g0 ] O 0 O
9 35 4 3 35 2.5 3 2.5 2.5
1 1.5 1.5 15 1.5 1.5 1 15 1.5
Two-way Joystick Four-way Two-way Four-way 0 Four-way ]
Average average average average average good average average average
158.24 146.2 149.84 161.75 146.02 132.5 108.18 135.82 145.8
84.95 108.79 12.91 17.2 99.86 103 59.41 75.05 96.84
65.11 108.12 m.37 113.32 102.51 103.47 49.87 .12 80.51
104.65 119.91 123.78 130.09 113.96 11.88 72.94 92.79 109.66
2 4 4 35 35 2 1.5 35 35
9 4 35 35 35 3 1 35 3
0.5 1.5 1.5 1.5 1.5 1 1 1.5 1
0.5 1 1 1 1.5 1.5 1 0.5 1
0.5 15 1 1 1 1 0.5 1 0.5
201.02 129.52 106.74 188.73 235.43 180.13 159.47 118.08 183.8
85.24 51.64 33.26 103.14 141.15 63.12 61.09 46.91 105.31
81.42 132.79 91.42 185.92 255 209.11 168.16 146.95 180.1
2 2.5 2.5 1 2 2 3 3 2.5 |
15 2 2 2 1.5 25 3 35 1.5 |
1 1 1 1 1 1 1 1 1
1 8 8 2 4 8 12 103 103
1 8 8 NA NA NA 8 8 8
16 20 9 10 18 15 12 14 12
5 3 4 8 8 5 4 2 3
14.58 21.06 25.46 25.69 2515 23.54 13.29 17.89 20.63
2.6 35 38 2.6 37 2.7 2.8 29 31
6.7 12.81 12.5 9.84 11.01 11.56 6.41 736 9.68
i > > L i i = s ] -
Jindal Photo Films Itd  neoteric-informatique neoteric- J.J Mehta and Sons  J.J Mehta and Sons Komal International Matrix Agency Rashi Peripherals  Rashi Peripherals

informatique

022-28504949 022-24172600

022-24172600

022-24306356 022-24306356

022-22611274 022-2300406

022-28260258

022-28260258

022-2854044 24185294 24185294 24326865 24326865 022-22610219 022-23054631 022-28221012 022-28221012
k_mohan/jpl@jindals.com rajeev@ rajeev@neoteric-  sales@jjmehta.com  sales@jjmehta.com  indiaolympus@vsnl.net  matrixmk@vsnl.com ho@rptechindia.com ho@rptechindia.com
neoteric-info.comm info.comm
www.fujifilm.com www.Kodak.com www.Kodak.com www.minolta.com www.nikon.com  www.olympus-global.com www.samsungcamera.com  www.sony.com Www.sony.com
27,000 20,900 16,900 23,500 25,500 19,995 24,995 24,990 19,990
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Fuji Finepix M603

Fuji Finepix S304

Hard to hold, hurts to pay

he M603, with its silver finished plastic body, looks more like

a tiffin box than a camera! The most noticeable difference is
the absence of an optical viewfinder, replaced by a large
2.5-inch LCD. Due to the new upright design, the shutter release
and the zoom controls are placed on the sides of the camera,
which takes a toll on usability. Fuji has provided a grip handle
that screws into the tripod mount, stabilising the camera when
the controls are used.

The M603 has a 3.1 mega pixel CCD, a 3X optical zoom and
a 4.4X digital zoom. Shutter speeds range from 1/4 of a second,
to 1/2000 of a second with 64 zone TTL metering, using which
one can take photographs even in low light conditions. Seven
white balance modes have been
provided. Apart from the auto
mode, the camera has four flash
modes. The I1SO speed varies from
aminimum of 160 to 1600, which
is excellent, in case you want to
increase the gain of the CCD for
night shoots. The M603 has pro-
visions to read both, XD memory
cards and Compact Flash Type Il
cards, and is also microdrive com-
patible, thus providing you
enough memory options to
choose from.

In the image test, the average colour deviation was
3 per cent for red, and a little less than 10 per cent for green and
blue. The images were sufficiently bright with no dark corners.
In the Specular effects and gradation test, the images were
strictly average.

The M603 was able to pick out most details, but fared
poorly at colour reproduction—it lost all its points due to a
dull reproduction in the RGB target test. The F601 was
comparatively better than the M603 in this respect. While
testing for zoom, and in the actual person test, it showed a
decent performance.

The camera is priced at Rs 46,500, which does not justify its
so0-so performance at all. Chip in a bit more, and you get the 1Xus
400, which fares much better.

Fuji Finepix M603 @
+ Support higher resolutions and Performance EEEER
various memory formats Features EEEER
— Shoddy ergonomics Ergonomics EkkER
Price: Rs 46,500 Value for money k k k k k

Can’t afford to miss

he S304 looks like a SLR with its huge 6X optical zoom lens,

and the new xD memory card. The plastic body has a silver fin-
ish, and dark-grey rubber grips are thrown around to produce a
stark contrast. The back sports a big viewfinder, with the anti-reflec-
tive LCD screen. The buttons are placed within your thumb’s reach.
The ones pertaining to the LCD are placed just above it.

Ergonomically, the S304 was the best camera in the entire test—
the grip on the right side is perfect, and even the batteries are placed
cleverly to balance out the weight of the lenses.

The camera features an effective CCD count of 3.2 megapix-
els, and 6X optical zoom and a 3.2X digital zoom. The shut-
ter speed varies from 3 seconds to 1/2000th of a second.
There are five different white balance settings, apart from
the auto mode. The only gripe that we found was the 16
MB xD memory card—the camera deserves
at least 32 MB.

In the image test, the S304 had
no problems detecting red, with an
average deviation of just over 3 per
cent. Unfortunately, the average
deviation with green and blue, was
more than 20 per cent. Overall, the
image looked a bit dull and saturat-
ed. In the specular effect and gra-
dation effect test, nothing quite beats
the S304. It lost some critical points while pick-
ing up finer details. In the RGB target test, the S304 responded
well to red and blue, but failed to pick up green very well. In the
zoom test and the actual person test, the scores were average.

At Rs 35,000, it is an absolute must for those looking for a high-
end camera on a shoestring budget. It also comes with frills such as
a conversion lens adapter. Good features, great performance and
most importantly, a terrific price makes it an absolute winner.

“Is very fast. Does not have the 2-3 seconds wait to fire. Image
quality is excellent too. Has a good grip, a digital viewer and is
equipped with a hood to block flare. At 40,000 it may sound
expensive but makes up on quality. Will get lots of buyers if
priced at about 35-38,000. | could be one. »

—Sherwin Crasto

Fuji Finepix S304 e
+ Excellent ergonomics, good Performance EEERR
features and value for money Features EEEE R
— Quite bulky Ergonomics EEEER
Price: Rs 35.000 Value for money & b k k k

Mr. Santa Céaus

Think beyr:mcr Red and White.
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FUII F601

FUII M603

The Canon IXUS 400 gave good colour reproduction, followed by
the Fuji FinePix S304. These were the two cameras that reproduced
colours better than the others. Canon IXUS produced very decent
and smooth-looking specular effects. The Fuji M603’s reproduction
was a little too harsh and shiny. All the cameras were closely com-
petitive at picking up details and focusing, but Fuji S304 manged to
capture every detail, as is apparent from picture where the individ-

FUJI S304

ual thread in the curtains are visible. The wrinkles on the doll are
clearly visible in the images taken by the IXUS, which was nearly on
par with the Fuji S304.

The Canon S50, which is 5 mega pixel camera disappointed us
in the luminosity test as the image was little dark. The pictures from
both, the Fuji F601 and M603, are bright but not as focused and
detailed as the IXUS 400 and the S304.

1/2 PAGE ad
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CAMERA FEATURES

BOARD
CATEGORY MID RANGE DIGITAL CAMERAS
Canon Canon Fuji Fuji Fuji Fuji
. Model Digital IXUS 400 PowerShot S50 FinePix $304 FinePix M603 FinePix F601 FinePix F410
Max. Image resolution 2272 x 1704 2592 x 1944 2048 x 1536 2832 x 2128 2832 x 2128 2304 x 1728
CCD sensor (Megapixel) 4 5 3.2 &l 3.1 31
Focal length (35 mm equivalent) 36 t0 108 35 to0 105 38 to 228 38to 76 36 to 108 39 mm
Optical Zoom 3x 3x 6X 2X 3x 3x
Digital Zoom 3.6x 4.1x 3.2x 4.4x 4.4x 4.4x
Macro focus range (cm) 30 to 46 10 to 50 10 to 80 20-80 20-80 6to 65
IS0 setting 50, 100, 200, 400 50, 100, 200, 400 equivalent to 100 160, 200, 400, 800, 1600 160, 200, 400, 800, 1600 200,400, 800, 1600
White balance settings Auto, 5 modes Auto Auto, 5 modes Auto, 7 modes Auto, 7 modes Auto, 7 modes
Shutter speed range 15 to 1/2000 15 to 1/1500 3 to 1/1500 1/4 t0 1/2000 1/2 t01/2000 1/2 t0 1/2000
Metering modes Equivalent metering, Equivalent metering, 64-zone TTL metering, 64-zone TTL metering 64-zone TTL metering 64-zone TTL metering,
Center-weighted, Center-weighted, Program AE Program AE, exposure

PHYSICAL FEATURES

ERGONOMICS

in)
o
Z
<
>
o
o
v
o
w
o

W &S

OVERALL SCORE

CONTACT

SCIORIE

averaging/Spot metering averaging/Spot metering

compensation in manual mode

Number of flash modes

Auto, Red-Eye Reduction,
auto-on, auto-off, Slow

Auto, Red-Eye
Reduction, auto-on,

Auto, Red-Eye Reduction,
Forced, Suppressed,

Auto, Forced,
Suppressed, Slow

Auto, Red-Eye Reduction,
On, Off, Slow Synchro

Auto, Red-Eye Reduction,
Forced, Suppressed, Slow

Synchro auto-off Slow Synchro, Synchro Synchro
Red Eye+Slow Synchro
Dimensions (I x w x d) cms 87 x 57 x 27.8 112 x 58 x 42 99.7 x77.3x 69.3 64.5x93.3x31.6 72x93x34 T7x 69 x 22
Weight (grams) 185 260 295 240 220 125
Electronic viewfinder O O O O O O
Compressed image format JPEG JPEG JPEG JPEG JPEG JPEG Exif ver 2.2
Memory types supported Compact Flash Compact Flash xD-Picture Card xD-Picture Card, CF, SmartMedia xD-Picture Card
MicroDrive

Memory included (MB) 32 32 16 16 16 16
Power Functions (scale of 5) 3 3 2 3 2 3
Battery form factor Li-lon, Custom Li-lon, Custom AA Li-lon, Custom Li-lon, Custom Li-lon, Custom
Comfortable to hold (0-5) Bi5 3 4 2 2 2
Rubber grip O 0 ] 0 0 O
Menu navigation ease (0-5) B 35 4 315 8i5 35
Comfortably sized buttons (0-2) 15 15 15 1 1 0.5
Special menu navigation buttons NA Four-way NA Four-way Joystick Two-way
Build quality of flaps (memory, video/USB door) Average Average Average Average Average Average
Image Test (Photoshop)
Red (mean) 133.08 145.97 148 141.53 151.08 127.23
Green (mean) 99.43 86.03 97.28 90.81 96.21 69.07
Blue (mean) 100.97 .4 81.44 70.5 86.28 66.49
Luminosity (mean) 109.68 102.32 110.67 103.69 .51 86.17
Specular Effect (scale of 5) 4 4 4.5 315 8 2
Gradation in shading (scale of 5) Bi5 4 45 3 35 1
Details Test (0-2 each)
Zone 1 Colour reproduction 15 1.5 1.5 1 1 1.5
Zone 2 Text and wrinkles 15 15 15 115} 0.5 1
Zone 3 Details 15 15 1 115 1 1
RGB Target Test
Red (mean) 154.11 164.51 184 120.81 173.49 174.44
Green (mean) 120.18 70.41 66.97 43.75 74.84 72.34
Blue (mean) 56.18 169.5 169.04 119.65 165.05 151.96
Zoom Test
Quality (Scale of 5) 3.75 2.5 35 3 35 2.5
Actual Person Image Test
Quality (Scale of 5) BI5 4 3 2 3 2
Period of warranty (Years) 1 1 1 1 1 1
Number of authorised service centres NA NA 1 1 1 1
Number of cities where service centres are present 8 8 1 1 1 1
Camera Features (30%) 15 16 16 15 16 17
Physical Features (15%) 7 5 3 5 4 7
Performance (50%) 26.64 23.67 25.24 21.77 22.44 13.87
Ergonomics (5%) 3.2 33 4 25 2.9 2.9
Value for Money 8.16 6.4 10.76 7.62 7.64 9.32
Grade D i i e ] = Ly
Contact Canon India Pvt Ltd Canon India Pvt Ltd Jindal Photo films Ltd Jindal Photo films Ltd Jindal Photo films Ltd Jindal Photo films Ltd
Phone 011-26806572 / 7317 011-26806572 / 7317 022-28504949 022-28504949 022-28504949 022-28504949
Fax 011-26807180 011-26807180 022-28504044 022-28504044 022-28504044 022-28504044
E-mail Shyam@canon.co.in Shyam@canon.co.in  k_mohan/jpl@jindals.com k_mohan/jpl@jindals.com k_mohan/jpl@jindals.com  k_mohan/jpl@jindals.com
Web site WWW.Canon.co.in www.canon.co.in www.fujifilm.com www.fujifilm.com www.fujifilm.com www.fujifilm.com

Price

49,995

59,995

35,500

46,500 47,500

35,000




test drive =

m digital cameras

Fuji FinePix F410

Fuji F601

Much glitter, no gold

ujifilm’s FinePix F410 is equipped with a

3.1 megapixel Super CCD. It can pack in a
3 megapixel image size that can be boosted to
6 megapixels using the fourth-generation
Super CCD.

The F410 sports a complete metallic body,
with clean running lines. Sliding a raised
panel on the front switches the camera on,
lighting the three blue neon lights. The back
of the camera has a neat and clean design,
with a good thumb grip. The buttons for
menu selection and other settings are placed
near the LCD monitor. Due to its metallic
body, the F410 does not provide a firm confi-
dent grip, and is likely to slip.

Despite its small size, it has no dearth of
features. You can select from seven pre-defined
white balance settings,
or set it to shoot in
auto mode. The cam-
era’s shutter speeds
range from1/2 a sec-
ond, to 1/2000 of a
second—enough to
take photographs

under any conditions.
The F410 supports 1ISO
speeds ranging from 200 to 1600—sufficient
enough to increase the CCD gain, in case you
want to shoot at night.

In performance, the F410 could not live
up to the reputations built by other Fuji cam-
eras—especially the S304. The F410 took a
severe beating in colour reproduction,where
the deviation was more than 10 per cent for all
thethree colours. The camera wasn'’t able to
pick up variations properly, leading to a poor
score in the specular effect and gradation test.

Similarly, in the details test, the camera
just could not pick up any sort of fine details.
The only saving grace was the RGB target test,
where the F410 clawed back to its feet by
reproducing the colours decently. In the zoom
test and the actual person test, the results were
worse. Despite the 3X optical zoom, the F410
seems to be quite ineffective in capturing tar-
gets that are some distance off. In the actual
person test, the photograph turned out quite
dark, and showed varying shades of white,
indicating poor white balance response.

Priced at Rs 35,000, one does not expect
such a poor performance. For the same price
range, you should consider the S304.

Fuji FinePix F410 @
+ Compact form
factor Performance k k k k k
— Extremely over | Features_ LN
priced Ergonomics EkEkk
Price: Rs 35,000 Value formoney b bk & k k

[EM 69

Expensive mediocrity

he Fuji F601 has good looks but is hard to

operate. Operating the zoom and shutter
buttons puts the thumb and forefinger at awk-
ward angles—uncomfort-
able while taking a u___-ﬂ
photograph.

The F601 has a
3.1 megapixel Super 4
CCD sensor, with a
3X optical zoom and
4.4X digital zoom.
Eight white balance
settings, and a shut-
ter speed ranging et
from 1/2 a second to 7
1/2000 of a second,
help snap in all lighting conditions.

In the standard image test, the F601 was
able to reproduce the test scene well, without
saturating colours. The average colour devia-
tion was not good—Iless than 7 per cent for
red, and more than 10 per cent for blue and
green. The images were vibrant, with uniform
luminance across the entire frame. The F601
reproduced mild specular effects, but was able
to reproduce the gradations perfectly well.

In the details test, it was good at colour
reproduction, but lost ground when it came
to picking up finer details such as the wrin-
kles, etc.

In the RGB target test, the camera was bet-
ter than all its Fuji and Canon counterparts.
This was the only test where the F601 excelled,
and perfectly reproduced the RGB target with
great precision. In the zoom test too, the F601
gave fine results, losing only to the Canon
1XUS 400. However, in the actual person test,
the F601 performed badly, yielding photo-
graphs that looked quite dark.

Overall, it’s a good camera, marred by a
shoddy design, but is inexcusably over priced.

“Excellent quality of images, but am still try-
ing to figure out how to hold the camera.
Looks nice on the table, yet feels funny in
the hand with it’s ergonomics. But thankfully
one can switch off the display even when
shooting and conserve precious battery
power. At 47,500, for most Indians it will be
a back bencher. And yes!, will make excellent
pictures for the super-sleuth Bond photogra-
pher better known as the Paparazzi. »

—Sherwin Crasto

+ High resolu- —

. Fuji F601

tions and ISO uji F60 @
speeds Performance EEEER
— Over priced Efg;‘:g;ics : : : : :
price: Rs 47,500 Value formoney k k k k k
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Now you can carry your music wherever you go, with the help of portable MP3 players. We look at the
latest offerings by various manufacturers to help you select the one for you

portable player. MP3 players have come close with their

small form factor and the sheer amount of music you can
carry. Though some of them are still expensive, they are a com-
mon sight. Here we compare the best of the lot to help you
choose one that is best suited to your needs.

MP3 players come in three main categories, depending upon
the storage medium used—solid-state, hard drive-based and CD
MP3 players. While solid-state memory MP3 players are tiny and
extremely portable, they can store a maximum of 256 MB of data.
On the other hand, hard drive-based players, such as the Apple
iPod offer up to 30 GB of storage space and more features, but they
are bigger and much more expensive. CD MP3 players are cheap
and use inexpensive media, but do not look as cool as the others.
We looked at the solid-state MP3 players available today to help
you make the right choice. Solid state MP3 players are tiny mem-
ory-based players. The absence of moving parts ensures that you
get good quality music regardless of who's rocking the boat.

Apacer Audio Steno BP300
Battery guzzling fashion accessory

Connoisseurs of music are always in search of the perfect

This funky and futuristic looking player from Apacer moonlights as
a USB portable storage device, a MP3 and WMA player, and also a

FED 69

voice recorder. It has a small rectangular backlit LCD, two volume
control buttons and a Play or Pause button that also doubles as a
power switch. The record, lock and menu jog switch are located on
the underbelly. The LCD displays the track title from the ID3 tag, bat-
tery status, and indicates any other chosen settings. Removing the
coloured cap at the top of the device reveals a USB connector that
plugs directly into the USB port of your computer. The cap can be
secured to the device with the cord provided, so that you don’t lose
it—even if you do, you can use one of the two different coloured
spares that are thoughtfully provided, or just choose a colour to
match your wardrobe! The player can be worn around your neck,
using the provided strap—a good thing too, as it seems fragile.

Connecting the device to your PC is as easy as plugging it into
the USB port, either directly or by using the USB extension cord
that is provided. It is recognised as a removable drive, and you can
use Windows Explorer to copy music or data to it—though the
manufacturer strongly recommends using the bundled transfer
software, which also includes a format utility. One goof-up here is
that when you install the Audio Update application, a window
pops up telling you to switch the MP3 device to ‘Recovery mode’—
there is no information on how to do this, neither in the user
guide, nor on the manufacturers Web site.

The 128 MB storage is enough to store 24 MP3s encoded at
160 Kbps with an average size of 5 MB. You cannot create a

SEPTEMBER 2003
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Apple iPod 30GB

Hard drive-based MP3 players are the most expensive type,
but they also provide the maximum storage space and a
plethora of features.

Weighing 176 gms, the Apple iPod sports a plain white front
panel, with a stainless steel finished back. It has a 2-inch backlit LCD
on the front panel. The front panel also features a rotary wheel and
five buttons to control the player—all touch-sensitive. Apart from
the 30 GB model we tested, the Apple iPod is also available in 10
GB and 15 GB storage capacities. The 25- -
minute skip protection ensures that the iPod is .
the perfect jogging companion. A FireWire
(IEEE1394) cable connects directly to the iPod
or to the included docking cradle. iTunes and
MusicMatch software are provided on a CD
for both Mac and Windows users.

The 30 GB hard drive can store L
approximately 7,500 songs, at 4 minutes . = ',.‘-
per song encoded at 128 Kbps MP3 or
AAC formats. You can browse by playlist, album, artist, composer,
genre or song. The main menu can be customised, and so can the
backlight time and the screen contrast.

You can also use the device as a portable hard drive to transfer
any kind of data between different computers. There is also a Line-
Out socket that lets you connect your iPod to a stereo system.

The iPod supports MP3, MP3 Variable Bit Rate, AAC, WAV, AA,
and AIFF audio file formats. The provided earphones produce crys-
tal clear music at 30 mW per channel for an immersive experience.

We transfered 1 GB of songs, using USB 2.0 from a PC running
Windows XP and MusicMatch software, in just about 6 minutes and
25 seconds. The internal lithium-ion battery takes about an hour to
charge up to 80 per cent and about 3 to 4 hours to charge fully, it
lasts for about 6 hours.

Contact: Apple Computer International Private Limited
Phone: 080-5550575

Fax: 080-5586107 Apple iPod 30 GB a
E-ma|l.: |nd|a|nfo@a5|a.applg.com Performance T,
Web site: www.apple.com/ipod : L
Price: Rs 45,000 for 30 GB, SEIES >

Rs 36,000 for 15 GB and Value for money » » » » »
Rs 28,000 for 10 GB Ease of use NN

playlist, but can create folders in the removable drive. Note

that all the songs inside the folders are listed along with those

stored in the root. Though the manufacturer claims that the

single AAA battery will last 12 hours, it gave us only 4.5 hours

of continuous playback.

The jog switch lets you switch between music and

voice modes, and customise other settings.

You can choose between five

equaliser modes, but there

is no user defined equalis-

er setting possible. You

- can repeat and shuffle

tracks in playback mode,

and customise the backlight

# and power off timings. You can

also choose between 16 KHz and
44.1 KHz bit rates for voice recording.

1/2 pageV AD
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The menu navigation is easy enough. However, the device exits
the menu as soon as you view or change an option—uvery irritat-
ing if you need to change two or more options. Operating the
device is simple if you are carrying it around your neck, but if it’s
inside your pocket, you’ll have to remove it to access the controls.

The supplied headphones are comfortable, but with below
average audio output—there was no difference in sound quality
using our reference headphones either. The bass and treble levels
of the Hindi track were distorted—the vocals were too sharp and
not up to the mark. The data transfer was very fast, taking 1 minute
35 seconds for the 50 MB set of MP3 files.

Its sub Rs 9,000 price and funky looks will make it an attrac-
tive buy for teenagers, but it is not a product for serious music
buffs. Its average audio quality, poor battery life, bad build qual-
ity and poor software need to be considered before buying the

BP300.

+ Good set of headphones Apacer Audio e
+ Fast data transfer Steno BP300

- Poor application support Performance Bk kR

- No playlist and folder support Features EERERR

~ Average audio quality Value formoney ¥ k k k K

— Poor battery life

Price: Rs 8,990 Fase of use heERE

Creative Digital MP3 Player LX100

channels as favourites. You can record voice or radio for up to 8
hours. This is useful if you are interviewing someone, as the clari-
ty is good and you can transfer the recording to your PC. There is
no software bundled, the accompanying CD only contains drivers
for Windows 98 SE, and warranty and support information.

The LX100’s menu is well designed, but the haphazard button
placement leaves much to be desired. The bundled headphones are
a little too sharp, but the quality of sound we heard with our ref-
erence headset was very good. The audio output has good treble,
mids and vocals, but the bass is a tad weak. It took almost 2 min-
utes (1 minute 56 seconds) to transfer the 50 MB set of MP3s.

Overall, the LX100 is a portable, light-weight and feature-rich
device with good quality audio output. Considering its features,
a price of Rs 9,799 is very good. Thus, it scored well in both the
features, as well as the value for
money sections, which paved

Creative Digital MP3 e

the way to its crown as the win-  |Player LX100

ner of our test. Performance EEEEE
+ Decent set of features Features EEERER
+ Easy installation Value for money k k k k k
+ Large LCD Ease of use EEEEK
— No bundled software

Price: Rs 9,799

Creative Nomad MuVo 64MB

Top of the charts

The LX100 plays MP3 and WMA audio, has voice recording as well
as FM radio. A small and lightweight device, it is extremely portable
and can be carried inside your pocket or around your neck. It sports
ametallic silver finish and a large backlit LCD. The screen displays
song file-names, folders, menu settings, battery status, audio for-
mat, playing mode, chosen equalizer mode and even a visualiser.
A jog switch controls playback functions and menu settings. Other
buttons on the device include a volume and record, play, hold,
repeat, and other mode buttons. The play button doubles as an on
and off switch.

When connected to the PC running Windows 98 SE and above
via the USB port, it is recognised as a removable drive. You can use
Windows Explorer to copy files to and from the device. The 128
MB flash memory is non-upgradeable. The internal lithium-ion
battery is automatically recharged when connected to a USB port.
The battery lasts for 10 hours of continuous play, just as the man-
ufacturer claims.

The 128 MB (or 24 MP3s encoded at 160 Kbps) capacity may
not be enough to last over the weekend, but will easily last through

your daily commute or morning jogging sessions. You can
create a playlist and organise songs inside appro-
priately named folders. There’s no
ID3 support, which results in just
the file-name scrolling across
the LCD display.
Apart from standard
repeat and playback func-
tions, you can choose from five
equaliser modes, as well as
adjust bass and treble as
per your choice. FM
reception is average, and
+;,'-m'{vﬁ' you can scan for available
channels—you can store ten

Back to the basics

With a two-piece design, the Nomad MuVo is similar to the Apac-
er Audio Steno—it can be directly plugged into a USB port. The
device features a white removable USB memory stick that slides
into a blue-coloured module with the battery compartment. The
memory module has playback buttons and a two-colour LED on the
front, with volume controls and a repeat button on one
side. The unit is lightweight and about the size of a cig-
arette lighter. The device supports MP3 and WMA
formats, and also doubles up as a removable
storage device offering up to 64 MB of stor-
age space. However, other features such as
voice recording, FM tuner or an LCD
screen are conspicuously absent.

To transfer music to the
player, all you need to do is
remove the memory stick
from the unit and plug it _-_'--.‘ -
into the USB port of your Q
computer. No cables or drivers are
required for Win Me, 2000, or XP, and it is
automatically recognised as a removable drive. You can use Win-
dows Explorer to transfer files to and from the device. Bundled
software includes drivers for Windows 98 SE and a formatting
utility. The device only plays MP3 and WMA files stored in the
root, and not those stored in folders.

The controls allow you to scroll through the stored tracks,
play, pause, control volume and repeat whole tracks, or a partic-
ular section of a track. There are no equaliser modes or any other
playback features. You cannot view track information, as there is
no LCD display. When the battery is low, the LED blinks red.
Powered by a single AAA battery, the MuVo gave us almost 11
hours of continuous playback. Most people will find the 64 MB
memory capacity insufficient.

Controlling the device is literally child’s play, due to good []

!
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How we Tested

The test bed was a Pentium 4, 3.2 GHz system with an Intel 875
motherboard, 512 MB 333 MHz DDR RAM, a GeForce4 Ti4600
graphics card and a 40 GB Seagate 7200 rpm Serial ATA hard drive,
running Windows XP Professional.

We rated all the MP3 players according to their features,
performance, ease of use, ergonomics, and their value for money.

Features

Features are what make a device more desirable. They make
usability and operability of the device easier. We took note of all
the features supported by the MP3 players such as battery life,
memory size, its interface, backlight, etc. Some important features
are explained below:

Memory size: The higher the memory capacity, the more songs
you can store on it.

Battery type and number of batteries: MP3 players, especially
those with backlit LCD screens, are power hogs. Those with inter-
nal rechargeable batteries are preferred. Also, those that require
only a single battery to operate are preferred over those that
require two or more.

LCD screen and backlight: An LCD is an obvious advantage as it
displays the track, artist and audio format being played. Browsing
the menu is also a lot easier.

Remote control: A remote control brings obvious benefits and
conveniences.

PC interface: Transferring music onto the player is an important
aspect of owning a portable MP3 player. Parallel and serial inter-
faces are outdated, so those with the faster USB 1.1, USB 2.0 and
FireWire interfaces got more points.

Audio formats supported: MP3 isn’t the only compressed music
format anymore. We awarded points according to the number of
formats supported—MP3, WMA, OGG, etc.

Firmware upgrade: Firmware is the software that sits on the chip,
and is comparable to an OS. If a player’s firmware can be upgrad-
ed, it can be relatively future-proofed by adding more features with
newer versions of its firmware.

Voice recording: Voice recording capability can make your player
double as a dicta-phone. This is obviously desirable.

AM and FM Tuner: An in-built radio tuner offers more variety, and
you will not have to make do with only what’s on your player—
especially when you haven’t had the time to load new songs.

ID3 tag: An ID3 tag is basically 128 bytes of track information
stored at the beginning of a song—track name, artist, genre, etc.
Devices that can read and display this information were awarded
more points.

Track Browsing: Track browsing is a much needed feature which
lets you jump to any song, and does not limit you to countless
clicking of the forward or rewind buttons.

Data Storage: Certain MP3 players can double as portable storage
devices. This is an added advantage.

Line-Out: A Line-Out connection allows you to plug your player to

other devices, such as your home or car audio system.

Bundled software and accessories: Free software is always
welcome! We noted the software bundled and its usefulness,

and also made a note of the accessories provided, such as a

carry pouch, arm band etc.

Equaliser: An equaliser lets you tweak the playback to suite your
tastes. We noted the number of presets available, and whether you
can customise the bass and treble levels.

Playlist feature: A playlist lets you choose which tracks you want
to listen to, and in the order you want to hear them—obviously

a boon.

Repeat: The repeat feature lets you hear your favourite song again
and again and again and again and again...

Shuffle: This lets you play songs in random order, for those of you
who love surprises.

Performance

What’s the use of a player with tons of features, but performs
badly. Here’s a list of things we kept an eye out for.

Audio quality: We tested the MP3 players by playing five tracks-
one with high bass, one with high treble, one English track and
two Hindi tracks. Though we used a reference headphone set to
test all the players, we also used the earphones supplied with each
player to test the quality of both the player and its earphones.
Data transfer speed: We noted the time taken to transfer

50 MB set of MP3 files from the test PC to the player using the
bundled software, where applicable. The faster the transfer, the
more points a player earned.

Playtime or battery-life: The playtime was tested by fully
recharging batteries, or inserting new batteries ( as applicable),
and playing music continuously at full volume until the battery
was drained. The players were then awarded points in order of
battery performance.

Ease of use and ergonomics

It is very important for portable devices to be user-friendly. The
buttons should be easily reachable and simple to press. Preference
was given to players with simple yet functional buttons, so that
once you're used to the player you will not need to remove it from
your pocket to control it. An easy-to-use menu structure is a must,
where you will not need more than three clicks to access any
function. We also looked for players with a backlit LCD, for easier
operation in the dark.

Value for money

This is calculated by dividing the feature and performance
offered with the price that the player is available for. This is
especially important, as it gives you a clearer picture about
whether a player is priced correctly as per the features and
performance it offers—the all-important buying decision
depends greatly on this.

button placement. However, as there is no hold-button, if you
carry the player in your pocket you are likely to press some but-
tons inadvertently.

The bundled earphones were extremely clear. However, its
treble was sharp and using the player for long periods is a

painful experience. The time taken to transfer 50 MB of music
to the device over the USB 1.1 interface was a slow 3 minutes
and 38 seconds.

Overall, the portability, user-friendliness and good audio out-
put are the definite plus points of this player. At Rs 5,999, the
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MuVo 64MB provides good value for those who want a no-frills
MP3 player with good audio quality. However, the lack of an
LCD screen and poor features will push music enthusiasts
towards other, more recent, devices.

+ Good audio quality

+ User-friendly Creative Nomad 0
+ Long battery life MuVo 64MB

- NolLCD Performance EEEER
— No voice recording or FM Features EkEKEE
tuner . Value formoney k k k k k
— No playlist or folder support ; R
Price: Rs 5,999 Ease of use

Philips Nike psa[64 Portable Sport Audio

Your workout partner

Boasting of a splash-resistant egg-shaped design, the psa[64 MP3
player from Philips Nike is sports oriented. The buttons are covered
with rubber, and an arm band lets you wear the device on your arm.
The cord on the bundled earphones loops around the back of your
head—the whole idea being to minimise obstruction in sporting
activities. The device comes with a magnetic butterfly clip that can
be used to secure the earphone cord to your clothes, as well as a
wired remote with a magnet that can be stuck to the same clip.

The rubber-coated keypad has a three-way button for con-
trolling next, previous, play and pause functions, apart from
two small keys for controlling volume. The play and pause but-
ton also serves as a power switch. A button for hold, and anoth-
er for selecting equalizer modes are located at the top, on either
sides of the earphone socket. You can also control playback and
volume using the rubber-covered remote.

You need to remove a lid at the rear to access the battery
compartment and the USB connection. With its rugged feel and
splash-proof design, this device does seem to be the best in the
list as far as build quality is concerned. However, the magnetic
butterfly clip obviously tends to stick to anything metal that
comes close, even the earphone buds—that are covered by a
metallic mesh. Secondly, the earphone cord feels
short when you do not use the wired remote.

To connect the psa[64 to your PC, you
have to install the bundled drivers before
it is recognised as a removable drive.

Now you can use Windows Explorer or

the bundled MusicMatch JukeBox

application to transfer your

music files. MusicMatch

also allows you to convert

CD music tracks to MP3 and

WMA files. The Resample Rate

feature in this application allows

you to reformat the tracks trans-

ferred to a lower bit rate. This enables

you to fit more tracks onto the player by creat-

ing smaller files during the transfer, and does not affect the

files stored on the computer. The 64 MB memory accommo-

dates just enough tracks for your daily workouts or com-
mutes—about 12 MP3s encoded at 160 Kbps.

There is no playlist support, and though you can create
folders, the device will only play tracks stored in the root. Also,
you cannot use it as portable storage as it doesn’t allow you to
store any other file types. You can choose from five equalizer

1/2 pageV AD
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Sony ATRAC CD Walkman D-NF611

CD MP3 players do not cost a bomb, and use easily available inex-
pensive media, most play MP3 and audio CDs, and some can

also play VCDs. Apart from being a little bulky and not as
portable as their solid-state counterparts, the main issue
to consider is skipping. Most new CD MP3 players do
come with electronic skip protection that takes care of
this problem. Here is our take on the Sony ATRAC CD
Walkman D-NF611.

The Sony D-NF611 is encased in a plastic /—\
silver body and the front panel features a dot-
matrix LCD, a four-way navigation and play-
back key, a jog dial and five other keys. The
LCD displays the track ID3 information, battery
status, file number, playing time, etc. A hold but-
ton at the rear prevents accidental button pressing.

Apart from the standard MP3 and audio-CD formats, the Sony
D-NF611 supports ATRAC3plus and ATRAC3. ATRAC3 (Adaptive
Transform Acoustic Coding3) is a proprietary compression format
that satisfies the need for high sound quality and compression rates.
Available transfer bit rates for ATRAC3 are 132, 105 and 66 Kbps,
while ATRAC3plus supports 64 and 48 Kbps. However, these formats
are not playable on a computer. Since the player supports both CD-
R and CD-RW disks, you can use the bundled SonicStage Simple
Burner Software to convert your existing audio CDs or MP3 tracks to
ATRAC3plus or ATRAC3 formats and burn them onto a CD-RW to
maximise the playtime. We were able to accommodate about 275
tracks on a standard 700 MB CD-RW using ATRAC3plus at 64 Kbps.

As far as playback options are concerned, you can play tracks at
random, repeat a single track, play tracks within a selected group,

modes, but since there is no LCD, you have to rely on your
ears to know what mode you chose. No LCD also means that
neither song information, nor battery status is available. A few
beeps and a red indicator light warn you that its time to
change the single AAA battery. On the other hand, no battery-
guzzling LCD also means longer battery life, and we logged a
whopping 14 hours of continuous music—much higher than
the rated 10 hours.

Audio output using the bundled earphones was extremely
good, and with the reference headphones, even better. Output
was extremely clear, though a tad sharp using the bundled ear-
phones. However, the psa[64 lost out in data transfer speed. It
took us 3 minutes and 39 seconds to transfer 50 MB of music
using Windows Explorer.

To sum it up, the ruggedness, good audio quality, long
battery life and made-for-sport design of the psa[64 is
suitable for all athletes and fitness freaks who love music
while working out. However, the lack of an LCD screen
and portable storage mode may not make it appealing to a
wider audience.

+ Good audio quality

+ Rugged and innovative design Philips Nike psa[64 e
+ Long battery life Performance EEErERE
-NolLCD ) Features EEEEE
— No portable storage option

; Value formoney k k k k k
— No playlist or folder support ;

L

Price: Rs 8,500 Ease of use EkE 3
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play bookmarks of tracks, or selected playlists. The device supports

m3u playlists burnt onto MP3 CDs. Depending upon the for-
mat of the CD, you can add bookmarks for a fixed
number of tracks for up to 10 CDs. A button at
the side of the device allows you to increase bass
by two levels, and also activate the automatic vol-
ume limiter system.

The D-NF611 also features an FM and AM
tuner, and you can preset up to 30 stations for
FM and 10 for AM. To ensure a skip-free operation,

the player has a two-level G-Protection function—

one for normal use, and the other enhanced level for
use while jogging and exercising. This can be controlled

Jfrom a small switch found under the lid of the player.

You can power the device using two AA batteries, or the bun-
dled AC adaptor for tethered playback. Measuring 136 x 25.4 x
156 mm and weighing 215 gms, the player is a hefty bundle to
carry around, especially as there is no carry case provided. There is
provision to attach a strap though.

Audio quality is excellent and the bundled stereo earphones
reproduce sound with great clarity. However, even considering its
impressive features, this baby may seem a tad overpriced at close
to Rs 10,000.

Price: Rs 9,990
Contact: Sony India Pvt Ltd

Sony ATRAC D-NF611 Q

Phone: 011 — 26959990 Performance  » » » » »
Fax: 011 - 26959141 Features L
E-mail:mktginfo@sid.in.sony.com.sg | Value formoney » » » » »
Web site: www.sony.net/walkman Ease of use P Err

Samsung Digital Audio Player yepp YP-90S

Yepp, it’s expensive!

The mango-shaped Samsung yepp YP-90S is tiny and light, and
sports a silver finish. The feature set is very similar to the LX100,
boasting MP3 and WMA playback, voice recording and an FM
radio. A circular backlit display on the front shows you the name
of the audio-file playing, or the mode selected. Volume controls
and a record button are also located on the front panel. A jog
switch and a mode button are placed on the side, along with the
USB connection. The jog switch is used for playing functions and
scrolling, while the mode button gives access to the menu.

To connect the YP-90S to your computer, you need to install the
bundled yepp explorer. You also get the yepp CD Ripper that can
be used to convert audio CDs into MP3 and WMA. The device does
not show up as a removable drive, and yepp Explorer is the only
way to access the internal memory. Although you can transfer other
file types onto the device, it’s a little pointless as the other PC should
also have yepp Explorer loaded to be able to read the memory.

There is no folder or playlist support, which isn’t really need-
ed for a 64 MB device that can only store 12 MP3s encoded at 160
Kbps. It requires two AAA batteries, and a new set lasted just over
11 hours—as opposed to the 15 hours suggested by the vendor.

Apart from shuffle and repeat, an intro mode is also available.
You can choose between four preset equalizer modes, or customise
bass and treble. The FM tuner comes with 10 presets, but struggles
with less powerful stations. VVoice recording is done in WAV format
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and is reasonably clear. The player switches off automatically, if left
idle for about 5 seconds, and there’s no way to customise this.

Menu navigation is also fairly simple, but the button place-
ment was disappointing. Not only is it difficult to control the play-
er when it is in your pocket, you need to dig deep into the menu
to activate the hold mode. The clip-on carry pouch can be hooked
on to your belt, but you still need to remove the device from the
pouch to access the controls.

As far as audio quality goes, the bundled earphones provided
above average quality output, but with noticeable vibration while
playing heavy bass and treble tracks. It took us 1 minute and 36

seconds to transfer the 50 MB of
music to the player over the
USB 1.1 connection.

The yepp YP-90S
offers a decent set of fea-
tures in an extremely
small package, but its
dependency on its bun-

dled software and absence
of playlist and folder support
may warrant a second thought.
Also, the price tag of close to Rs
10,000 is too high.

+ Decent set of features

+ Fast data transfer Samsung yepp YP-90S e
— Bundled application required to Performance EEE KK
access Ime;noryf d Features EEEEER
—?opaylst 8|L.to e shupport Value formoney ® k B k k
— Average quality earphones

geq y eap Ease of use EkEENRE

Price: Rs 9,990

And the winner is...

Even though there were only five contenders for the top slot in
this comparison, we saw a fair bit of variation in features, user-
friendliness and performance. The Philips Nike psa[64 was the
only player that came with a remote control, but was also the
only one that can’t be used as portable storage. The Creative
LX100 was the only one with an internal rechargeable battery.
The Creative LX100 and the Samsung yepp YP-90S both feature
FM radio and customisable bass and treble settings. The Creative
LX100 is the most feature-rich player amongst the lot, and is also
the winner of our Best Performance award.

Both the Creative players were extremely easy to connect to
a PC, since they do not require any drivers or software. All the
players were small and lightweight, but Samsung was the only
vendor to supply a carry pouch, while Philips Nike came with an
arm band. The latter was the best in terms of intuitive button
placement. The Apacer Audio Steno BP300 is good for comfort
because it comes with lightweight clip-on headphones, in con-
trast to earphones supplied by other vendors.

In pure audio performance, it was a close contest between
both the Creative models and the Philips Nike psa[64. However,
the former impressed us enough with its great sound reproduc-
tion to take the top slot.

For our value for money award, it was a photo-finish between
the two Creative siblings, but the Creative MuVo 64MB won
because of its audio quality, extreme ease of use and a price tag
of just about Rs 6,000.1

DEEPAK DHINGRA
deepak_dhingra@thinkdigit.com
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BOARD
Apacer Creative Creative Philips Nike Samsung
. Model Audio Steno BP300 Digital MP3 Player LX100 Nomad MuVo 64MB psal64 Portable Sport Audio  Digital Audio Player yepp YP-90S \

Storage Type Solid-State Solid-State Solid-State Solid-State Solid-State
Storage Capacity 128 MB 128 MB 64 MB 64 MB 64 MB
Battery Type, No. of Batteries AAA, 1 Li-on, internal AAA 1 AAA 1 AAA, 2
Rechargeable Batterie(s) (Y/N) 0 [m] [m] O O
Separate Power Adaptor (Y/N) 0 O 0 ] O
Inbuilt Display (Y/N) 0 0 O 0 0
Remote Control (Y/N) 0 O [u] O O
PC Interface USB 1.1 USB 1.1 USB 1.1 USB 1.1 USB 1.1
Audio Formats Supported MP3, WMA MP3, WMA MP3, WMA MP3, WMA MP3, WMA
Firmware Upgradeable (Y/N) 0 0 0 0 O
Voice Recording (Y/N) 0 0 0 0 0
AM/FM Tuner (Y/N) 0 0 0 0 0

[l 1D3 Tag Support (Y/N) O O O O O

il Power Saving Mode (Y/N) ] ] ] ] ]

dll Customisable Equalizers (Y/N) O O O O O

E Preset Equalizer Modes Normal, Classic, Jazz, Normal, Classic, Jazz, Nil Funk, Rock, Normal, Normal, Classic,

! Pop, Rock Pop, Rock Techno, Hip Hop Jazz, Rock
Portable Data Storage (Y/N) 0 m] O O
Folder Support (Y/N) 0 O O O O
Bundled Software Audio Update, Audio Win 98 Drivers Format Utility, Drivers MusicMatch Jukebox, yepp Explorer, CD Ripper,

Format, Drivers

Drivers & Utilities

Win 98 Drivers

Bundled Accessories

Headphones, AAA battery,

Earphones, Neck Strap,  Earphones, AAA battery,

Earphones, AAA Battery, Arm

Earphones, AAA batteries,

PERFORMANCE ERGONOMICS

W&S

Neck Strap, USB Cable USB cable Neck Strap, USB Cable Band, Cord Clip, USB Cable Carry Pouch, USB cable
Playback Features |
Custom Playlists (Y/N) 0 0 0 0 ]
Track Repeat (Y/N) 0 0 0 0 0
Track Browser (Y/N) 0 O 0 O O
Shuffle Tracks (Y/N) 0 0 0 0 0
Intro Mode (Y/N) 0 0 0 0 O
Dimensions (mm) WX H XD 93 x 31 x 28 (approx) 80 x 45 x 17.5 73x35x16 60 x 68 x 27 50 x 78 x 21.9
Weight (Gms) 32 51 28 50 36
Intuitive Button Placement (Scale of 5) 2.5 2 8 1315 2
Interface/Menu Navigation (Scale of 5) 3 3.5 4 4 3.5
Earphone Comfort Factor (Scale of 5) 4 3 8 1315 3
Portability (Scale of 5) 4 4 4 4.5 45
Backlit Display (Y/N) 0 0 0 O 0
Screen Contrast Adjustable (Y/N) 0 0 0 0 0
50 MB Data Transfer (secs) 95 116 218 219 96
Battery Life (Hrs) 4.5 10 1 14 1
Audio Quality (Scale of 5)
Heavy Treble & Flange Track 3 4 4 4 2.5
Heavy Bass Track 2 35 4 4 2.5
English Track 2.5 4 4 4 35
Hindi Track #1 3 4 3.5 35 35
Hindi Track #2 2 4 4 4 35
Warranty Period (Years) 1 1 1 1 1
No. of Authorised Service Centres 7 16 16 200 710
Features (50%) 26.00 34.50 16.00 15.50 26.50
Ease of Use (15%) 9.90 10.30 9.20 10.20 10.70
Performance (35%) 15.00 22.60 22.10 23.10 20.40
Value for Money 56.62 68.78 78.85 57.41 57.66
Grade i» [A-) [a] > L

Vendor Name

Xserve India Pvt. Ltd.

Creative Labs Asia Creative Labs Asia

Philips India Ltd

Samsung India Electronics Ltd

Phone

080-5572601

91-98203-57713 91-98203-57713

022-56912334

011-51511234

Fax

080-5572603

NA NA

022-26879268

011-51608818

E-Mail

info@xserves.com

rajshekhar_bhatt@ rajshekhar_bhatt@
ctl.creative.com ctl.creative.com

richa.singh@philips.com

sanjay.gajamer@
samsung.com

CONTACT OVERALL SCORE

Price (in Rs)

8,990

9,799 5,999

8,500

9,990

Disclaimers: All prices are subject to variation, * Lower scores indicate better performance

= 80
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CD-Writers

se the word 'write' in a conversa- only provided an audio cable and the
l ' tion today, and you'll have Nero CD burning software. Other man-

everyone thinking you're talking ufacturers provided a CD-R and in some
about burning a CD. That's how com- cases, a data cable and CD-RW as well.
monplace CD-Writers are today. All and This made Plextor look bad, considering
sundry ran out and bought one when that it’s a premium drive manufacturer.
their prices plummetted, because every- Asus and MSI were the only drives
one wanted a cheap backup solution. that had two separate LEDs to indicate
From a backup of all your office docu- Speed, quality and read and write. The MSI drive was a real
ments, accounts sheets and e-mails to deeds—all put to test looker, with a black front bezel and

your favourite songs, movies and family
pictures, all can be frozen in time on a

transparent buttons which also function

in the battle of drives as LEDs. Some drives had only a single-

little cheap disc. That's the beauty of a coloured LED to indicate both read and
CD-Writer, its just so darn useful, and so write, which is very misleading. If you're
darn cheap! burning something and your sibling
CD-Writers are commonplace now— opens the drive or presses a button,
who needs a CD-ROM drive when a CD- instead of a CD with a back up of your
RW drive can read, write and rewrite, valuable data, you end up with a coast-
and only costs a little more! But wait, e er for your coffee mug.
DVDs are popular too, and almost every- We also checked the features that
one wants one. So, Violal, manufactur- some of the drives provided while the
ers come up with another Jack- ] other’s missed out on, such as Mount
of-all-trades drive—the combination Rainier (see box ‘Jargon Buster’). All the
drive. This drive can not only read, write rI e drives were vertically mountable and
and rewrite CDs, but also play DVDs. thus the real meat of the competition lay
What else could one ask for? Confused? in the performance tests, to which we

CD-Writers and re-writers

It was a well-fought and close competi-
Features - i tion, with some surprising results. We
We received 11 CD-RW drives for the began with the Nero CD Speed and aver-
comparison tests. Since the number was age transfer rate tests. We used an audio
quite considerable and the brands vari- CD so that we could also get the DAE test
ous, we checked out the features and results in one go. Most drives available
package contents of each drive that | today can read sub-channel data and
came in. | audio, and also do EFM correction. The
The Asus CD-RW drive was packed | MSI drive’s DAE test result shocked us. It
to its gills—you name it, they gave it, | scored 0. Surprised, we tested it again,
from an extra data cable, to an audio f and still got 0. This shows a big differ-
cable to connect to legacy sound cards. | ence between the data on the CD and the
All the other drives provided at least a data extracted from it—though when we
CD-R and the CD-writing software. Plex- used the drive to rip audio tracks to MP3
tor and Krypton disappointed us; Plextor and WAV, and compared it to tracks
provided only the Nero writing softwar ripped from other drives, we found no

and their proprietary PlexTools, discernable difference.
with a quick installa- The data transfer
tion guide and test also
warranty shocked
card. us. The
Krypton worst

Don’t worry, we plan on helping you move on next.
decide on a drive, and make the drives

sweat it out in our tests. After all, we're Performance
talking performance and money here!
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of the lot turned out to be Plextor.
We were shocked to see its abysmal data
transfer rate of 8X. Next in line was
the Liteon 48X drive, with a poor trans-
fer rate of 18.9X. The best of the lot was
Asus, with a transfer rate of 39.04X.
It was followed closely by the BenQ with
37.59X and the Liteon 52X, which
scored 36.44X. Transfer times are
most important for transferring data to
a hard disk.

Next up were the access or seek time
tests. Plextor disappointed us again,
with an access time of 126 ms while BenQ
came up tops with 82
ms. In real world per-
formance, this trans-
lates into faster reading
of a disc. The spin-
down time was also noted.

Remember that for higher drive  The Asus drive comes with
speeds, more spin-down time is  a great bundle of goodies

required. Since all the drives had
comparable speeds, it shouldn’t have
mattered here. Again we were in for a sur-
prise—Asus was the worst with 10.56 sec-
onds, BenQ was close behind with 6.82
seconds and Plextor made up for its for-
mer poor performances by topping this
test with 0.01 seconds.

SiSoft Sandra was used to gauge the
sequential and random read speeds. The
sequential read speeds remained stag-
nant between 3.5 and 4 MBps for most
drives. However, in the random read
speeds, Krypton topped the tests with a

Copy-Protection

Copy-protection is the technology
devised to protect media content,

be it streaming or static, from being
copied. Although, it is okay to make
one personal backup copy of any
media for archival purposes, media
companies are taking no chances

and are aggressively using different
copy protection techniques to protect
their content. Some very popular
techniques in use by game publishers
are SafeDisc from Macrovision and
SecuROM from Sony. Audio CDs use
Cactus Data Shield by MidBar
Technologies.

SafeDisc: SafeDisc 2 is the latest
incarnation, and comprises three main
features—an authenticating digital
signature, encryption that protects the
content and anti-hacking software.
SecuROM: SecuROM is a copy-

EED 83

speed of 1,186 KBps. Samsung had the
lowest score with 787 KBps, which was
surprising considering its 8 MB buffer.
Samsung also did badly in the access
time test, with 254 ms. The honours for
the fastest access time went to the Kryp-
ton 52X, followed by the Liteon 52X and
the Plextor respectively.

Finally, we ran the extraction tests,
in which the drives had to extract the
first, middle and last track from a pressed
audio CD. The AOpen drive was the
fastest and the Asus drive came in last.

In order to test the drives for writing

and re-writing, we did
many tests involving

the burning and rip-
~___ ping of audio and
e

= data CDs.

The first test was the
sequential write test,
in which we used a 700
MB movie file
and timed the burning process. The Sony
52X proved to be the fastest, burning the
file in 155 seconds, the Asus 52X was the
slowest, taking 174 seconds.

The assorted CD burning test was a
neck to neck competition. The LG 52X
took the crown with 153 seconds, sur-
passing even its own sequential write
time. Samsung timed a very poor 207 sec-
onds, leaving us wondering where its 8
MB buffer went.

The CD-to-CD copy test proved to be
the Liteon 52X’s undoing, which took a

protection technique made by Sony
and is employed by game publishers.
The process involves adding a unique
electronic SecuROM key to the CD-ROM
using special glass-mastering equipment
also manufactured by Sony DADC. The
catch lies in the electronic key, which is
difficult to copy to a CD-R.

These protection techniques can
be worked around using certain copying
software. CloneCD is one such one-to-
one backup CD software that is
commonly used. We tried copying a
few copy protected discs using CloneCD,
to get around Safedisc and Securom
protection for all the drives we tested.
All the drives were able to circumvent
both Safedisc and Securom—except for
the twins from BenQ, which failed both
the tests, and the LG GCE-8523B which
failed the Securom test.
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test drive " CD-Writers

The system we tested the drives on was a
Pentium 4, 2.8 GHz on an Intel D850MV
motherboard with integrated sound card
and 512 MB RD RAM, a GeForce3 display
card, a 40 GB Seagate Barracuda as pri-
mary master and a Samsung 52X CD-
ROM as primary slave, running Windows
XP Professional. All drives were then con-
nected as secondary masters, and their
performance in the various test cate-
gories was noted. Performance account-
ed for 90 per cent of the drives score,
while the remaining 10 per cent was
based on less important details such as
packaging, half-height, etc. The value for
money was calculated as a scaled ratio of
the scores, obtained in the features and
performance tests, divided by the price of
the drive. To make things easier, we
divided the drives into two categories—
CD-Writers and combination drives (CD
read, write, rewrite and DVD read).

CD read, write and re-write
tests

These tests are common for both cate-
gories. We used Nero CD Speed and SiSoft
Sandra for the read speed test.

Nero CD Speed: This software is used to
test the data transfer rate, access or seek
time, CPU usage time, the burst rate of
the drive, drive motor spin up and spin
down, and finally, the DVD eject and
load time. Tests that are related to time
are measured in milliseconds; data
transfer is either measured in KBps or
MBps while drive speeds are measured
in terms of X. We used the same data
CD on all the drives.

We also did a Digital Audio Extraction

Plextor Premium

Does the thought of fitting 1 GB of data on a 700 MB CD
interest you? Well, this Plextor drive lets you do just that.
Not only can you fit 1 GB of data on a normal 80 minute,
700 MB CD-R, you can password-protect your data as
well. If you try playing this password-protected CD on any
other computer, you will get a disc-read error. This can be
controlled by downloading the SecuView software and
running it on the system where you want to view the CD.
Plextor calls this feature GigaRec, and the password-
protection feature is called SecuRec. The maximum
capacity of a disc is dependent on the type of disc and the
GigaRec rate. All this looks rosy, but there are a few
catches—the discs burned, using the Gigarec feature are

not read correctly in some drives.

I 84
99 124
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How We Tested

(DAE) quality test of the drives. In this
test, the software extracts audio sectors
from three different locations on the

CD and stores it on the hard drive. The
CD is then read again, and compared

to the extracted audio on the hard drive.
A pressed audio CD was used to get

the DAE quality results. Nero CD Speed
assigns scores ranging from 0 to 10

for the DAE test, with 10 given for

no difference in the files.

SiSoft Sandra: Here, we measure the
Sequential and Random Read speeds of
the drive, as well as the average access
time. The media used here is the same
data CD that was used for the Nero test.
Higher results in the Sequential and
Random read speed tests, and lower
access times, attracted more points.
Audio Extraction Speed Test: We used a
pressed audio CD and extracted the first,
middle and last tracks from it audio CD.
The criteria considered here were the time
taken by the drive to rip the tracks and
convert them to .wav format. The audio
CD used was the same for all the drives.
The quality of the track is not given much
importance; however, the presence of
audible hisses, clicks and pops was noted,
and subtracted from its score.

CD writing tests: This is a complete bat-
tery of tests which was common for both
categories of drives. The tests comprised
writing data sequentially (single file test),
random writing (assorted write test), burn-
ing an image file, a CD-to-CD copy test
and writing an audio CD. The time taken
for each is measured and the points are
awarded accordingly. The Samsung 52X
CD-ROM on our test bed was used in the

whopping

509 seconds.

The MSI fin-

ished the
fastest, with 448
seconds. Moving to
the assorted data CD
re-writing test, the BenQ
drive took the top spot
with a speed of 217 sec-
onds. The MSI drive was
the first to erase the re-
writable disc, finishing in
just 218 seconds. The
AOpen finished last, tak-
ing 312 seconds for both
the writing and erasing.
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The AOpen CRW 5224
is a slow re-writer
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CD-to-CD copy test for all drives. We also
used the fastest media available—48X.

CD re-writing tests: We did two tests
here—the assorted write speed test and
the CD-RW full erase test, and the time
taken for each was noted. We had to
make do with 24X re-writable media, as
this is the fastest available.

Copy Protection Tests: This is a new
category of tests, which comprises of
making a back up of a game or data CD
that is copy protected. This is important as
it is a very gruelling task for the drives, and
helps us test the lens quality. Points were
awarded to the drives which were able to
perform this test without any hitches.

DVD read tests

For the DVD performance test, we used
three different software; each covering

a particular aspect of the drive’s read
performance.

Nero DVD Speed: This test was the same
as the CD tests, except we used a pressed
DVD. The same DVD was used to test all
the drives. Also, the maximum number of
DVD formats supported was also consid-
ered—and scores were awarded accord-
ingly. Points were given for access time,
burst rate, spin-down time and disc
recognition times.

SiSoft Sandra: This test was performed
twice for the combo drives, to measure
both CD and DVD read speeds.

DVD Decrypter: This software is used

to extract a .vob file from the DVD to

the hard drive, and the time taken is
measured. This test was only applicable
for combination drives. Lower extraction
times were given higher scores.

In the EFM test,

-~ the drives were
E_—!_—' supposed to make
; an exact copy of an

EFM encoded,
copy-protected  disc.
The BenQ failed this
test, while all the others passed with fly-
ing colours.

There were a few annoying things
that we came across while testing.
The AOpen, Sony and MSI drives are set
to run at a fixed speed of 40X, with
48X for Sony. You need to press and
hold the eject button to make the
drive write at faster speeds. Also, the
BenQ drive was temperamental and
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refused to work on

any system that had ———e——— |
BlindWrite installed. o (—
The Patin-Couffin _ L e *

) . JI_ .IJ_.
layer that installs with

the default installation of
the software was found to
be the culprit.

Combination drives

With the advent of DVD-ROM drives and
the spread of CD-R and RW drives, it was
just a matter of time before drives that
combined the two began popping up in
the market. Combination drives are now
very affordable and also space saving.
International brands such as Toshiba,
TEAC and Hitachi are still not available in
the Indian market, and we tested the five
available brands—BenQ, LG, LITEON,
Samsung and Sony.

The Samsung SW-352’s 8 MB
buffer does not seem to help it

The packaging and
contents of all the drives
were similar. Liteon and
Sony were the only
drives that had a half-
height form-factor. This
is useful for people who
have micro-ATX boards
and small cabinets. Also, another advan-
tage was the support for the Mount
Rainier standard. Most drives featured a
standard single eject button and multi-
coloured LED on the front bezel. Sam-
sung was the only drive that had a 52X
CD write and 16X DVD read speeds.
BenQ was the slowest with 32X CD write
and 12X DVD read speeds.

We used a non-encrypted data DVD-
ROM for our Nero DVD Speed tests. The
test results were quite surprising, to say
the least. Especially the burst rate tests,

Decision Maker

You want | You need Look for

To backup a | A high perform- | A 52X CD-Writer with
more buffer size

A multi-pur- | A good combina-A combination drive that| Sony CRX 300 A or
gives good performance |Liteon LTC-48161H

lot of data | ing CD-Writer

pose drive | tion drive

The models Price range
Krypton 52X/32X/52X |Rs 2,900 to
or Liteon LTR-52327S |Rs 3,500
Rs 4,200 to
Rs 6,300

DVD Regions and Its Intricacies

Soon after the DVD format was

standardised world-wide, the movie

industry divided the world into six

regions. These are:

Region 1: USA and Canada

Region 2: Europe, Near East, South Africa
and Japan

Region 3: South East Asia

Region 4: Australia, Middle and South
America

Region 5: Africa, Asia and Eastern Europe.

Region 6: The People’s Republic of China.

This was done mainly to stop the
movement of movies across boundaries.
Earlier, PC DVD-ROM manufacturers
earlier used to manufacture region-free
DVD drives that could play DVD’s from
any region. Such drives were called RPC-
1 drives. But after January 1, 2000, this
changed; The new RPC 2 drives were
region locked. You can only change the
region five times, after which your drive
is locked to the last selected region.

For the region protection to work, the
disc itself must be set to a specific region
code (which most discs are), and then
either the DVD drive or the playback
software must match the disc’s code to
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their own code for playback to work. If
the drive itself is locked, the software or
hardware decoder will rely on the drive
to confirm the region match. If the drive
is region free, then the decoders try to
enforce the region protection.

If your drive is set to a specific
region, you will be unable to play a
disc from a different region. This can
not be bypassed without replacing the
checking mechanism within the drive
itself. This can only be done with a
firmware update.

However, there is software that help
the drive bypass this protection. One such
software is DVD Region Free, which we
used to test the drives and see if it could
bypass the region-coding protection. We
used a Region 1 DVD to test the drives.
None of the drives were set to any specific
region and with DVD Region Free
disabled; the dialog box to set the drive to
a specific region popped up when we
tried playing the DVD in PowerDVD XP.
Once the software was enabled, the DVD
automatically started to play. The software
side-stepped the code and successfully
played the DVD on all the drives.
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BOARD
COMBINATION DRIVES
BenQ LG Lite-On Samsung Sony
- Model 1232C 44808 LTC-48161H SW-352 CRX 300A \
Drive Specifications |
Speed 32X/ 10X/ 40X/ 12X 48X/ 24X/ 48X/ 16X 48X/ 24X/ 48X/ 16X 52X/ 24X/ 52X/ 16X 48X/ 24X/ 48X/ 16X
Interface Type E-IDE E-IDE E-IDE E-IDE E-IDE
Data Buffer Size (MB) 2 2 2 8 2
Tray build quality 8 35 4 3 3
Controls on the drive front bezel Single eject button Single eject button Single eject button Single eject button Single eject button;
dual purpose
[ Indicator LED's Single, Multi-colour Single, Multi-colour Single, Multi-colour Single, Same Colour Single, Same Colour
5 Vertically Mountable 0 3] 3] 5] 3]
i Half-height O O
E Silent Operation (scale of 5) 35 4 4 3 4
N Mt.Rainier Support ] O O O O
Package Contents
Data Cable g O O O O
Audio Cable O ] [B] [m] [m]
Manual a O O O O
CD-R O | 0 O 0
CD-RW a 0 0 O O
CD Writing Software/ DVD software 0 0 O 0 O
DVD Read Performance : Nero DVD Speed
Average Transfer Rate (X) 5.59 2.83 6.27 2.719 6.39
Random Access/ Seek Time (millisecs) 83 81 70 61 60
CPU Usage (1X) 32 31 36 34 33
Burst Rate (MBps) 0.6 1 20.3 0.8 20.2
Spin Up/ Down Test (spin down time) (sec) 1.49 3.2 174 0 178
Eject/ Load Test (recognition time) (sec) 9.07 5.23 4.85 3.16 5.3
SiSoft Sandra 2003
Sequential Read MBps 7 315 5 8 4
Random Read KBps 752 697 675 1088 673
Access Time (recognition time) (fullstroke, ms) 305 297 324 205 324
VOB file extraction test (DVD Decrypter) |
Extraction time required (sec) 161 104 52 4 53
CD Read Performance: Nero CD Speed |
Transfer Rate (average) measured in X 21.31 30.98 373 34.73 31.86
Access/ Seek Time (random) (millisec) 88 96 91 116 91
CPU Utilisation (8X) % 12 5 15 84 16
Y Burst Rate (MBps) 364 KBps [ 16 i 16
I8 Spin Up/ Down Test (spin down time) (sec) 2.29 4.09 3 0 3.03
§ Eject/ Load Test (recognition time) (sec) 6.21 5.64 6.52 .7 6.62
59 DAE Quality 5 10 10 10 10
Y SiSoft Sandra 2003
4 Sequential Read (MBps) 2.9 35 4 315 B
Bl Random Read (KBps) 455 868 998 756 998
Access Time (recognition time) (fullstroke, ms) 482 225 195 268 186
Extraction Test (dbPowerAmp)
Track 1 (sec) 13 7 5 7 9
Track 8 (sec) 9 10 5 6 10
Track 15 (sec) 1l 4 8 27 5
CD Write Performance: CD-R
Single data file write (sec) 347 1M 167 173 188
CDR assorted data write (sec) 350 172 189 17 163
iso write (sec) 257 131 131 152 131
CD Copy (sec) 355 240 487 218 219
Audio CD write (sec) 313 158 157 189 154
CD-RW |
Assorted Write (sec) 486 221 295 225 292
RW Erase (sec) 518 223 290 227 283
Warranty & Support(Years) 1, Carry in 1, Carry in 1, Carry in 15 months from the date of 1, Carry in
manufacture
g Features (10%) 4.63 6.15 6.54 1.70 6.28
il Performance (90%) 41.68 65.05 66.99 67.08 68.97
Ed Value for Money 9.26 14.83 17.30 14.24 12.04
5 Grade O [T o [C-) L
Vendor name BenQ India Pvt Itd LG Electronics Mediatech India Samsung Electronics Rashi Peripherals
o India Pvt Ltd India Information &
2 Telecommunication Ltd
I8 Phone 022-25705231 0120-2560900/ 940 022-22014083 011-51511234 022-28260258
Ml E-mail salesenquiryin@beng.com response@Igezbuy.com sales@mediatechindia.com marketing@samsungindia.com ho@rptechindia.com
Price (In Rs) 5,000 4,800 4,250 5,250 6,250

Disclaimers: All prices are subject to variation, * Lower scores indicate better performance
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Jargon Buster

Access Time: The total time a device
requires to find and retrieve a piece of
information.

Absolute Time In Pre-groove (ATIP):
Address and recording information
encoded in the wobble groove on CD-R
and CD-RW media. Based on this
information, a burner can determine the
absolute position in Pregroove.

Buffer Under RuN (BURN)-Proof: For a
CD-RW drive to support the BURN-Proof
feature, it must make use of a special LSI
(Large Scale Integration) chipset. These
chips contain proprietary microcode
developed by Sanyo. In order for BURN-
Proof to work, the CDR Software used for
recording must also be BURN-Proof
compatible.

Eight bit to Fourteen bit Modulation
code (EFM): EFM is the modulation code
used in all CD recording. This low-level
and very critical channel coding
technique maximizes pit sizes on the disc
by reducing frequent transitions from O
to 1, or1toO.

Error Correction Code (ECC): A system
of scrambling and recording redundant
data onto the disc as it is recorded.
During playback, this redundant
information helps to detect and correct
errors that may arise during data
transmission.

Firmware: Firmware is the programming
instructions contained on a ROM chip
within the CD recorder, which tells

the recorder how to respond to
commands issued by software. Some
firmware is flash-upgradeable—you

can upgrade the firmware by running

a piece of software. Other firmware is
coded into a non-rewriteable chip, so
the entire chip must be changed in
order to upgrade firmware.

where we got extreme highs and lows of
data transfer. Liteon and Sony were
neck-to-neck in competition with 20.3
MBps and 20.2 MBps respectively, while
the other three drives languished below
the 1 MBps mark. The Samsung drive
took the crown in the disc recognition
tests with a time of 3.16 seconds; BenQ
came in last with 9.07 seconds. Sony
won the transfer rate tests, with a speed
of 6.2X; Samsung came in last with
2.79X—the increase in buffer size did
not seem to help much.

In the SiSoft Sandra tests, it was the

dicitf: 4

ISO 9660 Format: The most common
international standard for the logical
format for files and directories on a CD-
ROM. Some other common logical
formats such as Joliet and Rock Ridge are
extensions of 1ISO 9660.
Joliet: Joliet is an extension of the I1SO
9660 standard developed by Microsoft to
allow CDs to be recorded using long
filenames, and using the Unicode
international character set. Joliet allows
you to use filenames up to 64 characters
in length, including spaces.
Lead-In: An area at the beginning of
each session on a recordable compact
disc which is left blank for the session’s
Table of Contents (ToC). The lead-in is
written when a session is closed, and
takes up 4,500 sectors on disc (1 minute,
or roughly 9 MB).
Lead-out: An area at the end of a session
which indicates the end of the data. The
first lead-out on a disc is 6750 sectors
(1.5 minutes, about 13 MB) long. Any
subsequent lead-outs are 2250 sectors (.5
minute, about 4 MB). Writing the lead-
out closes the session.
Mount Rainier: This is a standard for
high speed CD-RW drives that enables
native OS support for data storage on
a CD-RW disc. It makes data storage
easier by including features such as
defect management, drive 2K
addressing, background formatting
and standardisation of both the
command set and physical layout of
the drives.

One of the biggest advantages
of having a Mount Rainier supported
drive is that you don’t need to wait
for the drive to format a CD-RW before
putting some data onto it. This is the
background formatting feature at work.

Samsung which shone in the sequential
read tests with a transfer rate of 8 MBps,
while the BenQ surprised us with a good
7 MBps, leaving the other three drives
eating its dust. The same trend was
repeated in the random read tests. The
access time scores were a completely dif-
ferent story with the Liteon and Sony
drives finishing last. Samsung again took
the top honours with 205 seconds fol-
lowed by LG with 297 seconds.

In the VOB file extraction test, the
Samsung 52X finished the extraction in
just 41 seconds, 11 seconds earlier than
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test drive " CD-Writers

BOARD
catecory B oo
Aopen Asus BenQ Krypton LG LITEON LITEON
. Model CRW 5224 CRW-5224A CRW5224W 52X32X52X GCE-8523B LTR-48246K LTR-52327S
Drive Specifications |
Speed 52X/ 24X/ 52X 52X/ 24X/ 52X 52X/ 24X/ 52X 52X/ 32X/ 52X 52X/ 24X/ 52X 48X/ 24X/ 48X 52X/ 32X/ 52X
Interface Type E-IDE E-IDE E-IDE E-IDE E-IDE E-IDE E-IDE
Data Buffer Size (MB) 2 2 2 2 2 2 2
Tray build quality (Scale of 5) 35 4.5 3 1315 4 4 4
Controls on the drive front bezel Play, Next Track & Stop, ~ Play, Next Track,  Play, Next Track, Play, Next Track, Single eject button Single eject button Single eject button
Eject and Stop, Eject Stop, Eject Stop, Eject
Indicator LED's Single, Multi-colour 2 Single, Single, Multi-colour  Single, Same Colour Single, Multi-colour Single, Multi-colour
= Multi-colour
3
4 Vertically Mountable O O O O O O O
4| Half-height O ] O ] ] 5] 5]
E Silent Operation (scale of 5) 35 4 4 3 4 4 4
Bl Mt.Rainier Support O ] O O O O O
Package Contents
Data Cable o o O O O O
Audio Cable O ] O ] 0 O |
Manual m] ] O O O a a
CD-R O ] 0 O O ] ]
CD-RW ] ] 0 0 0 0 ]
CD Writing Software 0 a 0 g ] O O
CD Read Performance: Nero CD Speed |
Average Transfer Rate (X) 3116 39.04 371.59 31.36 31.54 18.9 36.44
Random Access/Seek Time (millisecs) 90 109 82 83 106 84 85
CPU Utilisation (8X) % 8 7 6 6 100 49 22
Burst Rate (MB/s) 1 17 18 17 17 3 17
Spin Up/Down Test (Spin down time) (sec) 3.79 4.1 6.82 2.39 2.13 419 4.69
Eject/Load Test (Recognition time) (sec) 3.35 10.56 3.63 7.81 4.36 5.62 5.44
DAE Quality 10 10 10 10 10 10 10
SiSoft Sandra 2003 |
Sequential Read (MBps) 3.4 3.7 4 4 35 4 4
3 Random Read (KBps) 905 910 993 1186 998 980 1162
=l Access Time (Recognition time) (Fullstroke, ms) 21 215 200 155 185 209 164
u:J Extraction Test (dbPowerAmp) |
B Track 1 (sec) 4 10 10 6 6 9 7
P Track 8 (sec) 7 12 6 6 9 15 7
ol Track 15 (sec) 4 15 8 5 7 18 4
il CD Write Performance: CD-R
Single data file write (sec) 174 175 168 157 156 159 156
CD-R assorted data write (sec) 180 183 172 173 153 161 156
1S0 write (sec) 126 139 121 130 123 130 125
CD Copy (sec) 452 466 459 454 451 483 509
Audio CD write (sec) 145 155 142 161 166 164 147
CD-RW
Assorted Write (sec) 312 231 217 219 233 298 220
RW Erase (sec) 312 227 224 230 231 295 225
Warranty & Support (Years) 1, Carry in 1, Carry in 1, Carry in 2, Carry in warranty 1, Carry in 1, Carry in 1, Carry in
4l Features (10%) 5.58 7.52 6.29 4.94 6.38 6.08 6.46
gl Performance (90%) 7.81 69.16 76.64 82.62 73.26 61.26 80.67
é Value for Money 29.20 21.91 29.62 29.28 28.44 26.67 29.09
By Grade Ly €“» Ty Ly o o> o>
Vendor name Xserve India Pvt Ltd Asus - India BenQ India Pvt Ltd Priya India Ltd LG Electronics Mediatech India Mediatech India
India Pvt Ltd
3
E Phone 080-5572601 9820213336 022-25705231 022-56663100 0120-2560900-940  022-56396696 022-56396696
o] E-mail bhavna_gupta@ info_india@ salesenquiryin@ priyabom@ response@ sales@ sales@
Xserves.com asus.com.tw beng.com priyagroup.com Igezbuy.com  mediatechindia.com mediatechindia.com
Price (In Rs) 2,650 3,500 2,800 2,990 2,800 2,525 2,995
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CD-WRITERS

MSI Plextor Samsung Sony
CR52-M W5224TA SW 252 CRX220E1 \
52X/ 32X/ 52X 52X/ 24X/ 52X 52X/ 24X/ 52X 52X/ 24X/ 52X
E-IDE E-IDE E-IDE E-IDE
2 2 8 2
4 4 3 4
Play, Next Track, Single eject button  Single eject button  Single eject button
Stop, Eject
2 Single, Multi-colour ~ Single, Multi-colour  Single, Multi-colour
0 0 0 0
O O O O
4 4 3 4
O O O O
O ] O
0 0 0 0
0 [ (Quick On CD-RW 0
installation guide)
O O O O
0 0 0 0
0 ] 0 0
31.88 8 31.42 31.51
78 126 91 86
6 97 9 14
1 17 1 17
0 4.16 1.39 4.24
8.96 0.01 4.07 5.43
0 10 10 10
33 35 35 35
902 1100 787 933
208 161 254 204
12 9 7 9
6 24 6 6
9 17 6 5
163 172 158 155
164 183 207 157
125 139 126 129
448 477 457 491
149 159 152 144
223 238 279 294
218 231 284 296
1, Carry in 1, Carry in 15 months from the 1, Carry in
date of manufacture
6.46 4.88 1.25 6.08
.72 65.68 67.80 .12
25.22 10.09 21.44 14.99
LA o LE ) o
Cyberstar Zeta Technologies  Samsung Electronics ~ Rashi Peripherals
India Information &
Telecommunication Ltd
080-2276986 022-24102288 011-51511234 022-28260258
narend@ tejas@ marketing@ ho@rptechindia.com
cyberstarin.net zetaindia.com samsungindia.com
3,100 6,990 + taxes 3,500 5,150
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its nearest competitors Liteon and Sony, who finished with 52 and
53 seconds each. This bodes well for the Samsung drive, as faster
data transfer rates is good for users who are always copying data
to and from the hard drive.

The Nero CD Speed tests also saw some very tough competi-
tion. All the drives gave a DAE quality of 10 with an accurate
stream, except BenQ, which logged in a DAE quality score of 5
without an accurate stream. The LG 52X had the fastest disc
recognition time, while the Samsung came in last. The LG drive
stood first in the CPU utilisation tests, needing only 5 per cent
CPU power at an 8X read speed, while the Samsung logged in the
highest with 84 per cent—not good news if you intend to multi-
task. All the drives successfully backed up the copy-protected data
discs-except the BenQ drive, which failed both the copy-protec-
tion tests.

And the winner is...
CD-R/RW drives
The Krypton 52X/32X/52X was the unanimous winner

in terms of performance. It beat all the big brands and =y

came out tops in the performance tests, earning our -

Best Performance award. Although the manu- -

facturers still need to take care

of the packaging and at least — |

provide aCD-Rwith thedrive. |« | |sswyrioss |
The BenQ CRWS5224W o TR = ok

was the winner of the
Best Value award. The pack-  The only thing the Krypton
aging of this drive isamong  |acks is packaging frills
the best and it
also packs in a 2 MB buffer,
rrreny costs less than Rs 3,000 and
gl ——'  a1year warranty.

|
1] =

-
The BenQ has all it takes to

please your wallet
it
Combination Drives —
The Sony CRX 300A drive [ e W OO
—— __
showed extremely good g = -

performance results,

=T i and took our Sony is the best performer, speed
] limit not withstanding
- 2 = Best Performance award.
LN - e The build quality of this

: drive is quite good and ti has
a 2 MB buffer which takes care of
the buffer under-run risks. If only the
speed limit feature could be turned off

The Liteon LTC-4161H is
a valued performer

somehow!

The Liteon LTC-48161H takes the best value award. It is
the lowest priced drive among all the entrants, and also does a
pretty good job in all fields.

BHASKAR BANIK
bhaskar_banik@thinkdigit.com
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ith the arrival of digital cam-
eras, we don’t think twice
before clicking away to glory.

Unlike their film-based counterparts,
digital cameras have no costs associated
with each photo clicked. Due to the
sheer number of images stored on the
computer, we end up with file names
such as ‘000_0121.jpg’. Now, renaming
all these images is a nightmare, and
searching for a particular image becomes
downright exasperating.

For those who occasionally snap
images and have only about a hundred
images to manage, the image manage-
ment in Windows XP is sufficient. It also
comes with Camera Wizard that helps
you transfer images from the camera to
the hard drive. Most cameras come bun-
dled with basic image management soft-

ware, but these are just like the Windows
Explorer—they will let you browse
through your pictures and let you
arrange them in different folders, but not
much more.

The digital camera, and the problems
of management that it brought along
with it, has spawned a new market for
software developers. Most imaging soft-
ware companies such as Adobe and Jasc,
have released products in this segment,
and existing players such as ACD and
Ulead, have greatly improved theirs.

Although these software don’t have
any precise requirements, their target
audience is very clear—the home seg-
ment. Considering this, it is imperative
that the software be user friendly.
The majority of the target users are
novices, and so user-friendliness has

Unique Filer 1.4

Zero Assumption Digital Image |
Recovery 1.0

Find it on the Mindware CD

Ve

been given precedence over features in
the tests we did.

ACD See 5.0

ACD See is one of the more popular
photo management software. Sadly, it
still carries the dated interface, even in
version 5. Compared to other software, it
has a cluttered interface that is difficult
to navigate. Removing some menus and
the side pane would help, but that brings
down usability. Browsing a large
database of images might be difficult for
new users.

Clicking away all the time, but no album to show for any of it? We give you the superpowers needed
to organise, clean, edit and send all your photographs

=190
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The cluttered interface lets ACD See down

A calendar view lets you view images
by the year, month or date they were cre-
ated. Although this is an improvement,
it’s nothing compared to the timeline
feature provided by other software. ACD
See has a comprehensive search feature,
allowing you to search by varied criteria
such as colour depth. But this gift has
become a curse; there is not a single field
where the user can enter keywords.

The slideshow is another area where
ACD See shows signs of aging. Creating
a custom slideshow using images from
multiple directories is difficult. An
important area that ACD See has com-
pletely left out, is that there is no tool
for creating calendars, albums, or e-
cards.

On the brighter side, the software
provides a decent image editor—apart
from basic image editing features, it
allows you to use various easy-to-use fil-
ters such as pencil drawing and oil paint.

Moreover, the software can be used as
the default viewer for all image files.
However, in the end, the software does-
n’t serve its basic purpose, and is a prod-
uct you can do without.

Adobe Photoshop

Album 1.0

Adobe has entered this segment with
Photoshop Album. It has all the traits of
an Adobe product, from the friendly
interface to the long boot up time that
lets you memorise the names of the pro-
grammers that appear on the splash
screen. Nevertheless, Photoshop Album
is a comprehensive image management
software.

User-friendliness is a characteristic
that can be seen everywhere in the soft-
ware. There are a few features that help
this software beat the crowd—the time-

T S I et S B Y 1-
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Photoshop Album has a very useful Timeline
feature

How We Tested

We tested the software on a Pentium IlI
500 MHz system with 128 MB RAM, run-
ning Windows XP. A total of 200 images
consisting of a mixture of existing images
and photos taken using a Kodak CX6330
were used. The software were rated on
the following features:

Interface: Being targeted at the home
segment, the interface should be user-
friendly. It should not be cluttered with
buttons and menus, and all the important
features should be easily accessible.

Ease of browsing: This is the most impor-
tant aspect of the software. One should
be able to view all the images based on
parameters such as date, captions, etc.
The software should have good searching
abilities, based on more than one search
criteria. You should be able to view the
images by creating custom slideshows.

Image Editing: Apart for basic features
such as cropping, size reduction, rotation
and resizing, the software should be able
correct some common errors in the
images, such as red eye effect, glare, etc.
The ability to add some effects to the
image is a bonus.

Printing support: The layout of the print
should be controllable, such as the num-
ber of images on a side. The program
should also offer features such as index
print. The software should provide fea-
tures to use the images in the form of
greeting cards, calendars, and albums. It
should support archiving of images.
Extra features: Most software have
unique features such as creating
Panaromic images, PDA support, etc.
These features may be appealing to cer-
tain people.

A Little Extra

A standard called EXIF (Exchangeable
Image File Format), developed by the
JEIDA (Japan Electronic Industry
Development Association), is used in all
cameras. Digital cameras use the EXIF
format to store information related to the
image taken, such as the date and time
the photo was taken, model of the cam-
era, the X resolution, Y resolution, expo-
sure time, aperture value, etc.

Most image management software
make use of the EXIF standard. Though
novice users may not find much use in
this, professional photographers can use
this information to search for an image
based on a specific parameter.

line shows the dates at which images
were taken, and small bars indicate how
many images were clicked in that month
or on that date.

The second feature that makes Pho-
toshop Album stand tall is its various
ways of using images. One can create
greeting cards, calendars and photo
books, and even embed audio. The Cre-
ation Wizard makes the whole process a
breeze, but all these creations can only
be saved only as PDF files.

Another unique feature lets you
search for an image that is visually sim-
ilar to another. Select the images to be
used for reference, and select Find > By
color similarity with selected photo(s) to get
all the similar images on your hard drive.
You can also create 3D virtual rooms
with your images on the walls, and take
a 3D tour of a room.

Photoshop Album does have its
share of woes. You cannot select multiple
images by clicking and dragging the
mouse over them, as in Windows Explor-
er. Also, the program only offers basic
image editing features, and you cannot
add any special effects to the images. In
spite of these limitations, Photoshop
Album’s user-friendliness and features
make it an attractive buy for home users.

Picasa 1.0

In direct contrast to ACD See, Picasa has
an excellent interface. It is simple, with few
but relevant buttons. The scroll bar posi-
tion indicator always stays in the middle,
and only needs to be dragged slightly to
scroll. Another scroll bar at the bottom of
the screen lets you adjust the number of
thumbnails you see on the screen.
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Picasa’s interface is a pleasure to use

Folders are listed as separate albums,
and you can import images from the
camera or from albums—there is also an
option to exclude duplicates that have
same file name. Picasa has a picture tray
in the bottom, to which you can drag
images that you wish to club together—
to view as a slideshow, print, e-mail, etc.

Picasa also has an innovative and
original timeline. Unlike Photoshop
Album, which has a static timeline,
Picasa has a dynamic timeline—when
you select ‘Timeline,” the program goes
into full-screen mode showing the time-
line as an arc. The albums are arranged
according to the date of the first image.
So the timeline can be used more as a
tool for general browsing, rather than for
strict sequential viewing of images. In
the full screen mode, however, the
images are slightly blurred.

In the editing department, Picasa
provides only three features—red eye
removal, crop and single-click enhance.
Another sore point is that it can’t be used
for viewing images. Double-clicking a
thumbnail only gives a bigger view of
the image, and you can’t zoom. To view
an image in full screen, you have to

PDA your Images

PDA users can use an application called
PhotoMeister (www.photomeister.com).
This image management software allows
you to create photo albums that can be
viewed on your PDA. The creation
process is fairly simple. Select the images,
and click a button at the bottom. The
wizard will ask you a series of simple
questions, such as which OS your PDA
runs and the resolution to be used. It
then creates a photo album file that you
can copy to your PDA. There are many
other applications that do a similar job,
such as Hero E-Photo Album
(www.heroshare.com).

enter the slideshow mode, which again
shows blurry images.

This software is acceptable only for
those who want an easy-to-use interface,
and do not need even basic image
editing features.

Paint Shop Photo Album 4
Jasc’s After Shot is now re-christened
Paint Shop Photo Album. Compared to
its adversaries (Adobe Photoshop Album
and Ulead Photo Explorer) it is toothless,
with an average interface and Explorer-
style browsing. Though it uses the con-
ventional interface, the buttons on the
top provide access to all the important
tools such as e-mail, slideshow, and
print.

.L e

Tedl us more, and WIN!
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On the left pane there are four tabs—
Browse, Search, Keywords and Info. The
Browse tab displays a folder tree. The
keywords tab reveals a preset list of key-
words that you can add or remove from
images. The Info tab reveals complete
details of the selected images. Similarly,
the Search tab brings up the search
menu, from where you can perform a
search based on a maximum of three
parameters. You can’t mix the parame-
ters, for example, you can’t search for all
images with the keyword ‘Family’ and

k| e i o
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Photo Album has very easy-to-access controls

Remove the Duplicates

Over a period of time, you may have

a lot of duplicate files on your hard disk.
Some of them may be exact copies, while
others may be resized, rotated or cropped
versions of the original. If you have a
large collection of images, finding them

is very hard. Photoshop Album allows
you to search for images based on a
visual comparison, but it won’t find all
duplicate entries.

A nifty utility called Unique Filer lets
you find all the duplicate files in your hard
disk. It performs a pixel level comparison
of the images to find duplicate entries.
Just specify the folders, and it will scan
for duplicate files. Similarly, it can scan
for other documents based on content,
and on other parameters such as filename,
size and contents.

file names starting with ‘h’.
Double-clicking a thumbnail gives
you a larger view of the picture, and
clicking Adjust brings up the adjust wiz-
ard. This helps you adjust the image
step-by-step, previewing the changes
along the way. You can also add various
effects such as adding frames, fisheye,
ripples, etc. Although it has a tool for
creating panoramic images (joining sev-
eral images to get a larger image), we just
could not make one, and ended up with
just a collage of all the images we used.
Printing is another department
where Photo Album excels. Click on
Print to get a huge list of layout options
in the right pane. You can use the Adjust
tab to zoom, rotate or pan an individual
image, or provide a caption for each
image. Overall, Photo Album has a
decent interface, excellent editing and Il
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A menu-less interface drives the
Photo Organizer
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Photoshop Your Album

Let’s take a look at how Photoshop Album eases the task of manag-
ing images.

53i=3) |mporting images

A The first thing you need to do is import images directly from a
camera, a scanner or from your hard drive. To import images, click on
Get Photos in the taskbar, and select the appropriate option from the
drop-down box. You can import images as well as audio and video
files. If you are importing from a camera or scanner, you will have to
provide a destination folder and an image format. If you already have
Adobe PhotoDeleuxe or Activeshare albums, you can import from
them as well. To import these albums, go to File > Get Photos and
choose PhotoDeluxe Album or Activeshare Album. You can also cus-
tomise the arrangement of images into Catalogs. Go to File > Catalog >
New Catalog, to create a new catalogue. Thus, if your computer has
many users, each user can catalogue their images separately.

5122 Tagging images

2 Once you have imported your images, you have to organise
them. Without image management, this is a cumbersome task, as you
can’t have an image in two groups without putting them in both
group folders, thus wasting disk space. With image management soft-
ware, each image can be associated with one or more tags.

To tag images, click on Organize in the taskbar—you will see a list of
tags on the left. The tags also have sub-categories, for example, under
People you will find Family and Friends. To add a tag to an image,
click on an image, select the desired tag and click on Attach in the left
pane. You can also drag and drop a tag onto an image. Do this for
multiple images by selecting the images (using [Ctrl]) and dragging
and dropping the tag, or by selecting Attach.

All tagged images are displayed as an icon on the bottom-right
corner of the image. Hovering the mouse over this icon will show a
tool tip with the tags added to that image. To remove tags, just right-
click on an image and select Remove tag—you will see a list of tags
assigned to that image. Select the ones you want to remove, and click
OK. Two important tags are Favorites and Hidden. When you
assign the Favorites tag, it is given precedence when searching.
Similarly, when an image has the Hidden tag, it does not show up
in the search results. To display hidden images, you have to select
Hidden as well as your desired Search tag, when searching.

5123 Searching
@B There are many ways to perform a search in Photoshop
Album. Above the thumbnails, you will see a ‘Find’ bar. You can

drag a tag to this bar to search for all files matching that tag. Drag-
ging and dropping an image to this bar will search for all images
similar to it. After a search is done, all images are sorted into two
categories, viz, those that match and those that don’t. To perform a
search based on other parameters such as filename, media type, etc,
you have to use the Find menu in the menu bar. From here, you can
also search for images classified as ‘Unknown date or time’ and
those with no associated tags.You can sort images based on fields
such as date, folder location, and so on. The current field being used
is displayed as the button name. Adjacent to that button, you can
find buttons to change the layout of the screen, rotate the current
image, show or hide the properties pane, etc.

1= |mage Editing
7288 Using Photoshop Album, you can edit general errors in
images. Select an image and click Fix in the taskbar. This brings up
the Fix Photo window. On the right, you’ll see different tools—Sin-
gle Click Fix, Crop, Red Eye Removal, Brightness and Contrast, Light-

ing and Color Satura-
ik Mmsas®, tion.

On the top of the win-
dow is a tab called
‘Before & After’; select
that tab to see a com-
parison of the image
after a change is made
to the original file. If
you want to make
some general improve-
ments to the image,
try the Single Click Fix
first. There are four
controls for it—Auto
Color, Auto Levels, Auto Contrast and Sharpen. Just click the button,
and the program will adjust the image correspondingly. After you
make the changes, the system will save the image in the format ‘origi-
nalfilename_edited.filetype’—so ‘digit.jpg’ will be saved as ‘digit_edit-
ed.jpg.’

e T = Cami | e

Photoshop Album offers basic editing fea-
tures to improve on your images

i3 Archiving
5 Photoshop Album provides both backup and archiving fea-
tures. You can restore the program to exactly the way it was, before
taking the backup. This offers protection against any data loss or
other anomalies. To create a backup, go to File > Backup, and choose

printing support, and is a good buy.

Preclick Photo
Organizer 2.0
Preclick Photo Organizer has a pretty big
list of features that it does not offer—it
can’t import images directly from a cam-
era or scanner, and can’t print images.
The only editing you can do is ‘Rotate’,
and you’ll miss other features such as
EXIF support, calendar, greeting card cre-
ation, etc.

To its credit, Photo Organizer has

[EM 94

one of the best interfaces. At the bottom
of the screen is a list of all the thumb-
nails and above it is a bigger view of the
selected image. Below the thumbnails, is
the timeline—if you let the mouse hover
over a line, you get the dates of images
corresponding to that portion of the
timeline. When the thumbnails are sort-
ed according to folder or title, the time-
line gives the name of the folder or title.

On the right is the information pane,
where additional information about
images is displayed. Each image can be

rated, with a maximum of four stars.
Also, each image has an associated cap-
tion, subject, event and place tag. Below
these are the Folder field, Find field, Rat-
ing field and Sort-by field. The Find field
allows you to search for any detail about
the image.

Photo Organizer is strongly recom-
mended if you have a small collection of
images, and need better features than
what your OS offers. Its strength is its
interface and ease of use, but it offers no
additional features. The company also
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between a Full backup or Incremental backup. The former does a
complete backup, while the latter only saves all the data since the last
backup. The data can be written onto a CD directly, or saved as a file.
To restore the information go to File > Restore. Archiving is a feature
whereby you can select images to be archived, and the system writes
the images to CD. A low resolution version of the image will be main-
tained on your hard disk. When you try to use an archived image, you
will be prompted to insert the CD.

)= Creations

6 Using the images in your collection you can create albums,
slideshows, video CDs, greeting cards, e-cards, calendars and photo
books. These are called Creations. Select all the images you want to use,
and click on the button to the right of the Fix button. This will bring up
the Creations wizard that will guide you step-by-step through the
process of building the
desired creation.

There is a creation called
- Adobe Atmosphere 3D
Gallery that can be
mseanegs  accessed through the
wammsay  Creations menu in the
paapaeem® menu bar. It is a unique

method of sharing your
photos online with oth-
ers— your photos are
placed on the walls of a
The 3D gallery is a unique way to share your  virtual gallery building,
images. where users can go

around in 3D space to

view your images. There is even provision to allow multiple visitors to
view the gallery at the same time. Select the images to be shared and
start the Atmosphere 3D gallery. Then, in the pop-up menu that
appears, select the style of the 3D room that you want—a preview of
the room will also be shown. Then enter other details such as the size
of the images and the title of the gallery.

The program will output a set of documents to a folder as in the
menu, and will start the gallery automatically after exporting the files.
But to view the gallery in a browser (only Internet Explorer is support-
ed), you have to download the Adobe Atmosphere player from
www.adobe.com/ products/atmosphere/downloadplayer.html. After
installing the player, open the index.html file in Internet Explorer to
start the 3D gallery. You can upload these documents to the Internet,
and others with the player can view the gallery and can even interact
with each other.

offers a shareware version called Lifetime Organizer.

Ulead Photo Explorer 8.0

A comprehensive package from Ulead, Photo Explorer performed
consistently in all the sections. If not for its conventional inter-
face, it could have made it to the top. Photo Explorer uses the
Windows Explorer-style interface, with thumbnails listed in the
main window, a preview pane below the folder tree and only rel-
evant controls in the toolbar.

If you have a huge set of images, and searching and tagging
is your priority, then keep away from Photo Explorer. You can’t
view the different search parameters together from the search
menu. Not only do you have to shuffle between menus, you get
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Ulead has a conventional Windows Explorer-
style interface

incorrect results due to entries that you
aren’t aware of. It has the worst tagging
feature of all, with no predefined tags,
forcing you to enter tags separately.
What'’s worse, you can only add descrip-
tions to images individually, and can
only rate them as A, B or C.

Apart from these drawbacks, the
software has a good set of features. It
comes with a standalone viewer—Ulead
Instant Viewer, which can be used as the
default viewer. The image editor is also
quite impressive and has utilities such as
histograms, focus changing, lens distor-
tion, and so on. It also lets you preview

Recover Lost Images

When you delete an image from a digital
camera’s memory, it isn’t actually erased.
Like a hard disk, it just deletes the refer-
ence to that image. Thus, using a low-level
access to the camera’s memory, you can
recover lost images. There are utilities that
allow you to recover the images, but since
low level access depends on a lot of things
such as the type of memory used and
make of the camera, the utility may or may
not be successful.

a change before applying the alterations.
The CD catalog feature automatically
asks you if you wish to create a catalogue
of a CD when you insert a CD with
images on it. After you click Yes, the pro-
gram will go through the entire CD and
create a virtual folder. If you select this
folder later, you will be asked to insert the
corresponding CD. However, you can’t
view thumbnails of a virtual folder unless
the corresponding CD is in the drive.

And the winner is.....
Photoshop Album, Picasa and Preclick
Photo Organizer deserve credit for chang-

Tell us more, and WIN!
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Zero Assumption Digital Image Recov-
ery, a freeware, lets you recover images,
in addition to other shareware tools such
as PhotoRescue www.datarescue.com/pho-
torescue/). The latter can even recover
data from memory cards, USB sticks, etc.

We tested these utilities on various
cameras and they worked with cameras
manufactured by Minolta, Nikon, Fuji and
Sony, and not with the ones manufac-
tured by Kodak and Cannon.

ing the conventional interface and bring-
ing in better interfaces, suitable for home
users. But traditional players such as
ACD, Jasc and Ulead have backed their
products with a good set of features.

In the end, Adobe comes out with
the honours because it has the best
combination of features and user-friend-

Adobe
Photoshop Album

T 1 ok e 80 O et e o i ol

liness. Photoshop Album does not offer
conventional features such as an image
viewer, filters, special effects, and so on,
but it lets you to use your images in var-
ious ways. Its excellent interface helped
hammer in the nails in the coffins of the
others.

The other software also show flash-
es of brilliance; Photo Album has excel-
lent printing support. Those who want
to add a lot of effects to images should
choose Photo Explorer. If you don’t want
to spend anything at all, opt for Photo
Organizer. But, if you insist on the best,
then there’s nothing to beat Adobe Pho-
toshop Album... yet.E

MOULY ARUN PRABHU
mouly_arunprabhu@thinkdigit.com
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Maudlin about a number, and veryone has a favourite number, you’ll realise that the deck you’ve not

wish it never fades? Well, Ethat sentimental oldie, which used for years has a dirty head, or needs

here’s how you can sustain brings back sweet memorles dear to re-alignment, or maybe your record play-
you. Unfortunately, getting to play that er has a broken belt. Ouch!

that oldie, and keep those song may involve a lot of effort—rum- Got all that sorted out? Great! Now,
sentiments alive... maging through old cassettes, or flipping the song that you remember so clearly in
through a dusty stack of records, reading your head doesn’t seem that clear to your

. them, label by label. Once that’s done, ear. Dusty old tapes, having to repair your

] :.and you find the song you're looking for, deck, the perpetual hissing sound—all
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this is a bit too much for our ears that are
accustomed to CD-quality audio, and our
click-to-play minds. Abort! Abort!

Plan B?

It seems that the easiest thing to do
would be to just download the
song from the Internet. So, you fire
up your file-sharing applications,
and run a search—without much
success. Next, you query your
favourite search engine, and run
through all the MP3 sites you’ve book-
marked—all in the hope that they may
have your number. By now, you are won-
dering why is this so difficult-after all, it
took just a few minutes to get that
Enrique song the other day.

The problem is that you’re more like-
ly to find yet-to-be released songs by
Madonna, than something Status Quo
sang 15 years back. Defeated and deject-
ed, you now consider (...gasp!) buying the
CD. Seems logical enough, but just like
the Internet, chances are that it will be

Find it on the Mindware CD
Advanced MP3 Catalog Pro

Cool Edit Pro 2.1
J. River Media Center 9

IMAGING: Parag Joshi
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hard to find, with no one stocking it—
and that’s only if somebody actually came
out with the CD in the first place.

Plan C. Do we have a plan C? Is there
really another way? Yes! With a little
effort, you could record your old
favourites onto your own PC at home.
With just a little more than the time it
takes to listen to your tunes once, you can
record them, and have instant access to
them in the future—just like the rest of
your collection.

So, what do | need?

Not much actually. At the bare minimum,
you need a sound card, which you prob-
ably have already. Apart from that, some
software and maybe a CD writer.

You start off by hooking up your cas-
sette deck to your PC, and recording the
music. Next, it is cleaned up, and made to
sound better. Then you organise your
music, and burn it onto CDs.

There are several software tools you

can use to accomplish each task. We’ll
review tools separated into two main cat-
egories—those that record sounds and
clean them up by removing noise, equal-
izing and applying other filters or effects,
and those that you can use to sort your
collection, rename and play back your
files easily.

The process used for your old songs
can also be put to other uses, such as
recording your voice to send it via e-mail,
or to use in presentations. You can even
use the same tools to clean up the audio
in home movies.

SoundForge 6.0
SoundForge is an old favourite that is
widely used to edit wav files on the PC.
The program’s interface is simple and
straightforward—users of earlier versions
will feel right at home, and novices won’t
take long to find their way around.
SoundForge is extremely stable, and
responds to most commands quickly.
Getting the recording to start takes only
a couple of clicks. Pressing the Record but-
ton brings up a Recording window, where
you can set the recording settings, select
how repeated recordings will be saved (in
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one file, or separate files), lay down mark-
ers for easy reference whilst editing,
adjust the offset levels if the left or right
channel is louder, view the recording
time, and, quite thoughtfully, the time for
which you can record before you run out
of disk space. Recording quality is not an
issue either. SoundForge is capable of han-
dling higher bit depths and sample rates
than your sound card can feed it.

Once you're done recording, it’s time
to edit. Here, SoundForge blesses you
with every tool you need—fades, equal-
ization, volume adjustment, normalisa-
tion. Trimming, deleting sections,
inserting silence are all accomplished
easily, thanks to the superb selection
tool, which lets you be as quick, or as
precise as required. However, it lacks
multi-track editing that can come in
handy while making re-mixes, or music
CDs with songs mixing into each other.

Full-fledged noise reduction requires
the Noise Reduction DirectX plug-in from
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Sonic Foundry. You can download it at
http://www.sonicfoundry.com/download/step2.
asp?DID=167.

Cool Edit Pro 2.1

Cool Edit Pro looks way cooler than
Sound Forge; Fortunately, that’s not at the
cost of usability. There are two editing
modes—Multi Track and Edit. Multi Track
is where you can lay down multiple files,
mix them, etc. Edit view is the wave-file
editor where you work with one file at a
time. You can switch quickly between the
modes by pressing [F12].

The Play/Pause, Record and other but-
tons sit at the bottom left, and are quite
convenient to read. Zoom options
include zooming into the selected area,
and the start, or end of the selection.

Recording in Cool Edit is a breeze.
Press the Record button, and a dialog box
comes up, asking you to define audio set-
tings—there are options all the way up to
192 KHz 32-bit Stereo. Click on OK to
start recording. Whist recording, the
timeline cursor scrolls across the screen,
with a real time waveform generated
behind it. Once you’re done with the
recording, move over to editing in the
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same Edit view. Switch to the Effects tab
on the left, from where you can access
most of the required functions. You can
apply lots of cool effects such as pitch
bending, delays and reverbs.

When it came to noise reduction, Cool
Edit Pro performed very well. Most of the
noise was removed without much change
in the original audio. The cleaned up audio
did have a tinny ring to it, but it was quite
acceptable. Moving around is not as intu-
itive as SoundForge, but is never a major
handicap to your productivity. The multi-
track capabilities are a big boon when you
want to mix tracks. Here, you can even use
loops, and make your own songs with your
own voice track.

Audacity 1.1.3

A simpler audio editing tool you will be
hard pressed to find; and a better editing
tool you will not find, at this price. It’s
free! Whilst the interface does not offer
much in the way of eye-candy, it’s very,
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very easy to use. The main interface he.
just the basics by way of buttons—selec-
tion tools, playback and recording con-
trols, zoom and volume controls. The
interface serves as a wave editor, as well as
a multi-track mixer. You can accomplish
basic editing tasks easily with the selec-
tion tool. Some operations, though, take
too many steps—something that other
editors accomplish in a couple of clicks.
You need to get to grips with the way
things happen here—a perfect example is
deleting a section from the wave. In any
other editor, you just select a section and
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The noise removal tool in Audacity details the
steps to remove noise
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What We Used

Advanced MP3
Catalog Pro

Cool Edit Pro Recording and cleaning up
MP3 Gain Volume levelling

ID3 TagIT Renaming and tagging
Nero Write to CD

Make a database of your files

your sound card. The connectors
on your deck or sound card may
have developed carbon deposits,
manifesting into a loud crackling
sound when you twist the plug in
the socket. You can remove this by
using a contact cleaner.

Before you begin, it's a good idea
to ensure you have enough disk

hit [Delete]. In Audacity, you need to
select it, and then go to Edit > Delete, where
you will see that the shortcut key is actu-
ally [Ctrl] + [K]. Most operations, such as
loading files, saving, editing etc. happen
just as speedily as they do in other pro-
grams. But the program was unstable at
times, and crashed while opening more
than one large file. Audacity has a lot of
effects and filters that are labelled simply,
enabling novices to understand them too.

The Noise Removal tool included
precise instructions, telling you to select
a sample and make a profile, then return
to remove the noise. This was really
nice, compared to the other software,
which left us bewildered with the array
of complicated settings that were not of
much assistance.

Let’s record then...

Time to get down to actually recording
your files. There are several tools that we
used; You may use one of the alternatives
we’ve tested here, or any other software
that you’re comfortable with.

The first thing you need to do is get
the music on to the PC. Recording is actu-
ally the most crucial step in this entire
process. If something is not right here, the
problem becomes all the more difficult to
deal with as we proceed further. It is also
the stage where the smallest changes can
have the biggest impact on the eventual
audio quality. So, it’s worth spending a lit-
tle extra time to get it done properly.

For starters, ensure that your cassette
deck is in peak condition—get it serviced,
if necessary. Choose your connecting
cables with care—OFC cables perform
much better than standard wires. Try,
and avoid unnecessary adapters and con-
nectors—the more links there are, the
more the chances of loss in quality. Use
asingle direct cable, and plug it from the
Line Out of your deck to the Line In of
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space for your recording. An hour of
wave-file audio will take approximately
600 MB on your hard disk. Though some
applications support it, recording directly
to MP3 is not advisable, as the audio is
compressed. When further processing is
done on these files, the quality degrades
rapidly. You should also defragment your
hard disk for optimal performance.

Now, open the Windows Volume Con-
trol menu by double-clicking on the speak-
er icon in the Taskbar. Alternatively, you
can go to Start > Programs > Accessories >
Entertainment > Volume Control. From the
menu, select Options > Properties. Ensure that
the correct sound card is listed as the Mixer
Device, and then select the Recording
radio button. Also, ensure that the check-
box for your input source is selected below
(Line In or Microphone), and then click
OK. The window now changes to the
Recording Control Window. Select the
checkbox for the input source you are
using, and set the volume temporarily to
the Maximum.
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Select your source and set your recording
level here

Launch Cool Edit Pro (CEP). If you
have a previous mix, or wave file open,
close it, and make a new file. Play your
tape to check if you can hear it through

Nothing like CD

No matter how much effort you put into
it, your recordings will not match the
sound quality of an original CD that is
mastered in a studio. If you wish to add
your own CDs to your music collection,
or just keep them in MP3 format, you
should use a CD-Ripper to rip them onto
your disk directly. This way, you ensure
the highest possible quality, and it’s likely
to be done several times faster than
recording through your sound card.

Another benefit of ripping from a CD
is that the file name and ID3 tags are
filled in automatically by most ripping
tools. They get this information from
online databases of pre-recorded CDs,
such as CDDB or FreeDB. You can also
add your custom compilations to these
databases for free, so when you carry
your CD to your friend’s place, that PC
will automatically download the track
names.

your PC speakers. This indicates that the
audio is coming through correctly. Next,
double-click the level meters at the bot-
tom of the screen to enable the level pre-
view before recording. If the level reach-
es the end, and the red lights come on,
then the sound is too loud, and is clipped.
Sound that is clipped, is lost. Avoid this by
reducing the volume till it is just short of
reaching the red lights. If no sound comes
through, double-check the Recording
Options, and make sure that the selected
source is the correct one.

Now, rewind your tape to the begin-
ning. Press the recording button in CEP,
and select 44 KHz, 16-bit Stereo quality.
Click OK to start recording, and then
begin playing the tape. It is important to
start the recording early, and not just
before the song starts. That will make the
noise reduction process easier and more
effective. You can record the entire tape
as one wave file, and split them later.
Stop the recording when the tape runs
out and save it as a wave file. Repeat the
procedure for Side B.

After the recording is done, and the
files are saved, clean up the sound and
split it into tracks. In the Edit mode, load
one of the wave files. First, remove the
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excess noise, or the background noise. To
do this, select a few seconds of the record-
ing that has just noise, and no music.
Select the portion that’s just about 3 sec-
onds before the first song, go to Effects >
Noise Reduction > Noise Reduction and click
on ‘Get Profile from Selection’ to scan the
selection, and make a noise profile. Click
Close. Now, deselect the area, and return
to Effects > Noise Reduction > Noise Reduction.
Press Preview to hear the effect of the
noise reduction. If the sound is changed
dramatically, then reduce the level of
noise reduction applied. Conversely, if the
noise is still too much, increase the
amount. If the noise reduction does not
seemn to be very effective, or makes the
track sound very different, refine the
selection used to make the noise profile,
and repeat the process. When you are sat-
isfied with the results, click OK. CEP will
now apply the noise reduction, which
may take quite a while, depending on the
speed of your PC. Normally, noise is most
audible in quiet areas between tracks. A
good idea is to apply less noise reduction
than what is actually required, so that it
just gets removed from the music, and
you can completely remove any audio
from in between songs. Do this by select-
ing the area, and going to Effects > Silence.

You can also apply equalization to the
music to make it sound smoother, or to
give it more punch. Select the area you
want to equalize, and go to Effects > Filters >
Graphic Equalizer. Choose from the numer-
ous preset settings available, or simply go
ahead and make your own changes. The
bars modify lower to higher frequencies
from right to left. The lower frequencies

Frame Accurate Editing

When working for Audio CD output in
Cool Edit Pro, set the timeline to CD
Frames. You can do this by right-clicking
on the timeline, and from the context
menu, select Display Time Format > Com-
pact Disc 75 Fps. Right-click again on the
timeline, and select Snapping > Snap to
frames (Always). This is important since
CDs store 75 frames of audio per second.
If you edit finer than that (in between a
frame), the CD burning software fills the
edited frame with blank data.
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Place the marker before the start of a new
song

represent bass and lower notes. The mid-
range is where you find the vocals.

After you're satisfied with the overall
sound, you can split the long wave into
individual files for each song. Place the
cursor exactly where you want to cut the
file. You can move the cursor in small
increments by pressing the left or right
arrow keys. Increase the zoom to increase
the accuracy. Place this marker just before
the start of a new song and press [F8] to
make a new cue at the cursor. Do this for
all the songs, and then place one marker
at the start of the first song, and another
at the end of the last song.

Go to View > Show Cue List. Select the
first item, and press [Shift] + [End] to
select all the cue items. Now, press Merge
to convert the individual Cues to Cue

Merging in the Cue List

Ranges. Notice the Begin and End times
for each individual track. Click on Batch,
and select the ‘Save to Files’ radio button
from the window that comes up. Enter a
filename prefix, and browse to the folder
where you wish to save the files. Set the
output format as MP3, and click Options
to set the quality manually. Once you're
done, click OK, and then OK again to
begin outputting your files. You will now
find a separate MP3 file for each track,

.
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Use MP3 Gain to make all your songs the
same volume

which you can use to make a CD.

Normally, songs from different artists
tend to be at different volume levels. So,
listening to them, one after another, will
involve a lot of jumping for the volume
knob. The Normalisation feature does not
take care of this effectively; it simply
makes the highest level in the track equal
the maximum volume possible. But some
songs still sound louder than others. A
simple program called MP3 Gain provides
the solution to this. It sets the audio level,
based on how loud the human ear would
perceive the sound signals to be. The
results are quite impressive.

Click Add Folder on MP3 Gain’s main
button bar. Browse to the folder of your
choice, and click OK. Now, click ‘track
analysis’—MP3 Gain will analyse each
track, and may take quite a while to com-
plete if you set many tracks to analyse.
Next, set the target normal value in the
text box—the default value of 89 makes
the songs seem too soft. Enter 92, and
then click ‘Track Gain’ to process all the
tracks to that volume.

Now, rename and organize your
media. This not only applies to the tunes
you've just recorded, but also to the other
few gigabytes of music hiding all over
your hard drive.

We’ve tested three tools that aim to
get your music collection into shape.

J. River Media Center 9

Media Center 9 aims to be your one-stop
media shop, and does make a good effort
too. The program is vast in its capabilities
and options. It not only handles a large
number of music formats, but also does
stills and video files. It takes several
shapes—from the normal full-size window,
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to a smaller player component called ‘mini-
me’. There is also a full-screen mode, and a
Party mode when your PC turns into a DJ.
The first time the program runs, it
brings up a dialog box to search for media
on your hard disk. The search is compre-
hensive—it finds all the media types you
specify—not just MP3s, but images and
videos too. It’s best to stick to MP3, and
any other format you store your music in.
Avoid searching for JPEG and other media
files, or you will end up with thousands of
tiny files from all over your hard disk.
Media Center 9 flexes its organizing
muscle in the form of Smart Lists. These
are automatically generated play lists,
based on certain criteria. For example, you
could ask to hear some of your favourites
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The smart single-click rating system

that you haven’t heard recently. It knows
which songs are your favourites because
you can assign ratings to each song. |
know what your thinking—how am | ever
going to rate thousands of songs? All you
have to do is click the number of stars you
want to assign to the song in the media
list. So, it’s just one click per song, and
you can do this while listening to music.
Doing a few at a time will get your col-
lection in shape pretty quick. The ratings,
combined with the Smart Lists, will real-
ly make your listening more enjoyable.

Using its listing capabilities, you can
see all the files of a particular artiste
placed together. You can even move all
the files into one folder on your disk. This
comes handy when you want to use
another program to manage your tunes,
or burn CDs.

Media Center 9 also has a built-in
CD-Burning and CD-Ripping. By default,
songs are ripped into the Ogg Vorbis
format. If you want to rip directly
into MP3, you need an additional
component. This can be downloaded at
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http://www.musicex.com/cgi-bin/down-
loads/mcplugins.pl. In Options, you will
also find that you can automatically per-
form normalisation whilst ripping tracks
from the CD.

While Media Center is the most fea-
ture-rich software here, the wealth of
features detracts from its usability, and
makes finding some options and tasks
difficult.

Zortam MP3 Media Studio
The first thing you notice about Zortam
Media Studio is its speedy installation—a
few clicks, and a fewer seconds later, it’s
done. However, things slow down con-
siderably, once you start working with it.
The first time we ran it, we were greeted
with multiple windows on top of each
other. Each one obviously had a different
function, and was titled accordingly, but
we didn’t know where to begin.

The place to begin is the ‘Search Media’
button in the top left of the main interface.
This enables you to search your drives for
music files. The search took a fair amount
of time, and found all the MP3s on our
PC—even the ones on the CD that was in
the drive at the time. The files found are
displayed in a huge table that has fields for
Artiste, Title, and the other typical ID3 Tag
fields. This tool’s core competency is the
powerful renaming and tagging available.
The bottom third of the screen is a dedi-
cated renaming zone. When you select a
song in the main list, the file’s ID3 version2
(ID3v2) information is displayed on the
left, and ID3 versionl (ID3v1) information
is displayed on the right. You can click on
any field, and edit it there itself. You can
copy tags between ID3v1 and ID3v2. There
is also a synchronisation option that works
effectively most of the time.

The database maintains all the requi-
site information: Artiste, track name, etc.,
and can be exported to an HTML or text
file. Zortam also allows ripping a CD to
various qualities of MP3, and Wave for-
mat. It also does conversions between
Wave and MP3.

Advanced MP3 Catalog
Pro

This is a no-frills tool, designed simply
for cataloguing. It is, by far, the simplest
looking tabbed interface tool reviewed

Sound Beginning and
Perfect Ending

Sometimes, when recording off an old
tape that your friend had recorded in his
sleep a long time back, you will find that a
song may begin half way or be cut off at
the end. Whilst regenerating the begin-
ning or end is not possible, you can clever-
ly cover it up, and make it sound less dis-
turbing. The simplest thing we could do is
fade in, or out. Depending upon whether
you wish to fade in, or fade out, select the
first, or last, few seconds of a song. Go to
Effects > Amplitude > Amplify. Click on the
fade tab.

Set the initial amplification to the mini-
mum value to fade in. To fade out, set the
Final Amplification to the minimum.

If you’re feeling a bit more adventurous,
and don’t mind spending some time
experimenting, CEP can do some neat
stuff. Try the Pitch Bender (Effects >
Time/Pitch) with the Preset ‘Turntable loos-
ing power’ for a cool ending.

here. The first tab is the Catalog where
you can see your entire collection sorted
into Volumes—based on the location of
your songs—much like separate drives in
windows. The left pane displays these
and their subfolders, in a Windows
Explorer-like tree.

You can click the New icon to make a
new catalogue. As soon as you do so, you
will be prompted to scan your PC for MP3
files, or to add a new volume manually.
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Add each of your CDs as a volume

The first time you run the program, you
should complete a full scan. Once the
scan is complete, you can rename the
volumes created for your convenience.
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added individually as a volume, and can
be renamed as you have named the CDs.
Once added, the Advanced MP3 Catalog
Pro stores the track details in the data-
base. Just find the song that you wish to
play in the database, and select Play. You
will be told which CD to insert, and your
song will play automatically in your
default player.

The Groups tab lets you browse your
collection by album name, year, artiste,
etc. The built-in searching, and duplicate
finding are also very powerful. Other fea-
tures worth mentioning are a label print-
er that prints jewel case inserts of your
MP3 discs, the ability to export lists in var-
ious formats and simple ID3 tag editing.

Advanced MP3 Catalog Pro does a
great job of keeping your collection
organised, especially if it’s largely on a
CD. It lacks in features as compared to
others, but serves the purpose best, and
that, with minimal effort.

Now, tag and stack it

For some things though, you just need a
dedicated tool. A good example is tagging
that refers to entering the relevant infor-
mation into the ID3 Tags. These tags are
the most popular way of maintaining the
track’s information, with most portable
devices being capable of reading and dis-
playing them during playback.

Use a free tool, called ID3 TagIT found
at http://www.id3-tagit.de/english/down-
load.htm to rename and tag MP3s. As you
launch the program, a simple Explorer-
style window greets you, with a directory
tree in the left window. Browse to the
folder that has the files you wish to edit,
and click on it. All the MP3 files in the
folder are read and their tag information
is displayed. This may take a while, if
there are many files. Ensure that you are
currently viewing the ID3 tag version2 as
shown on the toolbar’s top-right corner.
The right pane displays a table, with the
tracks and their tag’s details listed. To edit
the tag information of a single song, sim-
ply double-click on the song name. If you
wish to edit a particular field of multiple
songs simultaneously, select the tracks,
and then click on ‘Multiple Edit ID3 v2’
on the toolbar, or press [Ctrl] + [N]. Type
in the details in the field to be replaced,
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for example, the artiste’s name. Keep in
mind that the same data will be written to
all the files selected. You can also change
the case of your Tags.

Once you’re done, you can copy the
ID3v2 tags to the ID3v1 tags for back-
ward compatibility. Click the Trans-
fer/Convert icon, or press [F4], to bring
up the window. Here, select Transfer
ID3v2 to ID3v1, and select all the fields.

Tell us more, and WIN!
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You must also copy the tag information
to the filename, so that your files can be
easily managed in Windows Explorer.
Close the program, and click on Yes to
save the changes.

Ideally, you should have all your
music in one folder. Within that folder,
there could be subfolders for artistes, with
further sub-division into albums. If you
listen to a lot of music away from your
PC, JRiver’s Media Center can burn your

favourite tunes onto CDs, using smart
lists. If you don’t need this capability,
Advanced MP3 Catalog will suffice to sim-
ply organise your collection.

For those with disk space, it’s ideal to
have all your songs on your PC itself, so
that they are instantly accessible. If you
can enjoy this luxury, all you have to do
is scan your PC with Advanced MP3 Cat-
alog Pro. Start the program, and click on
the New icon. You will be prompted to
scan your PC. Complete the scan, and
you’re done. Those with too many MP3s,
or too little room on their hard disks,
need to write their MP3s onto CD. Use
your CD writing software to do this. Once
you have your CDs done, you can add
them in as volumes into Advanced MP3
Catalog. To do this, click the Add Volume
icon, or press [Insert] on the keyboard.
Select your CD drive from the browse
window that comes up. Pay attention to
naming the volumes, and your CDs cor-
rectly. When you run a search for a par-
ticular track, and that track is on a CD,
you will be asked for that CD by the Vol-
ume name. So, if the names aren’t the
same, things will get confusing.

Have you ever copied tracks off a CD,
only to end up with two copies of one, or
more numbers? If this is a regular
occurence with you, the problem is like-
ly to be compounded. You can search for
duplicates using Advanced MP3 Catalog.
Switch to the Duplicates tab, and select
the basis for comparison of files to deter-
mine if they are duplicates. If your col-
lection is large, it’s recommended that
you search one criterion at a time. Start
with File Size, as it's the best way to
determine exact duplicates. Click Start to
begin searching. You will be presented
with a list of possible duplicates. Com-
pare the files visually by their file name
and select one of each. Use [Ctrl] to
select multiple files. Once you’re done,
review your selection, and press [Ctrl] +
[Delete] to remove them.

So there it is, and easier than you
thought! With just a little know-how, and
your good old PC, you can resurrect your
musical past, and blend it into your
organised musical future. Sounds good,
doesn’t it? [

KAIZAD VAJIFDAR
kaizad_vajifdar@thinkdigit.com
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Products that topped
our performance tests

CPU

——Pentium 4 3.2 GHz

800 MHz FSB

+ Supports 800 MHz FSB and

Hyperthreading

- Very expensive

Contact: Nebula Technologies

Phone: 022-26730567

E-mail: pratik@nebulatech.com
Price: Rs 38,000

Motherboard

Intel 875 PBZ

+ Native support for SATA

- No possibility of over-clocking
Contact: Nebula Technologies
Phone: 022-26848612

E-mail: pratik@nebulatechnologies.
com

Price: Rs 13,000

Primary Storage
Maxtor 250 GB MaxLine
Plus Il

+ Tons of space

- Gets heated

Contact: Cyberstar

Phone: 011-6438216

E-mail: yogi@maxtor.com

Price: Rs 21,000

The A-List

A list of the best products in different
hardware and software categories

— Secondary Storage

Sony CRX 300A

+ Top performance, 'Lﬂ'
vertical mountable,

half height, Mt. Rainer support
- No CD-R/CD-RW media
Contact: Rashi Peripherals
Phone: 022-28260258

E-mail: ho@rptechindia.com
Price: Rs 6,250

— Graphics Card

—Display

LCD Monitor

SONY SDM-N80 18.1-inch
+ Stylish looks combined with great
performance

- External power supply takes up
extra space

Contact: Rashi Peripherals

Phone: 022-28260258

E-mail: ho@rptechindia.com

Price: Rs 1,49,000

— Input Devices
Microsoft Multimedia
Keyboard
+ Great feel
- Comes at a high price
Contact: Microsoft Corporation
Pvt Ltd
Phone: 011-26292640
E-mail: connect@microsoft.com
Price: Rs 1,600

Microsoft Wireless
Optical Desktop

+ High precision and sensitivity
- Batteries make it heavy
Contact: Microsoft Corporation
Phone: 011-26292640

E-mail: connect@microsoft.com

Gainward FX 5800

Price: Rs 4,500

+ Future-proof

- Gets very hot

Contact: Mediatech India Pvt Ltd
Phone: 022-56396696

E-mail: sales@mediatechindia.com
Price: Rs 37,975

— Sound Card

Creative SoundBlaster
Audigy 2 Platinum

+ 6.1-channel output

- Expensive

Contact: Creative Technology Ltd
Phone: 9820357713

E-mail: rajshekhar_bhatt@ctl.
creative.com

Price: Rs 15,199

e

—Speaker

Creative Megaworks

THX 5.1 550

+ Mindblowing sound

- No digital inputs

Contact: Creative Technology Ltd
Phone: 9820357713

E-mail: rajshekhar_bhatt@
ctl.creative.com

Price: Rs 25,999

=
=
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Laptop

Dell Latitude D600

+ Good design, has dual band
2.4 GHz and 5 GHz wireless

- Temperature shoots up after
prolonged use

Contact: Dell Computers Asia
Pvt Ltd

Phone: 1600 33 8044 (Toll free)
E-mail: marketing_response@
dell.com

Price: Rs 1,53,366

Laser Printer
Samsung ML-1710

+ Extremely fast

- Does not support USB 2.0
Contact: Samsung Electronics
India information and
Telecommunication Ltd
Phone: 011-51511234
E-mail: farrukh@
samsungindia.com

Price: Rs 16,000

Inkjet Printer

Canon S530D

+ Supports direct printing from
digital cameras

- Expensive

Contact: Canon India Ltd
Phone: 011-26806572

E-mail: rajeev.singh@
canon.co.in

Price: Rs 21,747

Scanner

HP Scanjet 4570C

+ Excellent scan quality

- Heavy and bulky

Contact: HP India Ltd
Phone: 011-28260000
E-mail: ashwini-k_aggarwal@
hp.com

Price: Rs 17,999

PDA

Sony CLIE PEG-TG50

+ Runs on Palm OS5 and
has a 320 x 320 TFT LCD
display

- Rapid battery consumption
Contact: Solar Systems
Phone: 022-56916834
E-mail: solarsystems@vsnl.net
Price: Rs 27,000

Mobile Phone

Sony Ericsson P800

+ Easy and intutive navigation

- Blocky design makes it bulky

Contact: Sony Ericsson Mobile

Communications International

Phone: 011-26180808

E-mail: sudhin.mathur@

sonyericsson.com

Price: Rs 35,500 _‘d
L

Digital Camera

Canon IXUS 400

+ Cerabrite body, better

buttons layout, wide shutter

speed range

- Ultra compact body hampers

handling

Contact: Canon India Pvt Ltd

Phone: 011-2680 6572

E-mail: Shyam@canon.co.in

Price: Rs 49,995
L uN

L

MP3 Player
Creative LX 100

+ Decent feature set,
easy to install, large LCD
- No bundled software,
no ID3 tag support
Contact: Creative Labs Asia
Phone: 9820357713
E-mail: rajshekhar_bhatt@
ctl.creative.com

Price: Rs 9,799
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Products that are
the best value buy

CPU

AMD XP 1800+

+ sufficient power for normal
desktop use

- Difficult to install the heat sink
Contact: AMD Far East India Ltd
Phone: 011-26238620

E-mail: amd@surfgold.com

— Motherboard

ASUS A7S266

+ Support DDR and SD, onboard
video, onboard sound, onboard
graphics, USB 2.0

- Not appropriate for gamers
Contact: Neoteric Infomatique
Phone: 022-24172600

E-mail: sales@neoteric-info.com
Price: Rs 3,900

— Primary Storage

Samsung SV1203N 120 GB
+ Noise Guard and ImpacGuard

- 5400 rpm drive

Contact: Samsung Electronics
India Information
Telecommunication India Pvt. Ltd
Phone: 011-6322517

E-mail: marketing@samsungindia.
com

Price: Rs 7,200

Secondary Storage

Beng CRW5224W _‘d
+ Cheap ve

- Data cable not bundled
Contact: BenQ India Pvt Ltd
Phone: 022-25705231

E-mail: salesenquiryin@beng.com
Price: Rs 2,800

Input Devices

Samsung PC Keyboard

+ Unmatched value for money

- No multimedia buttons, wrist
support not bundled

Contact: Samsung Asia Pvt Ltd
Phone: 022-2281/ 4886

E-mail: marketing@samsungindia.
com

Price: Rs 300

— Logitech scroll mouse
+ Ambidexterous design
Contact: Rashi Peripherals
Phone: 022-28260258/ 59
E-mail: ho@rptechindia.com
Price: Rs 550

Phone: 011-26826000
E-mail: ashwini-k_aggarwal@
hp.com

Price: Rs 550

Scanner

—Graphics Card

SMEDIA GeForce4 MX 440
+ 64 MB Video RAM, AGP 4X, 270
MHz clock speed

- No hardware support for DirectX9
Contact: Xserve India

Phone: 080-5202915

E-mail: vivek_gupta@xserves.com
Price: Rs 3,000

— Speaker

Adcom ACSPSW-660 2.1

+ 2 satellite speakers and one mini
sub-woofer, performance in the
gaming sector was quite good

- Volume cannot be set to maxi-
mum

Contact: SABS

Phone: 022-23808564

E-mail: sabs@vsnl.net

Price: Rs 550

Display
CRT
LG StudioWorks 700S
+ High resolutions,
great performance, anti-static,
anti-glare, anti-reflection surface
treatment
- No extra accessories
Contact: LG Electronics India
Pvt Ltd
Phone: 0120-2560900
E-mail: response@Igezbuy.com
Price: Rs 9,400

Digital Camera
Kodak DX6340

+ 3.1 megapixel camera with 4X
optical zoom

- only 16 MB memory provided
Contact: Neoteric Infomatique
Phone: 022-24172600

E-mail: rajeev@neoteric-info.com
Price: Rs 20,900

Laptop

ACI Emerald PIV

+ Integrated Web Camera,
FireWire port and an Ethernet
connection, can play games such
as Quake Il

- Bulky, no manual

Contact: Allied Computer
International (Asia) Pvt Ltd
Phone: 022-26366800

E-mail: sales@aci-asia.com
Price: Rs 89,990

Laser Printer
Wipro Laser 1540

+ Maximum resolution of
1200 dpi, 2 MB buffer, USB
and parallel port

Contact: Wipro Peripherals
Phone: 022- 26397418
E-mail: helpdesk.mumbai@
wepindia.com

Price: Rs 10,750

Inkjet Printer

HP 3325

+ Very small form factor

- 765 KB of buffer memory
Contact: HP India Ltd

HP 2300

+ Low warm-up time
Contact: HP India Ltd

Phone: 011-26826000
E-mail: ashwini-k_aggarwal@
hp.com

Price: Rs 3,499

PDA

Palm Zire

+ Affordable, good battery life,
comprehensive PIM applications
- No Palm Universal Connector,
no backlight, no expansion slots
Contact: Tech Pacific Technology
(India) Limited

Phone: 022-55960101

E-mail: aparna@corvoshandwick.
co.in

Price: Rs 7,000

Mobile Phone

Sony Ericsson T200

+ Light-weight, perfect grip,
WAP 1.2.1 browser and

43.2 Kpbs GPRS, PIM features
- Keys are hard and noisy,
unusual socket for the charger
Contact: Sony Ericsson Mobile
Communications International
Phone: 011-26180808

E-mail: sudhin.mathur@
sonyericsson.com

Price: Rs 6,495

MP3 Player
Creative MuVo
64 MB iﬂ
+ Good audio quality, Ty
user-friendly, long battery life

- No LCD, no voice recording,
no FM tuner, no playlist or
folder support

Contact: Creative Labs Asia
Phone: 9820357713

E-mail: rajshekhar_bhatt@
ctl.creative.com

Price: Rs 5,999
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Fujitsu Stylistic ST4110 Tablet PC

A tablet for your office worries

he Stylistic ST4110 is a
I true tablet, unlike the
notebook convertibles
we tested earlier. One of the
lightest tablets around, the
ST4110 weighs a little less
than 1.5 Kgs, and
measures 301.3 x
220 x 20.9 mm—just
about the size of an
A4 sheet. The suede
backing at the rear
ensures it does not
slip from your hands
while you’re moving
around.

Input is as simple
as writing on paper,
with the full-sized J
stylus. However, all .
ports, apart from the external
monitor port, are exposed,
which can be bad because of
dust and humidity.

The optional docking sta-
tion includes a CD-RW and
DVD combo drive. It also
adds additional USB ports as
well as network, monitor and
Firewire ports.

On the performance
front: the ST4110 can handle
all standard office applica-
tions. Handwriting recogni-
tion is fairly accurate. The

Price: Rs 1,95,000 for the Fujitsu
Stylistic 4110 Tablet PC;

Rs 2,55,000 for the Fujitsu Stylistic
4110 Tablet PC, USB FDD,
Wireless Mouse, Tablet Dock with
Combo Drive, Wireless Keyboard,
Stylus Pen, Screen Protector
Contact: ACI Infocom Ltd

Phone: 022-2826603/ 32

Fax: 022-28250674

E-mail: desmond@aciinfo.com
Web site: www.fujitsu.com
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MobileMark 2002 battery test
logged a battery life of a
whopping 4 hours and 12
minutes. However, both
MobileMark 2002 Perfor-
mance Test and Quake IlI
Arena simply refused
to run on the device.
Also, it does get warm
with extended use,
but the suede cover-
ing at the rear makes
life easier.

The Fujitsu
ST4110 promises to
be a workhorse for
. the true mobile pro-
fessional, however, at
Rs 1.95 lakhs for just the
tablet, it does not compare
very well with the Acer Trav-
elMate C100, which is about
Rs 40,000 cheaper.

SPECIFICATIONS

800 MHz ultra low voltage
mobile Intel Pentium IlI
processor, 256 MB SDRAM,
10.4-inch LCD display,

40 GB hard drive, Intel 830M
integrated graphics, SigmaTel
STAC9767 audio, two USB
ports, Ethernet (RI-45), modem
(RI-11), IEEE 1394 (Firewire),
Infrared, 802.11b Wi-Fi
compliant module, six launch
keys, scroll keys, built-in
microphone and speakers,
Type I/l PCMCIA slot

=

We test the latest and the best hardware and software products available in the market

ACI Centrino Notebook

Long lasting performance

he ACi Centrino is

I powered by an Intel 1.5
GHz silicon square
complimented by 512 MB of
DDR SDRAM, and provides
enough juice for your heavy
applications. A 15 inch TFT
display  pro-

vides a bril- =T
liant, sharp dis- .

play which is = B
hooked inter- | f

nally to an ATI
Radeon 9000
Mobility graph-
ics card. The lap-
top offers better per-
formance in the graph-
ics department as compared
to other laptops that make do
with a SiS integrated display.
In the graphics benchmark
using Quake Il Arena, the
mobility Radeon delivered
107 frames in normal mode,
but the frame rate dropped to
73.3 frames at 1024 x 768 x 32
bits.

Where other laptops are
bundled with lower rpm
drives, this laptop, with a
5400 rpm, delivers a decent
work-around in the perform-
ance department. This note-
book offers seemingly unlim-
ited options when it comes to
networking, and the two net-
work icons in the system tray
are just proof of the forward

Fujitsu Stylistic G
ST4110 PC

Performance EEEME
Features EEEER
Value for money » k k k
Build quality EEEER

Price: Rs 1,15,000 (approx.)
Contact: Allied Computer
International (Asia) Pvt Ltd
Phone: 022-56943260

Fax: 080-5586107

E-mail: sales@aci-asia.com
Web site: www.aci-asia.com

thinking that ACi has put into
making this laptop—it offers
you both wired and wireless
LAN capability. When we
tested the wireless LAN, the
connection was up and run-
ning in just a few seconds.
However, the connection
kept dropping even in a
good test environment.
The battery life, when
tested with reader work-
load —where the sys-
tem is not

stressed—
came to
four and half

hours, which is nearly 2
hours more than a regular lap-
top. The claimed figure, how-
ever, is seven hours, which
might be possible to get if you
lower the brightness; but this
strains the eyes.

Overall, priced at Rs
1,15,000, it offers features
which more than justify the
price, and is a good buy if you
want a performance-rich lap-
top with Centrino technolo-
gy as the icing on the cake.

SPECIFICATIONS

1.5 GHz Pentium M processor,
512 MB DDR memory, 15-inch
TFT LCD, ATI Radeon 9000
mobility graphics card,

5400 rpm hard disk and built-in
wireless connectivity

ACi Centrino Notebook @

Performance EEEE
Features L
Value for money k k k
Build Quality EEE
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Hercules 3D Prophet 9600 PRO

Kid pro revs up the heat

ercules, with its reputa-
tion for top quality video
cards, got everything right for
the 9600 PRO. Installation
was fairly simple, and the first
thing that caught our atten-
tion when the test machine
was booted up, was the card’s
fan. There’s

a small neon-blue

LED under the fan
which makes it look like a
futuristic gizmo.

The 9600 is based on the
RV350 chipset, which is a
derivative of the R350 chipset
used in the 9800 PRO, and is
the first ATl card manufac-
tured using the 0.13 micron
fabrication process. The
RV350 features four DX9
pixel pipelines and two ver-
tex shaders, which is exactly
half of the R350 used in 9800
PRO. The two variants of this
core are the 9600 and the
9600 PRO, running at
325/400 (200 MHz DDR) and
400/600 (300 MHz DDR)
respectively. ATI therefore
expects that the performance
to price ratio of the 9600
would make it agreeable to
consumers.

Our test bed comprised a
Pentium 4 3.2 GHz, Intel
D875PBZ motherboard (Can-
terwood), 512 MB DDR333
RAM, 120 GB Seagate SATA
hard drive, Creative Audigy 2
and the Hercules 3D Prophet

Price: Rs 16,875

Contact: Mediatech India

Phone: 022-56396696

Fax: 022-222014083

E-mail: info@mediatechindia.com
Web site: www.hercules.com
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9600 PRO. The drivers for the
card were the latest Catalyst
3.5 drivers. Installation of the
drivers went well without any
hitches, and the system was
up and running without
crashes.

In the tests, the 9600 PRO
packed a mean punch. It gave
a comfortable 107.2 fps with

Serious Sam SE at 1024 x 768
X 32. Quake IIl Arena was no
different, with 216.2 fps at
1024 x 768 x 32. The most
surprising results were in
3DMark2003 tests: this card
gave us a whopping score of
3465 with all the eye-candy
turned on!

The 9600 PRO is Direc-
tX 9 and OpenGL 2.0 com-
pliant. Fill rate is at a massive
1.6 billion texels per sec with
a memory bandwidth of 9.6
GBps—this translates into
comfortable, playable frame-
rates at high resolutions with
DirectX 9.0 and OpenGL 2.0
games. You also get dual
monitor support and an S-
Video out with this card for
those multi-monitor sessions.
It’s very important to note
that the card will not fit into
AGP slots in older mother-
boards, because it has only a
single notch for 1.5 volts.

This card is priced at
Rs 16,875, which is much
lesser than what the 9800
PRO costs, and with the fea-
tures this card provides, it is
one great buy!

SPECIFICATIONS

256-bit architecture, 400 MHz
clock, 0.13 micron fabrication,
AGP 8x , 128-bit 600 MHz
DDR, 128 MB video RAM, 400
MHz RAMDAC, maximum reso-
lution of 2048 x 1536 at 85 Hz

Hercules 3D Prophet e

9600 PRO

Performance EEEER
Features EEEER
Value formoney k k k k k
Build Quality k kB k kb &
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Epson Stylus CX 5100

Asus V9180/TD

A premium multi-functional device

Multi-functional devices
seems to be the mantra
of recent times—the Epson
Stylus CX 5100 can scan, print
and copy documents in colour
and monochrome. It is target-
ed at the SoHo (Small Office
Home Office) segment, and is
not meant for heavy-duty
print or copy jobs.

The CX 5100 sports ele-
gant looks and a fairly small
footprint. There is a small
LCD display for selecting

paper, print
— == o
._‘:.\—\_\_‘_ i -

quality, number of copies and
SO on, using a neat and easy
to use set of buttons on the
front face.

The CX 5100 has individ-
ually changeable ink car-
tridges. It supports a maxi-
mum printing resolution of
5760 dpi (interpolated) and
claims a maximum printing
speed of 22 ppm in economy
mode. The paper capacity
is 150 sheets and it is top-
loading.

The flat-bed scanner has
an optical resolution of 1200
X 2400 at a colour depth of 48
bits. It comes with a transport
lock that prevents the scanner
lamp from moving while
transportation. Setting up the
device was an easy job as it
comes with a USB interface.
Windows XP detected the
printer instantly, and
installed the drivers without

Price: Rs 22,500

Contact: EPSON India Pvt Ltd
Phone: 080-5321266/70

Fax: 080-5321065/5581799
E-mail: sales@eid.epson.co.in
Web site: www.epson.co.in
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any trouble.

The device took around
17 seconds and 27 seconds
respectively to print a full
sized monochrome text doc-
ument in normal mode and
best quality mode, which is
quite impressive. But we were
disappointed by the print
quality—there was some
smudging which continued
even after a number of prints.
In the photo printing capa-
bility test, the colour repro-
duction was not accurate and
the overall contrast was poor,
even on photo paper. It sim-
ply failed to impress.

But to our surprise, the
scanner made for lost
ground by producing some
stunning scans that were
brilliant in every aspect. The

only negative thing we noted
was a little drop in the bright-
ness level. Its document scan-
ning was also satisfactory, and
it passed the OCR test with
reasonable accuracy. Docu-
ment copying is very simple:
place the document to be
copied on the scanner bed,
and select Colour or B&W
using a button on the top.
The copies were of acceptable
quality; the settings, howev-
er, were non-changeable.

At Rs 22,500, the CX 5100
a premium product as far

as pricing is concerned.
And overall, the CX 5100
has excellent scanning

capabilities  and below
average print quality.

SPECIFICATIONS

Maximum resolution: 5760 x
1440 dpi, A4 flat bed scanner,
maximum optical resolution:
1200 x 2400 dpi, 150 Paper
capacity and USB interface

Epson Stylus CX 5100 @

Performance EEEEER
Features EEREER
Value for money k k & k k
Build quality EEEER

GeForce4 for the masses

sus has a reputation for

building some of the
most feature-packed and
robust nVidia chipset cards.
Enter the V9180/TD. The
chip is meant for those
who want the GeForced
tag at an affordable price.
This card is based on the
GeForce4 MX440 chipset
with one addition—it
features the new AGP 8X
standard. The Video RAM
is 128 MB—enough for
you to play your games
without framing. As
usual, the extras provided  +
by Asus include a pack
of games.

Instead of running at 270
MHz (GPU) and 400 MHz
DDR like its predecessor, these
cards are set to 275 and MHz.
This gets that extra oomph
into your gaming.

The card does not feature
either a pixel or a vertex shad-
er, so you won’t be able to
play upcoming games with
the eye-candy enabled. But

Price: Rs 7,200

Contact: Asus India

Phone: 022-56926013

E-mail: info_india@asus.com.tw
Web site: www.asus.com

The frame rates in Quake Il
were good; so was the

Direct3D performance.
This card does well what
it was meant

for, but as for the price, it is
slightly expensive consider-
ing the specifications; newer
cards based on the FX5200
chipset retail for nearly the
same price.

SPECIFICATIONS

256-bit architecture, 275 MHz
clock, 0.15 micron fabrication,
AGP 8x , 128-bit 500 MHz
DDR 128 MB video RAM, 400
MHz RAMDAC, max resolution
of 2048 X 1536 @ 85 Hz.

Asus V9180/TD

Performance E ok
Features EE
Value for money k k
Build Quality EE
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Logitech Momo Force Feedback

Wheel

Must-have accessory for the hardcore gamer

he ‘Momo’ on the Log-

itech Force Feedback
Wheel comes from the fact
that it is designed by profes-
sionals from Momo, who spe-
cialise in building gear knobs,
steering wheels and such, for
F1 racing cars.

The rubber-clad wheel
offers excellent
grip and smooth,
jerk free move-
ment. It sports
a maximum
rotation angle
of 240 degrees.
The centre of

the wheel has six program-
mable buttons. It also has two
paddle shifters behind it, and
the gear knob is at a fairly
reachable position. Both the
paddles

and
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the gear knob are program-
mable and offer good audible
and tactile feel. You throttle
using the floor pedals which
are placed on a heavy plastic
base, with anti-skid rubber
cladding on the underside for a
firm grip. The clamping mech-
anism of the wheel is also solid
with no lateral movement—no
matter how hard you thrash it.
The force feedback is good
enough to experience every
bump and thump in the game.
The wheel did well when it was
tested for precision when
negotiating hair pin curves.

Price: Rs 8,975

Contact: Rashi Peripherals
Phone: 022-28260258

Fax: 022-56916609

E-mail: ho@rptechindia.com
Web site: www.logitech.com

The price tag of Rs 8,975
is justified for a highly fea-
tured and performance-
packed device such as this,
though the force feedback
could have been a little more
effective. This device is sure to
give you the ultimate experi-
ence as far as racing games are
concerned.

SPECIFICATIONS

240 degree rotation angle, six
programmable buttons, two
paddle shifters, gear knob,
floor board

Logitech MOMO Force @

Feedback Wheel

Performance EEEEER
Features EEREER
Value formoney k k k k k
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Odyssey 5113RF Keyboard

Great concept; poor design

he Odyssey 5113RF is
an RF-based cordless
multimedia keyboard, with a
lot of multimedia keys
thrown all over the place, and
also a track ball embedded
in the key-

oy board.

The key-

board has a black body with
dark-grey keys.

The location of the track
ball is odd, with the ball in
the upper right hand corner,
and the left and right mouse
keys in the left hand
corner. Not only is this
ergonomically unsuitable, it
is also inconvenient to work
with. The 15 multimedia keys

Price: Rs 3,055

Contact: Compuage India Ltd
Phone: 022-23842200

Fax: 022-23842210

E-mail: info@compuageindia.com

Web site: www.compuageindia.com
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are handy, and can be
programmed to do a
particular task.

Typing requires some
time to get used to, but once
you’re done, it’s smooth sail-
ing. The biggest disap-
pointment is the mouse—
it’s slow and difficult to
track.

The keyboard has a
good range and works
perfectly fine within a range
of 2m, and nearly perfect at
all angles.

Priced at Rs 3,055, the
5113RF is expensive when
you consider the mouse and
the key layout.

SPECIFICATIONS

2m (6.4 ft) and +45° (hori-
zontal) and + 60° (vertical)
operating range, receiver with
2 PS2 connectors, 15 multi-
media keys, inbuilt mouse,
battery-low LED indicator

Odyssey 5113RF e
Keyboard

Performance EEEEER
Features B EEER
Value for money b k k k k
Ergonomics EEEERK

HPV AD

SEPTEMBER 2003



test drive =

m reviews

Samsung SGH -vV200C

Smile, twist and click

he SGH-V200C gives you

a 180 degree rotating
camera; the phone lets you
flip and zoom images
right while taking pic-
tures. Apart from
being tri-band, MMS
and GPRS enabled, it
is also sleek and styl-
ish, with a crisp,
vibrant 16-bit dis-
play. However, the
external antenna
does get in the way.

Menu operations
in this model are far
simpler as compared to
the earlier R220. The easy
to use four-way scroll key
allows you to hop directly to
predefined menus.

The memory capacity for
contacts 500 names and also
an extra SIM capacity of 250
names with a 32k SIM; and
with 16 MB of internal mem-

Price: Rs 29,999

Contact: Samsung Electronics
India Information & Telecommu-
nication Ltd

Phone: 011-51511234

Fax: 011-51608818

E-mail: chandrasekar@
samsungindia.com

Web site: www.samsungindia.com

ory, it allows you to store a
sizeable number of images,
ring tones and messages. The
device also comes with an
extra set of batteries.

The phone has an
Infrared port, but for some
reason it failed to receive
any sort of data in our tests.
Even though it is MMS
enabled, you can’'t add
audio to your messages,
and the T9 dictionary
does not allow you to
save custom names.

Overall, this is a
nice phone but does
not justify the price

tag of Rs 29,999.

SPECIFICATIONS

16-bit display, 355 x 288
camera resolution, 500 entry
address book, 16 MB inbuilt
memory, GPRS and Tri-band
enabled, MMS capability and
two sets of Li-ion batteries

samsung SGH -V200C @

Performance EEEER
Ease of use EEEER
Value for money k k k k k
Features EEEER

HP PSC 1210 All-in-One

Magic box

he PSC 1210 is a simple

and compact multifunc-
tional product from HP. It
converges printing, scanning
and copying into one single
unit that is not larger than a
full size inkjet printer. The
software required for all its
tasks comes bundled.
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The printer resolution is
1200 x 1200 on plain paper,
and 4800 x 1200 on photo
quality paper. It took just 18
seconds for a full sized text
test page in normal mode.
The photo-quality test prints
were comparable to the best
in the low-end printer class.

The flat-bed scan-
ner can scan A4 size

paper at a maximum
optical resolution of
600 x 2400 dpi and 36-
bit colour depth.
Twenty seconds for a
text document was
what the scanner took,

and the quality of the scan
was acceptable. The results
were disappointing for high
quality photo. The OCR soft-
ware gives a minimum of
errors. A press of a button
copies a document.

The HP PSC 1210 is the
ideal device for home use
where you print and scan
occasionally. We don’t recom-
mend it for colour copies and
scans, however. But finally, at
just Rs 7,999, it is the best
thing to hit the market in

Price: Rs 7,999

Contact: Hewlett Packard India Itd
Phone: 011-26826000

Fax: 011-26826056

E-mail: rajiv_rao@in1.exch.hp.com
Web site: www.hp.com

recent times. Go ahead and
buy it!

SPECIFICATIONS

1200 x 1200 dpi maximum
resolution (4800 x 1200
optimised dpi when printing
from a computer on premium
photo papers using 1200 x
1200 input dpi), 600x2400 dpi
maximum scanning resolution
at 36 bit colour, USB interface,
8 MB buffer, 2 cartridge
printing (colour, black).

HP PSC 1210 e
All-in-One

Performance EEERER
Build Quality k k k k Kk
Value formoney k k k b &
Features Bk kR

Pushpam HandsPC 1600

Touch me not

he HandsPC 1600 has

several good features, and
has an elegant silver body
and chrome finished buttons
that make up the bottom
third of the body. It looks
quite like an iPaq,

most important feature is the
bundled software that is cus-
tomised for Indian profes-
sionals—one that caters to
accountants, and the other to

LIC agents. These

software have full

and at first glance, T lanalefL functional capability
it’'s hard to distin- provided by similar
guish it as a locally desktop software.
made product. The 1600 Hands
The 1600 comes PC is priced at Rs
with a bright white 19,200, which may
backlight, which is - e seem a little steep.
not crisp or sharp :.. ? - This handheld does

enough for reading.

The touch screen also
lacks accuracy, but the hand-
writing recognition is excel-
lent, and the preferred input
mode is writing onto it. The
user interface is similar to that
of the Palm OS.

This PDA is packed with
features—it has an MP3 play-
er, a Dictaphone, and power-
ful PIM functionality. The

Price: Rs 19,200

Contact: Pushpam Infotech
Corporation

Phone: 020-4215162

E-mail: sachin@pushpam.com
Web site: www.pushpam.com

have customisa-
tions, but that does
not justify the price tag.

SPECIFICATIONS

33 MHz Motorola Dragon Ball
processor, Penbex OS, 2-inch

12-bit colour display, IR port,

64 MB Compact Flash,

serial connection

Pushpam HandsPC 1600 @

Performance L
Ease of use EEERER
Value formoney k k k k k
Features Bk EER
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Drive Image 7

Crash helmet for your PC

he worst nightmare of

every computer user is
that their PC will not boot, or
that all their data will be lost
overnight. And this casualty,
just because they kept post-
poning data backup—because
it’s cumbersome and takes
time!

Drive Image 7 is built
precisely to
resolve this
issue. All you
need to do is
use its wizard
for backing up

your  drives
according to
your  prefer-

ences, and it
does the rest
for you, fast.
Installation was
a breeze. You have
the option of storing your
drive image to a hard disk, a
network drive, a CD, or DVD-
R/RW. Drive Image 7 works
with all versions of Windows.
You can specify the
amount of space on each CD
(or disk) to be used so that the
backup image can span across

Price: Rs 2,997 (approx.)
Contact: Sonata Information
Technology Ltd

Phone: 080-6575800

Fax: 080-6567487

E-mail: charudutt.gurkar@
sonata-software.com

Website: www.powerguest.com

disks, and you can make the
software ignore bad sectors on
the hard drive. A compressed-
backup feature is available too.
In our tests, Drive Image
took 1 minute and 16 seconds
to make an image of a 601 MB
drive. The software took 4
minutes to restore a 549
MB folder. Drive
Image per-
formed all the
tasks it claims
to do—fast
backing up,
restoring single
.+ files, and verify-
ing file integri-
ty—at a low
enough price. So
the next time you
want to back up
your data, you know what to
use!

SPECIFICATIONS

Drive Image 7.0 for Windows XP
& 2000: 256 MB RAM, Pentium
compatible or higher processor
and CD-ROM drive

Drive Image 2002 for Windows
9x, Me, NT Workstation 4.0
(SP6a): 32 MB RAM, Pentium
compatible or higher processor
and CD-ROM drive

Drive Image 7
Performance k

Ease of use E

Value for money k
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Features k

WinTasks 4 Professional

Ask the task manager

Without effi- &
cient resource

and task manage-
ment, a lot of your
hardware bucks may
go down the drain.
WinTasks 4 Profes-
sional allows you to
control the potential
of your computer’s
resources.

WinTasks makes |

it easy to find and
remove unnecessary
background process-
es, and to assign
resources to higher-
priority tasks. The sta-
tistics window shows
you the CPU usage
and how the internal
memory is used. But-
tons allow you to
stop, increase or

decrease the priority level of
processes. You can get a
description of the processes,
and the DLLs that they use;
launch scripts; view CPU and
memory usage statistics;
record program logs; and
enable, disable, add or remove
programs from the registry.
The Event log window
automatically logs informa-
tion about all the programs
that were run. You can save
this information in a file for
later analysis. Using the ‘built-
in script’, you can create func-

Price: Professional: Rs 1,997.50,
Upgrade: Rs 1,250, Standard:
Rs 1,497.50, Elements:

Rs 997.50 per license for

100 or more licenses.

Contact: Liutilties

E-mail: contact@litutilties.com
Web site: www.liutilities.com

tions to automate handling of
processes and resources.

The lack of support for
Windows Me, and the fact
that the CPU and Memory
usage is not available for Win-
dows 98, was disappointing.

Overall, priced at Rs
1,997, WinTasks 4 is well
worth it.

SPECIFICATIONS

Pentium 200 MHz or higher;
Windows 98/NT/2000/XP;
10MB hard disk space; 32 MB
RAM; 4X CD-ROM Drive

WinTasks 4 Professional@

Performance EEEER
Ease of Use EEEEER
Value for money & k k k k
Features EEERER

Adobe Photoshop Album 1.0

The perfect digital photo album

dobe Photoshop Album is

a photograph manager
which manages nearly all
types of images on
your hard drive, no
matter where they’re
located. It allows you
to capture photos
directly from a digital
camera, scanner, or
folders across your net-
work, into a central
repository. Besides this,
you can also incorporate
video and audio clips into
your Photoshop Album, and
organise and view them.

When you start the Pho-
toshop Album, the QuickStart
guide window automatically
opens, and points you to all
the major tasks. It provides
powerful tools such as the
Timeline tool that organises
photos by date. The Calendar
view allows you to view the
photos according to the day

Price: Rs 2,500

Contact: Adobe Systems India
Phone: 0120-2444711

Fax: 0120-2537681

E-mail: sandeepm@adobe.com
Web site: www.adobe.com

you took the photos. Thumb-
nails are displayed
on dates of photo-
graphs. The Tags
option allows you
to add information
in order to organ-
ise your photos,
and it allows you
to burn your imags
~~ toaCD. Searching
for your images is
also very fast. All this
makes Rs 2,500 not too much
to pay.

SPECIFICATIONS

Intel Pentium 11l or IV; Windows
98SE, Me, 2000 or XP; 128 MB
or more RAM (256 MB recom-
mended); 250 MB or more hard
disk space; colour monitor capa-
ble of displaying thousands of
colours at 800 x 600 resolution;

CD-ROM drive

BenQ M100 Optical

Mouse

Performance EEEER
Ease of use L
Value for money & k k k k
Features EEREER
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A View to View

ersonal computers have become
P the hub of digital entertainment—

there’s no denying that. But it
wasn’t temptation enough to do away
with the 15-inch monitor that had been
sitting on my desk for the last 3 years. It
was sufficient for all my word processing
needs, and Quake Il looked impressive
enough at a resolution of 1024 x 768.

Everything was hunky dory till the
day that photo-editing job invaded my
world. Of course, | was glad to help,
but the only thing that vexed me
was the fact that | hadn’t tried
Photoshop on my PC—on my 15
inch monitor, to be precise.
Macromedia Flash had not been
quite friendly with my PC either,

a few weeks back. Anyway, |
decided to give it a go, and
opened the PSD file.

Blink! All I could see was tool-
boxes that clothed the image with a
shroud of obscurity. Was it the resolu-
tion? Pumping that up only made the
fonts squiggle, and the flicker exasperat-
ed my eyes. | thought | could survive
until | reached a stage when | realised
that | couldn’t take the visual annihila-
tion anymore.

Now, as that Matrix guy says, |
started to believe, | needed a monitor
upgrade... ASAP! And then began the
battle of choices: should | buy an LCD,
or a CRT? This battle was still on as

ﬁ = |f you are planning to build a

SHOPPIMG new PC, go for 17-inch moni-
TP  tors that are available within the
7 range of Rs 6,000 to Rs 7,500.

= Stay away from 14-inch moni-
tors, as the dealer may be trying to sell
an old piece, as they are not in pro-
duction anymore.
= Check if it an onsite warranty is sup-
ported, since transporting CRTs can be
cumbersome.
= Opt for an LCD if space constraints
or aesthetics are your major deciding
factors.

[EM116

Agent 001 seeks out the right monitor

| headed straight towards a local vendor
near my house, hoping he could help
me out.

There he was, that buck-toothed guy,
standing in front of his small shop, look-
ing very much
like a dis-
torted

milega ‘ell shee dee’ nahi.”

And then, as all roads lead to Laming-
ton Road, | found myself there. The
first dealer showed me an LG 700S 17-inch
CRT, which according to him, was the
best. He quoted a price of Rs 6,900,

and offered me a discount of Rs 2,000
in exchange for my monitor. | asked
him if he had any 19-
inch  CRTs. He
offered me an LG

900B for Rs 14,000,

which is quite entic-

ing, | must say. Then
I asked him which
one was Dbetter—
an LCD, or a CRT?
He gave me an inter-
esting reply. "Aare ek
LCD ke price mein
teen CRT khareed sak-

ILLUSTRATION: Mahesh Benkar

version of Scrooge. | told him of my
upgrade dilemma, and | enquired which
the best available was. He opined that
Samsung was the best, and with a flour-
ish, pointed towards the 763S 17-inch
CRT monitor that was available for a
cool 7,000 bucks. Boy! The price was
impressive enough, but now, | was curi-
ous about the other players. With anoth-
er grand gesture, he pointed to a
good-looking LG Flatron E700S flat
screen CRT monitor that would lighten
my pockets by Rs 9,000. That seemed a
fairly decent buy, but what about the
LCDs? To my utter dismay, he said that
he no longer stocked LCDs as they were
too costly, and that nobody was inter-
ested in buying those.

I was not going to take that for an
answer, since checking out one of those
LCD beauties was something | was hell
bent on doing. (I need to be impartial,
right?) | went across to his local rival.
Alas, the story was the same. “Digital

r 7 /

thay ho, toh achha kya

hoga?" Touché! He did have a
17-inch LCD Samsung monitor
in stock that would deplete me,

financially, by a whopping

Rs 36,000. I gave him a

sheepish smile, and slipped
into the next shop.

This wonderland was with the times,
and the owner was quite tech-savvy too.
He reckoned that LCDs offer sharper
images, and take up very little space, but
CRTs are much cheaper, and colour
reproduction is richer on them. He
offered me a 19-inch CRT from Samsung,
and a 15-inch LCD from Philips, for Rs
14,400 and Rs 22,000 respectively, as an
exchange offer. He also added that Sam-
sung packed in a 3-year onsite warranty.
Pronto, confusion waylaid my thoughts.
Should | go for the 15-inch LCD that
provides superior image quality, but less-
er screen space, or the tried and tested
19-inch real estate?

Reason won over wonder, and i
chose the 19-inch monster, for the enor-
mous workspace it provides, which was
the whole reason for looking for a dis-
play in the first place. At the end of it all,
| had saved a mint cool Rs 6,000, and my
eyes had found a view to fall for! &
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Denyi

Nng you Ser

vice

Plant a tiny ticking time bomb that has been fine tuned to attack, on the Internet. Watch it lie in wait
for a single instruction. Traffic on the Internet comes to a crashing halt when the moment comes. The
show has just begun—or should we say, ended...

beach on a fine sunny day, and
you’ve just pulled down the top of
your convertible. As you leisurely cruise
down the highway, you can’t help but feel
good when you think about the rest of the
day. That is, until you face the mother of
all traffic jams right up ahead, and there
soon seems no way for you to progress.
Now apply that analogy to a ‘Denial of Ser-
vice’ (DoS)’ attack on the Internet: the
information autobahn—that lifeline of all
services online—that you are cruising on,
can turn out to be worse than that demo-
lition derby you saw on TV.
In the networked world, a single click
of a button can turn off the gas. That’s

P icture this: you’re heading off to the
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as simple as it’s getting to be, to attack
the Internet.

Denying you access
A Denial of Service attack is one in which
a remote machine or network is targeted
such that its ability to conduct normal and
legitimate business is tied down by
swamping it with bogus requests for infor-
mation, and utilising all the available
machine and network resources. Distrib-
uted Denial of Service (DDoS) of service
attacks initiate hostile action from several
machines having diverse, and possibly
rapidly changing, origins.

A DDoS attack could involve large
numbers of slave or compromised com-

puters, from between a few hundred to
several thousand. The attacks are usually
well planned and smoothly orchestrated,
take place in discrete steps and generally
take advantage of some known vulnera-
bility in the targeted machines. The first
phase involves rapidly scanning a very
large number of diversely located hosts
to find out the machines that respond to
an existing vulnerability. This could be
some previously known vulnerability, or
some new, unknown one—in the soft-
ware or hardware setup of the machines
being scanned.

Once all the hosts have been probed,
the machines that have responded
favourably—that is, those that still have
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these vulnerabilities and have weaker
defences—are attacked in order to gain
access to them. Once in, all traces of the
break-in are wiped out, and special replace-
ment tools called rootkits are installed.
These prevent other root users (or admin-
istrators) from locating and removing the
unauthorised intruders. In the next step,
the perpetrator of the attack shifts focus to
using the compromised machine as a plat-
form for further attacks, by deploying a
remote-control tool on the compromised
machine. With this machine in control, the
perpetrator can further target other
machines, using this machine to progres-
sively scan and probe and break into more
systems and networks, and install the same
remote-control tools.

Most attacks are generally non-OS-spe-
cific—the tools used to break into and
acquire control of these computers could
be ported into the OS and architecture of
choice. Now here comes the scary part:
with the kind of widely available automat-
ed tools, including worms that can be writ-
ten for known vulnerabilities, it would take
less than 5 seconds to compromise a single
machine—meaning that several thousand
hosts can be attacked, and taken over in
less than an hour.

Blastin’ its Way

In July 2003, Microsoft acknowledged a
vulnerability in their Windows NT, 2000,
XP and Server 2003 related RPC (Remote
Procedural Call) implementation. A buffer
overflow mechanism was detected over
the part of the RPC implementation that
dealt with message passing. A successful
attack would grant the remote intruder full
administrator access on the local system.
MSBlast takes advantage of this vulner-
ability, and gains access to the target sys-
tem. The worm then retrieves a copy of a
file named msblast.exe, executes it and
starts scanning for other vulnerable hosts.
The infected computers reboot with a 60
second timeout. With Internet access
available, the worm is coded to target a
SYN flooding attack at the official
Microsoft update site (www.windowsup-
date.com) on port 80, if the current date is
the 16th or later (from January through
August), or any day of the month
between September and December. The
only solution here is to patch up the OS; a
free removal tool is available at http://secu-
rityresponse.symantec.com/avcenter/venc/d
ata/w32.blaster.worm.removal.tool.html
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But wait up, the show is just starting—
the final step is the actual DDoS attack.
Each one of these compromised machines
are called zombies in SysAdmin-speak, and
with an informal network of thousands of
zombies, each one can be ordered to attack
agiven target using a variety of techniques.
The attacker can control each zombie with
just a single command, and instruct them
to launch any type of attack. Turning off
the attack is as simple as issuing another
command. As the examples of some of the
most ferocious attacks in Internet history
will show you, the attempt succeeds
because the co-ordinated effort across
numerous slave machines overwhelm the
resources of the victims.

If this dangerous sequence of steps was
done under manual supervision and con-
trol, the number of computers that could
be compromised would be limited to what
the cracker could handle. But take this
technique and automate it down to one
self-propagating program—a worm that
will mindlessly follow the directives pro-
grammed into it, millions of times over—
and that is the nature of the world’s most
destructive Internet DDOS attacks.

Slamming it down, hard

The Slammer attack that struck around the
25th of January 2003 hit all the records,
and went down in history as the fastest
computer worm ever. Slammer is a slickly
crafted worm that takes up a mere 376
bytes of memory. The worm took advan-
tage of a rather common flaw that can
potentially exist in most applications,
known as buffer overflow.

During normal operation, code is read
into the system memory and occupies cer-
tain real estate there i.e., allocated memo-
ry blocks called buffers. A buffer overflow
happens when too much data is pushed
into a buffer. After the buffer fills up, the
data being read wipes out the program code
in the neighbouring blocks, and substitutes
that code with the new code. This is where
arbitrary code can be fed into the system
and malicious instructions executed.

Slammer exploited a stack buffer over-
flow flaw in Microsoft’s SQL Server: the
worm pumped data into the server, way
beyond what it was legitimately allotted.
As a result, other data got read into mem-
ory space where it was not supposed to.
This effectively let Slammer give new
instructions to the host computer—the
ones Slammer used to propagate itself—
which the computer executed.

This security loophole had already

been identified in July 2002; patches that
resolved this had been released by
Microsoft before the public announcement
of the vulnerability. Slammer managed to
get through anyway, because not enough
people had patched up, early enough. It
used some pretty smart tricks to ensure
rapid infection. The infected population
was estimated to double roughly every 8.5
seconds. It used random IP scanning, to
zero-in on other computers all over the
Internet. Just one 376 byte UDP packet
(the kind used to send information across
the Net) destined for UDP port 1434 spread

Slammer: 376 bytes long, spreading world-
wide, coming to a computer near you

across millions of random IP addresses,
and ultimately infected an estimated
75,000 hosts. Networks all over the world
started going out as each infected machine
spewed out more packets to random IP
addresses, as fast as network connectivity
would allow; the sheer volume of senseless
traffic being put out was bringing down
networks in North America, Europe and
Asia. In the US, ticketing and schedules of
the domestic airline, Contenental Airlines
were disrupted; Seattle’s law enforcement
and emergency response units went offline
and the employees found themselves back
in the early 20th century with radio sets
and pencils; the 13,000-strong ATM net-
work of Bank of America went on the
blink; and many Internet sites went offline
as their servers were swamped by traffic.
All of South Korea and many parts of
Europe went offline, and five of the Inter-
net’s root servers—the Internet’s version of
a lookup directory service—went down.
Despite the havoc, Slammer did not
seem to contain any destructive payload,
and has not appeared to have destroyed
any computer files. Still, a worm that
spread over the world in roughly 10 min-
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utes lead some analysts to predict that
Slammer may very well be the first of many
such swiftly spreading worms that could
use enormously destructive payloads.

Slammer’s origins have remained
unknown—the small size of the worm
ensured there was no additional informa-
tion about the worm in the code, and has
made it hard to trace its origin.

Red is the colour

Back in June 2001, security professionals
detected a vulnerability in Microsoft’s 1S
4 and 5, running on Windows NT, 2000,
and beta versions of Windows XP. The
flaw here was a gaping hole in the Index-
ing Services of 1IS 4 and 5, another
remotely exploitable buffer overflow prob-
lem; any intruder who could reach a vul-
nerable Web server could execute arbitrary
code and eventually gain complete access
to the system. Microsoft released a patch
that addressed this problem. Those who
didn’t patch up quickly enough, faced a
new worm around July 12th, one that
exploited the IIS vulnerability to the hilt.
The worm called Code Red attacks by
attempting to connect to TCP port 80 of
a randomly chosen host. The 4 KB sized
worm passes a carefully constructed URI
(Uniform Resource Identifier) to the HTTP
service (a ‘GET’ request). If the system is
vulnerable, the request will almost cer-
tainly exploit the buffer overflow vulner-
ability in the system, and allow the code
to execute.

The worm came with some pretty good
smarts programmed in. It first spawned 100
threads, thus running a 100 copies of the
worm at that time. It then followed a fixed
timetable—between the 1 to 19 days of the
month, it would try to infect other hosts.
From the 28th day to the end of the
month, the worm would go to sleep. The

Know Thy Enemy

It looks like just about any computer on the
Internet, with a standard OS and offering
standard services, but with one difference:
it’s a honey pot. Honey pots have been
designed to appear as attractive options to
crackers, the sort that they just cant seem
to ignore. They appear to be a normal
machine to the cracker; loaded with what
appears to be genuine data the cracker can
explore. Meanwhile, the good guys are
busy using the honey pot to trace the
hacker and learn more about the
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real action would happen between the
20th and the 27th day, when the worm
would launch a packet flooding DoS attack
on the IP address 198.137.240.91. At that
point of time, that IP address was assigned
to the official Web site of the US Presiden-
tial office. The worm also affected certain
Cisco routers, triggering off an unrelated
vulnerability. The DoS attack on the White
House site was performed by sending
98,304 packets to the whitehouse.gov serv-
er. Now, all 100 threads of the worm can
take part in this attack, giving rise to 100
times 98,304 packets every four-and-a-half
hours, after which the worm slept. Finally,
the 100th worm thread defaces the server
with a message saying it had been hacked
by the Chinese.

The only indicator of the abnormal
activity of DoS is unusually high traffic.
Code Red could be swept off a system if the
system is rebooted. The problem is that
since all the Code Red infected systems
scan the same IP addresses, they tend to re-
infect as soon as the computer comes
online again.

But that’s where Code Red was
flawed—its random number generator
was not perfect, and so, identical lists of
seemingly random target IP addresses
across different machines were created.
This meant that the worm spread rather
slowly, probing and scanning infected or
invulnerable machines.

Code Red was followed by a smarter
Code Red v2, the CRv2 worm. CRv2 came
with a far more sophisticated random seed
so that each infected computer came up
with different lists of random IP address-
es to target; this vital difference in code
allowed CRv2 to infect so many machines
that world-wide traffic in the third week of
July 2001 slowed down considerably. Also,
CRv2 was so smart that it no longer hard

compromised aspects of the system as well
as how the hacker probes the computer.

An extension of this is the Honeynet
project that uses several systems over a
network. In the network, inbound and
outbound connections are analysed,
informing users about the kinds of
intrusions that take place. The Honeynet
provides services very similar to a
production system, making it appear
genuine. The Honeynet project is located
at http://project.honeynet.org/

Am | at Risk?

Yes, you are. You may be just a home
user with a cable, DSL or an always-on
pipe to the Internet, but even if you don’t
run a site, your computer could still be an
unwilling participant in a DDoS attack as
a zombie, spewing out packets in an
effort to snuff out another site. Moreover,
this also leaves the data in your computer
very vulnerable to the tender mercies of a
cracker. What can you do? Take all the
basic precautions—use a strong firewall
and anti-virus solution, don’t install soft-
ware whose authenticity you can’t verify,
and be sure to keep track of and install all
the important updates, at least the securi-
ty related ones, that might prevent your
computer from being ‘acquired’.

coded the White House’s Web site
address—it queried a DNS and looked up
the address.

In August of 2001, yet another worm
came out into the wild. This one was
called CodeRedll; it was unrelated to the
first two, but used the same vulnerability
in the IIS servers. This was no mean
worm—unlike the first two, CodeRedll
was not memory resident, so a mere
reboot would not help. After infection, it
initiates propagation, and then opens up
a backdoor and remains dormant for a
day. Intriguingly, the worm does no dam-
age to any files or Web pages—instead, the

Code Red: lying silent and waiting
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really dangerous thing about it is that the
backdoor it opens allows for root-level
access to the infected machine and per-
mits any code to be executed, thus mak-
ing the machine a potential zombie.

Most of the world appears to have
patched up against CR and CRv2. But the
Code Red story doesn’t end here—there
still exist systems that are vulnerable,
ready to infect others, waiting.

Target the roots

The internet today relies on 13 crucial DNS
(Domain Name Service) root servers that
act as a sort of main directory service for
routing packets across the Internet to make
sure they reach the correct machine. The
central ‘A’ DNS server is operated by Net-
work Solutions Inc, and this server main-
tains the master list of all top level domain
names (such as .com, .org, .net, .mil and
country-specific codes). This list is dupli-
cated in the 12 other root servers on a daily
basis (the servers are designated ‘A’ through
‘M’). The list is made available to all routers
across the Internet, and routing tables are
updated by referring to the lists in the root
servers. For example, this is what converts
www.google.com to its respective IP address,
and lets you locate a machine’s location
through its domain. Now, to ensure redun-
dancy, and to make sure that all the root
servers don’t get taken down by the same
natural or unforeseen calamity, the servers
are dispersed globally, in places as far
apart as Stockholm, London, Tokyo and
Maryland. They are monitored by the US
government agencies, as well as research
organisations and universities, they are var-
iously defined as ‘battle hardened’ and
‘equipped to live through attacks of all
sorts’—aor so they wish.

On the 21st of October 2002, nine of
the thirteen root servers showed how vul-
nerable they were. In an attack that lasted
just over an hour, a major distributed DoS
attack was mounted on the root server sys-
tem worldwide. The root DNS servers have
been attacked before and subjected to DoS
attacks, however what made this different,
and more serious was the fact that all the
root DNS servers had never been targeted
at the same time before. The attack itself
came as a huge ICMP flood. ICMP, the
Internet Control Message Protocol, is a sys-
tem designed to carry error reporting or
testing data. To put it simply, what hap-
pened was a ping-style flood that was used
to clog up the access lines, and eat up all
available bandwidth, so that all legitimate
data packets got lost.
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Jargon Buster

Zombies: Zombies are computers that have
been taken over by a remote attacker, and
are used to attack other computers.

Ports and port number: A port is a termina-
tion point on a network. Port numbers allow
different processes and programs to use net-
work resources without interference.

Buffer Overflow: Programs allocate fixed size
blocks called ‘buffers’ for reading data. If a
program is given too much data that it reads
into the buffer without checking the size, the
buffer overflows leaking the data into neigh-
bouring memory. This could potentially over-
write the program code, and the computer
may execute the overflowing data as a part
of the instructions. If the exploited buffer sits

Fortunately though, two things came
to the rescue of the Internet. The first was
the fact that most DNS query data does not
reach the root servers—instead, caching
techniques are used, meaning that actual-
ly consulting the root servers is generally
the last resort. The second was the fact that
server administrators quickly realised that
the attack was an ICMP data flood, and
hence shut down those services. Yet, nine
of the root servers were overwhelmed in
the attack and succumbed. But reports at
the time indicated that since the attack was
short-lived, most users on the Internet
never came to know about the outage in
service. On the flip side, most analysts
agree that the attack had indeed continued
for several hours, then with the DNS
caches slowly expiring the world over, no
top-level domain name conversions would
have taken place through the root servers,
and users would have been snapped out of
the online link. The ‘F’ root server, for
example, responds to over 270 million
DNS queries every day. To put it in per-
spective, we were plain lucky that the
‘most sophisticated, large-scale assault in
the history of the Internet’ stopped with
just this much damage—but we could
expect worse in the future.

Hindsight, 20:20

DoS attacks today have become very
sophisticated; the time, kind and duration
of the attack, and the victim’s IP address
are now programmed into an attack
mechanism or code. The fact also is that
the acquisition and infection phase is
pretty sophisticated, and that’s why, once
a host has been taken over, the popula-

in a privileged program, a malicious program
could take full control of the computer.
Stack Overflow: A program stack is a block
of memory that holds the list of functions to
be executed. If a programmer isn’t careful, it
is possible for a hacker to send a large packet
of data that overwrites the stack, and exe-
cutes functions that the hacker wants. If the
exploited stack sits in a privileged program, a
malicious program could let an intruder take
full control of the computer.

Backdoors: Malicious programs that let
intruders access a computer system. These
programs may, for example, modify impor-
tant system tools that would let a hacker
access the computer at a later date.

tion of infected machines enlarged.

The Code Red and Slammer attacks
have targeted specific known vulnerabili-
ties in application software. This is cer-
tainly not the only way to attack and take
over machines, but the most successful
attacks in recent times have been of this
type. With more and more vulnerabilities
being identified in common application
software, the likelihood of worms that tar-
get them is definitely going to increase.
And Brute force attacks, such as the Octo-
ber 2002 DNS root server attack, can
always be done.

If you believe that switching over to
open source solutions is a remedy, think
again—the problem lies not with the
kind of software, but with how well
informed and how well-patched up you
are. Both open source, as well as propri-
etary solutions, have shown vulnerabili-
ties, and this does not take into account
attacks that target bugs and features in
protocols. In both the Code Red and the
Slammer worm attacks, critical patches
were available before the attacks took
place, yet the spread of the worms in
both cases was astonishingly fast—show-
ing that a vast number of servers had not
been patched. And here’s some more
food for thought: News.com reported
over two years back, that over 4,000 DoS
attacks hit the Internet every week. Now
that is scary. With all of four billion hosts
on the Internet, how big is this statistic
going to be in the next few years? More
importantly, will you be yet another
number in a table?.k

SRINIVASAN RAMAKRISHNAN
srinivasan_ramakrishnan@jasubhai.com
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%Minutes Expert
Rely on the Net

ou just bought a Reliance cell
thone, but are a little confused
about how to connect it to your
laptop or PC for Internet access. We

show you how to do it in 30 minutes
flat! Let’s get started.
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Enter the username and password in the dialer

The first thing you should do is get a
data cable to connect your handset to
your computer. Most data cables have
either of two interfaces—Serial (COM
port) or USB. We recommend a USB
interface, for the sheer ease of installa-
tion and use. Make sure you get an orig-
inal, manufacturer-recommended data
cable for your cell phone model.

Next, in Windows 98 or Me, install
the Dial-up Networking and TCP/IP pro-
tocols for the Dial-up adapter. To do this,
go to Start > Settings > Control Panel and
open Add/remove Programs. Click on
Windows Programs, select Communica-
tions and click on Details. Check Dial-
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Select the model and the port to which it is
connected in the wizard correctly
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up Networking and click OK twice. Now,
from the Control Panel, open Network
and click on the Add button. Select the
Dial-up adapter and click OK to install
it. Next, click on Add, select the
Microsoft TCP/IP protocol and click OK
twice. The setup will prompt you to
insert the Windows installer CD, do this
and reboot your computer when the
installation is done.

Insert your R Connect CD after your
PC restarts, and start the Installation
wizard. Click Next at the Welcome
screen, and select your handset’s make
and model number. Set the cable type to
USB or Serial, as per the cable you have.
Here we used a Serial data connector, as
it is the cheaper and more popular data

Laluc! pow Hskance Incisdd chal
derddy o mabon ard modal o por |l ilanes indaddobds

A7k Refance
IndiaMobile

fiabac! B raska vty phe [LG -

. —

ol catle ™ Ukt el

IF

ek e R

Select the port to which the phone is connected

cable interface. Before connecting the
cable to your phone, you have to set
your phone to work as a modem. Type in
412’ and press the call button. You will
receive a confirmation SMS that tells you
that your phone is now ready to be used
as a modem. Now you can connect your
PC to the phone via the data cable.
Continue the R Connect installer
wizard by selecting the COM port that
your phone is connected to—either
COML1 or COM2. Click on Yes and the
phone will be detected—if it isn’t,
choose the other COM port and click
Yes. After the phone is detected, press
Next and all the necessary drivers will be
installed. The phone will now be dis-
played as a modem in Windows. You will
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Restart your PC after installing the R-Connect
software

be prompted to restart you PC, so
close all applications and select ‘Yes,
Restart Now’.

After the reboot, the Reliance dialler
will pop up, and ask for the username
and password. If your mobile number is
(+22) 3101 XXXX, then your username
and password will be 223101XXXX.
Enter the number accordingly, and hit
Connect—the connection will be estab-
lished almost immediately.
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Enter your username and password in the
dialler box and click Connect

You can set Internet Explorer to always
use this connection from Tools > Internet
Options > Connections. Now, you will get
Internet speeds between 40 Kbps to 80
Kbps, but also remember that this service
is a battery hog—a fully charged phone
battery will only last for about 30 minutes
of continuous connectivity.E

NIKETU SHAH
niketu_shah@thinkdigit.com
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called GnuCash and Quasar do all your

money management for you. Gnu-
Cash, with its simple to use interface is
more suited to home users or amateurs,
while Quasar is a more professional finan-
cial accounting software, suitable for pro-
fessional users such as chartered account-
ants and so called advanced users.

In Linux, two accounting packages

GnuCash

GnuCash allows you to track bank
accounts, stocks, income and expenses. It
is an easy-to-use software based on pro-
fessional accounting principles to ensure
balanced books and accurate reports. This
software comes bundled with most distri-
butions such as Red Hat and ELX.

As soon as you start the software, it
prompts you to choose from either ‘Create
a new set of accounts’, ‘Import files’, or
‘Start tutorial’. Start with the ‘Create a new
set of accounts’ option.

Now a new account setup druid starts.
This druid helps you create the basic

it

Let the penguin pinch your pennies

accounts that are needed to start your
finance management and accounting
actions. The next step the druid does is to
select the currency. Click ‘Select button’,
keep the Type as Currency, set ‘Curren-
cy/security’ to ‘INR’ and press OK.

To create accounts, select the cate-
gories that are applicable to you. All the
necessary account heads relating to that
category will be created automatically. For
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Set the default currency in GnuCash to have all
values displayed in a currency of your choice

PHOTOGRAPH: Jiten Gandhi

example, if you select ‘Common
Accounts’, the category will include all
accounts that would be needed by you to
maintain your accounts. Accounts thus
created will consist of income accounts
such as salary, expense accounts such as
education, insurance, taxes, etc. It will also
include assets and liabilities accounts such
as credit cards and savings accounts. Press
Next to create all the selected accounts.
Once the accounts are created you need
to specify the opening balance for the
accounts. Finally, press Finish to get out
of this druid. Now you can enter the fig-
ures on a day-to-day basis. But before you
start, make sure you have changed the
default date format. Navigate to Settings >
Preferences > International, and set the date
format to UK (mm-dd-yyyy).

Now you can begin managing your
moolah. First, enter the salary details. To
do this, expand the Income group by
clicking the ‘plus’ sign next to Income,
and then double-click on the Salary entry.
A new window will appear as a column.



the Expense
group, and dou-

[ i R )

ble-click on the
entry to open it.
Here you will

This is what your salary entries will look like, from the the
start of the financial year

Begin by entering the date you received
your salary cheque, then a small descrip-
tion to summarise the salary transaction
(writing the cheque number in the
description is a good idea). Then, in the
Transfer column select ‘Assets:Current
Assets: Savings Account’, and finally, in
the Income column, type the salary
amount. An example entry is as follows:
Description: Salary for the month of September
Transfer: Assets: Current

Assets: Savings Account
Income: 1000.00

The financial year starts from April, so
you will need to feed in all the entries
from April, to the current date.

Once your income group is updated,
you need to work on the expense group.
For example, an important account in
Expense that needs to be mentioned is
transportation cost. For this, you can use
the Public Transportation found within

find a column
similar to that in
the Salary account.
If you use your own vehicle
to commute, you can use the
‘Fuel refill’ category, which
will also be mentioned in the
Public Transportation

i
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account. Whenever you
make any entry within the
Public Transportation
account, most of the entries will have the
Transfer column value as ‘Assets:Current
Assets:Cash in Wallet’.

Your salary goes directly to your sav-
ings account, while your transportation
and other expenses are cash transactions.
So you’ll have to make entries in the sys-
tem to reflect a cash withdrawal transac-
tion. The entry will transfer a certain
amount of funds from the savings account
to the ‘Cash in Wallet’ account. For such
entries, the Transfer column will contain
‘Assets:Current Assets:Savings Account’
with the ‘receive’ column containing an

Entries Transferring Funds from Bank Account to Cash-in-Wallet

amount, say Rs 100.00. An example entry:
Description: Monthly Expenses

Transfer:  Assets: Current
Assets: Savings Account
Receive:  100.00

All other expense transactions can be
created in the same way. You may need to
update different expense accounts such as
rent, property tax and so on. Another type
of entry that involves transactions in three
accounts, is credit card transactions. To
replicate this scenario in the software sys-
tem, first double-click on Clothes within
Expenses, then create a new transaction

1/2 page H AD
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Types of Accounts

The following terms each identifies the
account as being:

Bank: A bank account.

Accounts Receivable: Used for providing
customers with a line of credit.

Other Current Assets: A current asset
other than a bank type account or a
receivable type account. A prepaid bill is
an example of a current asset.

Fixed Asset: Fixed assets include such
investments as buildings and land.
Other Asset: An asset other than a
current or a fixed asset.

Accounts Payable: The account that is
used for the purchase of products. Multi-
ple payable accounts can be defined.
Credit Card: For company credit cards.
Other Current Liability: Any current liabil-
ity, other than a payable account or a

(if you’ve purchased clothes using your
credit card) with the Transfer column
pointing to ‘Liabilities: Accounts Payable:
Credit Card’. Finally, create an entry with
the same amount in the Savings Account
with the transfer field, pointing again to
‘Liabilities: Accounts Payable: Credit
Card.” This completes the cycle and set-
tles the balance amount in the Credit
Card account to 0. You can check this by
double clicking on the Credit Card
account within ‘Accounts Payable’ in ‘Lia-
bilities.” It looks something like this:
Entry within Clothes
Description: Clothes Shopping
Transfer: Liabilities: Accounts

Payable: Credit Card
Expense: 150.00
Entry within Savings Accounts
Description: Repayment of Credit Card bill
Transfer: Liabilities: Accounts

Payable: Credit Card
Withdrawal: 150.00

At any instant, while you are using
this software, you can view the Profit and
Loss value in the bar just below the tool-
bar. If the values show in dollars, click the
arrow button to the left, and from the
drop down list, select INR. This figure
gives you information about your current
financial situation.

Once you have updated all your
income and expense details into proper
accounts in the software, you can go on to
view the reports. When you open a report
for the first time, it will show you figures
in US dollars, so you need to specify the

[EM 126

credit card account. Income tax payable is
one such liability account.

Long Term Liability: A would be a long
term liability.

Equity: An equity account; say the share
holder capital in a company.

Income: A standard income account. Sales
accounts are all income accounts.

Cost of Goods Sold: When a product is
sold, the inventory is reduced by the cost of
the goods sold. This account keeps track of
your total cost of sales.

Expense: Expense accounts are for all
expenses such a fuel, power, water, rent
and staff costs.

Other Income: A non-standard income
account.

Other Expense: Any non-standard miscel-
laneous expense account.

currency as Indian Rupees (INR). Do so by
clicking Options in the toolbar, then
selecting the report’s Currency INR. Press
OK for the changes to take effect.

In the Report section, the most fre-
quently used fields will be Accounts Sum-
mary, Profit and Loss Account and Bal-

Tell us more, and WIN!
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ance Sheet. GnuCash provides all three,
along with a set of pie and bar charts such
as assets bar chart, income pie chart, and
others. After you’ve chosen all your set-
tings, choose the folder and the file where
all the data should be stored. Do so and
close the file.

Quasar

In Quasar, the base package is available
free of charge for a single computer,
while add-on modules are available for a
nominal fee.

To install Quasar, you need the
quasar-1.2-3.tar.gz file. You can download
the software from www.linuxcanada.com. To
start the installation, execute the follow-
ing command: ‘tar -zxvf quasar-1.2-3.tar.gz’.
This will create a folder called ‘install’. The
next step is to go to the ‘install’ folder and
execute the install.sh file. When you exe-
cute this script, it will install all necessary
files, and start the Quasar server.

When the Quasar server is up and run-
ning, start the GUI client by executing the
command ‘quasar’ in the terminal window
or run window. When the software starts
for the first time it will request you to
select the default language; choose ‘Eng-
lish (United States)’.

Quasar has a license agreement that
you have to accept in order to get to the
welcome screen. The welcome screen pro-
vides you with an option to ‘Open com-
pany’ or ‘Open sample company.’ If this is
the first time you’re using the software,
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Create a new account here

select ‘sample company,’ then go to File >
New Company. A wizard will take you
through the process of creating a new
company. Here, you have to specify the
mailing address, the month to be set as
the first financial month and the filename
for the data file.

Before you begin working with the
software, you will have to set up a few
important configurations manually. Go
to File > Configuration > User Configuration >
Internationalisation, and press Customize.
Here you will be able to customise a lot
of settings—from the date and time, to
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currency format, the number of digits
after which a comma should be placed,
and so on.

Once all the settings are complete you
need to create the accounts for the various
income, expense and other groups. At the
very least, you need a bank account, cash-
in-hand, credit card and salary account,
plus a few additional expense accounts
such as transportation, clothes, etc. To
create your first account, the Bank
Account, go to Ledger > Chart of Accounts >
New. Here, specify the account name, say
Savings Account, and select the account
type as Bank. Press Next to create more
accounts in a similar way.

The default account type for Salary
should be ‘Income’, for credit card ‘Cred-
it Card’, and for expense accounts
‘Expense’. Quasar does not have a pre-
defined ‘Cash’ account type, so to create
a cash-in-hand account you will have to
specify the account type as Cash.

Once you have all the accounts creat-
ed, the next task is to enter all the trans-
actions one by one. To insert a transac-
tion, you need to press the Journal Entry
within Ledger. The entry page is not as
simple as that of GnuCash. The ID field
has a value of ‘#’, meaning it will take the
next free ID from the database. The memo
field is the description field for the entry,
so you can enter a small description here.
You can select the account you need to
debit or credit by first clicking in an
empty cell within the Account column
and then pressing [F9]. This software
varies from GnuCash in terms of debit or
credit here too: in GnuCash you can see
simple columns such as receive and give,
but here, you get the standard screen with
a debit and credit column.

Let’s start with the salary transaction.
Specify the date when you receive your
salary, put in a description in the memo
field, and select the Salary account. Spec-
ify the amount in the Credit column, go
to the next row, select the Savings
Account, and specify the same amount in
the debit column.

Note that the Debit total and the Cred-
it total should be same in the right bottom
part of the window. Press Next to contin-
ue with further entries. For the Salary
account, money is going out, so it has to be
credited, and for the Savings account,
money has to be debited.

Now, to withdraw money, you need
to credit the Savings account and debit
the cash-in-hand account. To spend cash
for books, the entry should credit the
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‘cash-in-hand’  account T
and debit the ‘books’ [ia =iaiia
account. A transaction | & e

dealing with credit cards -
requires two entries, the -
first debiting the expense —
account (for example,
Books) and then crediting
the Credit Card account,
while the second repays
the credit card bill by deb-
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iting the Credit Card
account and crediting the
Saving accounts. If you
buy books worth Rs 624 using your cred-
it card. The entry will look like:
First Journal Entry
Memo: Book shopping
Clothes: 624.00 Debit
Credit Card: 624.00 Credit
Second Journal Entry
Memo: Repayment of Credit Card bill
Credit Card: 624.00 Debit
Savings Account: 624.00 Credit

Similarly, you can carry on your daily
transactions with the help of Journal
Entries. As all your transactions are
entered, if you realise that one of the pre-
vious entries was incorrect, correct the
entry by clicking on Transaction Journal

Modifying a Transaction

Inventory, Sales and Purchases. The
Ledger section contains trial balance, bal-
ance sheet and profit and loss accounts,
plus an additional Account Listing.
Account Listing report shows you the bal-
ance for every account in your company.
This software is not just a financial
software solution; it is a complete solu-
tion for small business units with
modules such as vendor billing, vendor
claims, quotation and invoices, cheque
writing and printing, sales and
purchases, and so on—that is, an Inven-
tory Management system. [l
MUSTALI KACHWALA
mustali_kachwala@thinkdigit.com

within Ledger.
Select the ‘Dates:’
as ‘This Year-to-
date’ and press
Refresh. You will
get all the entries.
Just double-click on
the entry to modify
it.

To know your
financial status at
any moment you
just need to view
the trial balance,
profit and loss
account and bal-
ance sheet using
the Reports menu.
The Reports menu
also contains a
Transaction and a
Report Listing. The
Transaction report
lists all the transac-
tions that have
happened. The
Report List has
more reports cate-
gorized into six sec-
tions—Card File,
Ledger, Cheques,

1/4th AD
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insight = _ troubleshooting

Haunted computers, cameras that don’t work, CDs that refuse to run, computers that won’t shut
down, or just upgrade advice... Tell us about it and we’ll help you solve it

Camera can’t find file

T, | recently bought a Sony DCR-
TRV355E USB and a Sony DSC-P8
USB camera. When | restart the machine,
after installing the required drivers, | get
an error message saying, “File USB-
NTMAPR.SYS is missing.” This happens
for both the cameras. Can you tell me
what I’'m doing wrong?

Abhinav

A since the message says that the cru-
cial file is missing or corrupt, the solu-
tion would be to replace the needed
file—all you have to do is copy the file
from the original Windows CD. Look
for the file named driver.cab in
Windows XP and 2000, or base2.cab in
Windows 98 and Me, and extract and
copy it. If you do not have the original
CD, or if you can’t find the file, go to
http://www.usb-drivers.com/ driv-
ers/49/49917.htm and download the file
of the same name for the version of

A
b problems, and we may

answer them here! Since we get more

sos@jasubhai.com
E-mail us your computing

mails per day than we can handle, it may
take some time for your query to be
answered. Rest assured, we are listening!
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Windows you have installed.

Time for action

Q, Whenever | try to explore any folder
including my CD-ROM drive, Windows
displays an error message saying, “A run
time error has occurred. Do you wish to
Debug? Line: O Error: Type mismatch:
‘KJ_start”.” Can you help me?

Sharma Gourishankar

M Uh-oh! Looks like your machine is
infected by a virus; you’ll have to
delete all the files with the ‘htt’ exten-
sion. The easiest way is to go Start > Find
(or Search in case of Windows XP), type
“*.htt’ as the criteria and start searching.
Once the search is complete, select all
the files in the search window and
press [Delete].

Now that you’ve learnt your lesson,
go to your anti-virus vendor’s Web site,
download the latest update and scan
your hard drive.

Where’s my graphics card?

1, | have a PC with a Pentium 4, 1.5
GHz, 128 MB DDR RAM, a 40 GB
Samsung hard drive and a Mercury KOB
845G/GL NDSMx motherboard with an
Intel chipset, and onboard sound and
video. My problem is that whenever | try
to install Linux 7.2, it does not recognise
my video card. Linux 7.2 does not list my

motherboard in the list of in-built drivers.
Where can | find the required drivers for
my video card?

Saumik Pal

The KOB 845G/GL NDSMx motherboard is
supported by newer versions of Linux

Mo you are really attached to your
version of Linux, and do not want to
upgrade to a later version, you can
download precompiled binaries in the
rpm format from ftp://aiedownload.intel.
com/df-support/6080/eng/dripkg-1.
0-4.i386.rpm. If you want to compile the
code yourself, go to ftp://aiedownload.
intel.com/df-support/6185/eng/20030425-
i386.tar.gz, and get the readme file from
ftp://aiedownload.intel.com/df-sup-
port/6080/ ENG/readme.txt.

On the other hand, since your PC
configuration is definately good
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enough, you can run newer versions of
Linux that have the drivers for your
motherboard and graphics card. These
distributions are available on the DVD
provided with the August 2003 issue
of Digit.

Faulty CDs

Q, | have a Compaq Presario with a
Pentium Il 1 GHz processor, 256 MB
RAM and 20 GB hard disk running
Windows XP. Recently, | got a book called
Red Hat Linux 8 Bible, which bundled
three CDs for installing the operating sys-
tem. Whenever | try to install Linux from
these CDs, it gives me an error message
that says, “The second stage of the install
which you have selected does not match
the boot disk which you are using. This
shouldn’t happen and | am rebooting
your system now”. Can you help me
solve this problem?

Amita

F. Unfortunately, you can’t—not using
those CDs at least. The problem is that
your CDs have the publishers edited
version of Red Hat 8 with incorrect
file sizes. What you can do is
download the correct version from
http://www.wiley.com/legacy/compbooks/
errata/redhatpubed/.

You don’t even need to do that; just
get the Digit August 2003 issue that has
a DVD, with the best Linux distribu-
tions, including Red Hat 9.

Misinformation

Q, | have a problem with the Frontech
Classycam digital camera that | bought
about two weeks ago. My computer is a
Pentium 4, 1.5 GHz with 256 MB RAM
running Windows XP. It said on the box
that the camera works with Windows XP,
but when | installed the driver provided
with the camera, | got a warning that the

The Frontech Web site clearly states that there
are no Classycam drivers for Windows XP
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A Boot for a boot
I|'-E,When | create a bootable CD using
Nero, the system prompts me to
insert the bootable Windows 98
CD. So | need to make, is a
bootable Windows 98 CD. How
should | go about doing this?

Atul Jain

A To create a bootable Windows
98 CD, you need the Windows 98
installer CD, as well as a bootable
floppy handy. What you need to

do is insert the bootable floppy,

and then start Nero. Select

CDROM (Boot) as the type of CD to
create and specify A: (or whatever
your floppy drive is called) in the
‘Bootable logical drive’ box. Copy the

software was not designed to work with
this OS, and may not work. | decided to
continue installation anyway.

Now, when | try to download
pictures, | get a series of five errors,
starting with ‘Failed to get USB device’.
Can you please tell me the solution
to this problem?

Abhinav Sharma

M Looks like you’ve been duped! The
Frontech ClassyCam does not offer
drivers for Windows XP, nor are any
available on the Internet. In order to
use this camera, you’re going to have to
connect it to a machine running
Windows 98, 2000, or Me.

Never shuts down

2, 1 have a Pentium Ill, 800 MHz
processor with an 810e motherboard,
128 MB RAM, and two operating
systems—Windows 98 and Windows XP.
The problem is that my Standby option
has been greyed out, and if | select Shut
down, the computer just restarts. The
problem exists in Windows XP only, and
not with Windows 98. | even checked the
power options in the BIOS and Control
Panel—they all seem to be OK. Then, |
tried to disable restart from System
Properties > Advanced > Startup & Recovery,
but got the Error; “0x0000007E
(0xC0000005, OXFC7F1945, OXFC9589B0,
OxFC9586B0) kbhdclass.sys - Address
FC7F1945 base atFC7F1000, DateStamp
36d82f3”. | have to reboot in Windows 98
just to shut down. What should | do?
Nitin

‘win98’

folder
from the Windows 98 installer CD to
your new compilation, add any files
that you want and write the CD.

ILLUSTRATIONS: Farzana Cooper

A In windows XP, the computer
reboots automatically when a fatal error
occurs. If that fatal error only occurs
when you’re shutting down, the system
reboots automatically. If you haven’t
changed any of the system failure set-
tings, you should be able to see the
error in the Event Log—right-click on
My Computer and go to Manage > Event
Viewer > System.

This can also occur if the Logitech
iTouch software version 1.5, or earlier is
installed for some Logitech keyboards,
such as the Cordless Freedom models.
Install the latest iTouch drivers from
www.logitech.com.

No can hear

£2, | have a Pentium 4 with 128 MB RAM
and a 40 GB hard disk, running Windows
Me. About a month after installing Power
Screensaver Builder, | began facing a
problem with the sound. | got an error
message that said “MMSYSTEM266 the
device could not be loaded, verify that
the driver is installed correctly”. | tried
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Use System File Checker to replace missing
system files
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Boot the multi-boot menu

q,l have an Intel 933 MHz on an Intel
MB815e motherboard, and an ATX
power supply, running Windows 98 SE
and Windows XP. The PC works perfect-
ly except that when it shuts down it
displays “It’s now safe to turn off
your computer”, instead of directly
shutting down.

My second problem is that | have
formatted my D drive, where Windows
XP was installed, but still get the menu
to choose which operating system
to boot from. How do | solve these
problems?

Ruhit

A Ok here’s what you have to do; to
fix the shutdown problem, go to the
CMOS BIOS settings by pressing
[Delete] when the PC boots. Go to the
Power Management option in the
BIOS menu and enable ACPI, press
[Esc], save changes to CMOS and exit
the BIOS screen.

Now, for your second problem,
right-click My Computer and go to
Properties > Advanced and click on
Settings in the 'Startup and Recovery'
section. Here, set the 'Default operat-
ing system:' to Windows 98, and set
the 'Time to display list of operating
systems:' to zero. The boot menu
option will not be displayed thereafter.
A definitive solution involves modify-
ing the boot.ini file. Click on Edit in
the same tab to open the Boot.ini file
in Notepad. Here, change the default
entry to default= c:\, and delete the line
multi(0)disk(0)rdisk(0)partition(2)\WIN-
DOWS="Microsoft Windows XP Professional"

referring to Help but everything seemed
to be in order. | re-installed the software
but the problem persisted. | am able to
play my sound files in all other programs.
Dev

M This error is caused if any or all of
the following files are missing or cor-
rupted: Msvideo.dll, Dciman.dll or
Mciavi.drv—all located in the Windows
System folder. Reinstalling a multime-
dia component from Control Panel >
Add/Remove Programs does not replace
these system files. You will have to run
Windows Setup from within Windows,
as then you are prompted to choose
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/fastdetect. This successfully clears the
boot menu.

Windows XP doesn’t install

2,1 have a Pentium Ill 933 MHz with
Intel 815EEa2 computer. My problem is
that | cannot install Windows XP. When
| restart, it shows an error stating
“error: unmountable_boot_volume”. |
recreated the partition and then for-
matted the hard disk, but still it did not
work. What should | do?

Ryan

40-conductor cable

-

80-conductor cable

Use an 80-conductor cable to connect
UDMA drives, instead the standard
40-conductor cable

A This occurs if your computer uses
an Ultra Direct Memory Access
(UDMA) hard disk controller, and
the following conditions are true: You
use a standard 40-conductor connec-
tor cable to connect the UDMA drive
to the controller, instead of the
required 80-conductor cable, and the
basic input/output system (BIOS) set-

between running a complete set up and
copying all the files again—choose the
‘Copy all files again’ option and your
problem will be fixed.

Another way to do this is to extract
only the files you need from the
Windows CD, wusing System File
Checker (SFC). To start SFC, go to Start >
Run, type ‘sfc’ and press OK. Next, click
on ‘Extract one file from installation
disk’, type the file name ‘Msvideo.dII’ and
press Start. The next screen will show
you where to ‘Restore from’ and the
location to ‘Save file in’—press OK.
Repeat the steps for all the files men-
tioned above.

tings are configured to force the faster
UDMA modes.

Replace the 40-conductor cable with
an 80-conductor UDMA cable. Simulta-
neously, in the BIOS settings for your
computer, load the ‘Fail-Safe’ default
settings and then reactivate the most
frequently used options such as USB
Support.

I lost my Red Hat

| run Windows Me and recently
installed Red Hat Linux 7.2, after which
it showed the LILO boot menu. Next,
| installed Windows XP but the LILO
boot menu disappeared. Now, | have to
use a Linux boot disk just to run Linux.
How do | fix this?

Seejo
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You can repair your LILO boot manager
from within Linux

A There’s no need for concern—
Windows always overwrites other boot
loaders. To fix your system, you have
to boot into Linux using the boot disk
you have. Login as root and go to the
command prompt and type ‘lilo’ and
press [Enter]. You should see some-
thing like ‘DOS added’ or ‘Linux
added’. Now restart your PC, and the
problem will be fixed.

PC to PC

Q. | want to know how to connect my
PC to my friend’s PC, who lives around
2 Km away from my house. We both
have phones and modems, and do
not want to buy any extra hardware.
We both run Windows 98. Can we
do this?

Vishal

A sure you can. Just go to Start >
Programs > Accessories > Communication >
Hyper Terminal on both PCs. Now either
you or your friend can call each other
using your modems, and transfer data
just as if you were on a network.
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Web camera stopped working

2, | have Windows 98 installed on my
machine. The Web camera installed on my
system was working perfectly until recent-
ly—it just doesn’t activate anymore. | tried
re-installing the drivers, but the installation
failed. The camera is not detected when |
plug it in either. | have checked the BIOS,
and found the USB port is enabled. | also
tried installing another camera, but even
that wasn’t detected. Finally, | installed my
camera on another system and found that it
works perfectly. What do | do?

Narender Negi

A Now that you’ve narrowed down the
possibilities, we suspect that the USB port
is the culprit. As you have already
checked it is enabled, the port is probably
malfunctional. To be doubly sure, you
can install a version of Windows with
better USB support, such as Windows XP.
If the problem persists, your USB port is
definitely kaput! You are then left with
two options—either buy new USB ports
with cables that connect to the USB
header on your motherboard (if your
motherboard has such headers), or buy a
USB PCI card for new USB ports to con-
nect your devices to.

Tweaking Windows XP

2, | have an AMD Athlon XP 1700+
with Asus-A7V8X motherboard, 256 MB
DDR 266 RAM and run Windows XP as the
operating system. The problem is that my
machine takes a very long time to boot up.
Santosh Choudhury

A Anytime an operating system is
booting up, it requires time to load
device drivers, start-up programs, etc.
The loading time is further dependent
on devices being initialised by their
drivers. Sometimes a slow device
such as an external modem can
increase boot up time. Windows XP
is a big step forward from previous
versions—it brings along a lot of
excess baggage in terms of services that
start when you boot. To reduce the
boot up time, you can use tweaking
utilities such as bootvis, available at
http://www.microsoft.com/whdc/hwdev/
platform/performance/fastboot/bootvis.
mspx. If you want more information
on how to tweak Windows XP to
improve performance, take a look
at the Tips & Tricks special that
came along with the June 2003 issue
of Digit.

Too many drives

Q. | have a Athlon XP 2000+ processor, 40
GB Seagate hard disk, 128 MB DDR RAM,
ASUS motherboard and run Windows 2000
Professional. | also have a Sony 52X CD-
ROM and an LG 48X CD-Writer. Recently, |
bought a 16X DVD-ROM. The problem is
that my vendor says it’s not possible to
install all three at the same time, reason
being that the PC won’t be able to locate
both, the DVD-ROM as well as CD-ROM at
the same time. Is this true? If yes, what is
the solution?

Dipanshu Banerjee

A pcs are normally limited to four IDE
devices. From the information that you
have provided, you already have a hard
disk, CD-ROM and CD-Writer installed.
This leaves one IDE connector to which
you can connect your DVD-ROM. If you
do not have a free IDE connector, then
you need to buy a combination drive that
accommodates both a CD-Writer and a
DVD-ROM. Use of a splitter in case you do
not have a spare power connector for the
drive. Also, you might run short of drive
bays. Some cabinets have only two bays
for optical drives. If so, you will have to
buy a new cabinet with three bays.
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Toner and Ink
Cartridges

Cartridges are not only the
most important part of a
printer, they are also the
only part that is maintained
and handled by the user. We
tell you how to squeeze the
last drop out of your car-
tridges, and get crisp and
sharp prints that won’t bur-
den your pocket.

&d Laser Printers

Generally, over 50 per
cent of printing problems
related to laser printers are
resolved when the toner car-
tridge is cleaned. So, clean
your toner cartridge regularly.
Never touch the drum sur-
face while handling toner
cartridges since this could
lead to oil spots and scr-
taches which will be evident
on your printouts. Also, the
cartridge should be protect-
ed from sunlight so it’s
always stored it in its origi-
nal box.

At times, in certain HP
printers, the screw in the car-
tridge cover becomes loose
due to vibrations. This screw
needs to be checked and
tightened, if you see a hori-
zontal white line in the cen-
tre of a printed page.

Another common prob-
lem is the black dots that
appear on printouts. This is
usually because of a nick on
the drum, caused by a for-
eign object. If this has hap-
pened, there’s no way you
can get the cartridge
repaired—you’ll have to
replace it. So make sure you
are using dust-free paper.
Also, keep the printer clea—

m tips and tricks

clean the outer surface regu-
larly. Use a damp cloth to
clean the accumulated debris
and dust, whenever you are
changing a cartridge. Pay
special attention to the rub-
ber rollers—never use alco-
holic cleaners on these.

&d Inkjet Printers

If you are installing a
new cartridge in your inkjet
printer, keep it in the upright
position for a few moments
before fitting it in. This
ensures that the ink will be
at the nozzle when you are
ready to use the printer. Also,
store the cartridge in an
upright position, in an air-
tight, rigid plastic container.
Whenever you feel tha your
prints aren’t as crisp as they
should be, run the printer’s
head-cleaning utility. This is
necessary especially if you
are using your printer after a
long time.

Using the Right Paper
The regular paper that |,
you use for printing

Ed Greeting cards

These papers are thicker, pre-
folded, and smaller than reg-
ular paper. They come with
matching envelopes. Printers
typically come with bundled
software, with several tem-
plates, for creating greeting
cards. Use this paper to cre-
ate personalised greeting
cards that have a profes-
sional look.

&d Glossy paper

Glossy paper has a shiny,
coated surface on one or
both sides. This produces
vibrant colours, but the prints
are

does fine for day-to-
day print jobs. However,

at times, you may want to
print on special types of
paper. Different types of
paper are available for differ-
ent printing needs.

&d Photo Paper

This is similar to the paper
used by film developers, and
is designed to produce high-
quality images. They come
in both, matte and glossy
finish, and in standard
photo sizes such as 4 X 6
inches. Use photo paper for
studio quality photos.

susceptible to fingerprints.
Use glossy paper for
brochures, flyers and report
covers.

&d Transparencies

These are clear plastic sheets,
and are used to create over-
head-projector presentations.
These can only be used with
inkjet printers, as transparen-
cies cannot tolerate the heat
generated by laser printers.

Ed craft papers
Craft papers come in a huge

variety. For example, iron-on
paper allows you to print and
image and transfer it to a
cloth. Banner papers, used to
create banners, also come in
this category. Other papers in
this category are Vellum,
parchment, printable fabric
sheets, shrink-wrap plastic
and so on.

&d stickers and labels
Stickers and labels are avail-
able for mail, folders,
diskettes, CDs and whatever
else you can think of. You
can use fonts, images and
colours to customise them.
Re-stickables allow for a lot
of creative flexibility.

Remember to check your
printer manual for compati-
bility, before using specialty
papers. Otherwise, you may
experience paper jams and
such.

Maintenance
&d Clear paper jams
Carelessness while clearing

P : a paper jam could lead to
A My pnc e —\ accumulation of toner

dust, which could be haz-

ardous to the health of
your printer. If the paper
jams before it reaches the
Fuser roller—the roller that
fuses the toner with the
paper—the toner will just lie
on the page, in the shape of
the image being printed.
Caution is necessary here, so
that the toner doesn’t fall
into the printer while you're
pulling out the paper. If it
has not yet begun to come
out of the printer, pull the
paper towards the inside of
the printer. If the paper had
just begun to feed, and you

O
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pulled it back through the
Feed rollers—the rollers that
feed the paper in the print-
er—the toner on the paper
could fall onto the rollers.
This could cause following
copies to come out dirty.

&d Avoiding paper jams
The thumb-rule is not to
overload the printer. Too
many papers can lead to
pressure on the paper sepa-
ration tabs, and result in
double feeds. Special care is
needed to feed specialty
papers such as photo paper.
Since these are thicker, the
best thing to do is to feed
them manually, one by one.
Also, do not use transparen-
cies, or other media that can-
not tolerate high levels of
heat. Cleaning your printer,
especially the roller, plays an
important part in avoiding
jams. This is because dirty
rollers hamper the move-
ment of paper inside the
printer.

&d static electricity
The laser printers that are
most affected by static elec-
tricity are those based on the
Corona Wire technology.
Static electricity increas-
es because of two things—
wind or movement, and dry
air. In winter, the problem is
compounded by low humid-
ity, and dry heat in offices
and homes. You may notice
random black streaks, or
blotches of toner on your
pages because of this. To
remedy this, the humidity
level in the room should be
at least 35 per cent. Further,
you can decrease the static

is needed to clean them.
Most vertical streaking
caused by a dirty Corona
wire will be hazy or uneven,
and intermittent. The wire is
found in a metal furrow that
runs the width of the paper,
along the bottom. It may be
covered with angled wire.
The wire is very thin, like a
strand of hair, and care
should be taken not to
break it while clean-
ing. First, the fur-

- row should be
cleaned with

a  vacuum

- cleaner, and
4 then with a
} cotton swab

dampened
with water or
peroxide. After
all the toner is
removed from the
floor and walls of the trough,
gently brush the length of
the corona wire with a dry
cotton swab to remove any
dust or debris.

Many toner cartridges
have a charge wire inside
them. Removing dust from
this will prevent most verti-
cal streaking.

electricity around the printer
using a solution comprising
one tablespoon of liquid fab-
ric softener and about 300
ml of water—spray this on
the carpet around the print-
er. Do not spray it directly
onto the printer.

&d AB switches

Be careful when using man-

ual AB switches for

printer sharing. e
In most
cases,
t he
ven -

dor’s warranty becomes void
if you use them. A better
option would be to use elec-
tronic switches.

&d Ozone filters

One more component that
needs to be taken care of is
the ozone filter. A clogged
ozone filter can harm your
printer by increasing its tem-
perature, and by blocking
the airflow—thus slowing
down the fan. A fan that’s
slow causes harm to printer
components, and the ozone
produced oxidizes them.
Change the ozone filter once
in 6 months.

Inkjet Printers

&d Cleaning the head

The head cleaning utility,
that comes with almost all
printers, does not always do
an efficient job. Often, ink
deposits build up on the end
of the print head, causing
the cartridge to function sub-
optimally. It’s better to clean
the head manually, to ensure
proper functioning and
crisper prints. Clean the

&d corona wire

Some of the older laser print-
ers, such as the HP Laserjet Il
and Ill, are based on corona
wire technology. Special care

head by wiping it gently
with a soft cotton cloth—
don’t use tissues since they
tend to stick onto the head.
Snap the cartridge in and out
a couple times, to get a good
connection after cleaning.

&d General Cleaning

If the printer is printing in
streaks, and is smearing,
there’s excess ink in the car-
riage area. Open the printer
and remove the cartridges.
Fold a letter-sized piece of
paper in half, and then in
half again the other way, so
that it is quartered. Insert
this paper into the regular
feed slot or space. Move the
paper to the left and to the
right, to remove excess ink
under the carriage. Once the
excess ink is removed, the
printer should resume print-
ing normally.

Apart from this, do call
your technician at least once
a year to get your printer
cleaned thoroughly. There
are parts that are impossible
to get at without disassem-
bling the machine. These
need to be attended to by a
professional.

Printing Images

There are a few general rules
that can be followed to print
high quality photographs.
The first rule is to use spe-
cially designed photo papers.
Several well-known brands
such as HP, Kodak and oth-
ers have their own brand of
photo papers. The second
rule is to use a photo car-
tridge. Your inkjet printer
will have to support this,
however. The third rule is to
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choose the correct settings in
the ‘Print’ dialog box. For
this, click ‘Printer proper-
ties’, and set the print quali-
ty to the highest possible
value. Also choose ‘photo
paper,” if you are using one,
as the paper type; use high
resolution.

&d customising images
First off, the photo that you
want to print should have a
resolution of at least 300 dpi,
otherwise the prints won’t be
good enough. If you’re scan-
ning a photo to print, scan it
at 300 dpi. Use a format such
as TIFF that preserves the
colours and sharpness, if you
intend to print the image.
You should therefore also
save your digital camera
images in the TIFF format,
if there’s an option to do so.
Also, don’t enlarge the
image using an image-edit-
ing software. This is because
an image of 1280 x 960 pix-
els at 72 dpi, has the same
amount of details, asa 4 x 3-
inch image at 300 dpi. How-
ever, this also means that
you can safely use a 1280 x
960 pixel image to print a 4
by 3-inch photo.

You might notice that
the printed image doesn’t
look exactly like the one on
the screen—this is simply
because the images on the
screen are in the RGB (red,
green and blu) format, and
the printer uses CMYK inks
(cyan, magenta, yellow and
black). There are colours that
can be rendered in RGB, but
not in CMYK. To avoid this
problem, convert your image
to the CMYK mode, using

m tips and tricks

image editing software such
as Adobe Photoshop, or
PaintShop Pro.

Also use a photo editing
software to edit your image,
to correct the red eye, dust
and specks problems. You
can use sharpening filters to
improve photo edges.

Ed Print settings and
paper

Next comes the printer. The
printer should be able to
print at ety

least )

600 =

X 600 dpl The higher the
dpi, the better will be the
quality of the printed
images. You also need to
keep your printer drivers
updated.

The next step now, is to
adjust the print settings. Set
the print-quality to maxi-
mum, and choose the right
paper setting, as it controls
the amount of ink that gets
onto the paper. It's better to
use the same brand of paper
as your printer’s as a compa-
ny usually customises its
paper for its printers.

After printing, you need
to allow the printout to dry.

Normally, the drying time is
one hour. If the photo will be
in close contact with some-
thing else—for example, if
you're going to frame it—it’s
better to let it dry for 24
hours. If you are printing
multiple copies, remove each
copy from the printer as
soon as it is printed.

&d Printing black and
white photos
The best way to print black
and white photos is to print
them using the colour car-
tridge. Yes, you read right!
The black cartridge is
designed to print black text,
and cannot produce shades
of grey as efficiently as a
colour cartridge can. Use an
image-editing software for
good quality results. Open
the photograph in your
favourite image editing
tool, and convert the
photo to greyscale.
Now, print the photo-
graph with ‘Automat-
ic’ colour settings, the
highest print quality and the
correct paper type. You'll get
a fine photo.

Power Tips

&d Printing marked
selection

When printing selected text
say on a Web page, select the
text, and go to File > Print. If
you're using Internet Explor-
er 5 or higher, choose to
print ‘Selection’ in the dialog
box that pops up. Most of
the newer browsers have the
Print Preview in the File
menu. This feature can be
very useful if you want to
print only selected pages.

P e T ST
Py

Use the Print dialog box in
Internet Explorer to choose
what you want to print

Decide upon the pages that
you want to print in the
Print Preview dialog box,
and then click ‘Print...". Now
in the Print dialog box, enter
the page numbers and click
OK. This procedure is
practically the same for
most browsers, including
Netscape.

&d Printing large
documents

Sometimes, you might want
to print a large document
that is laid out in many
pages—one being the index
page, and all the chapters
linked to it. Internet Explor-
er has an easy solution for
this problem. Just print the
index page, and in the Print
dialog box, tick the ‘Print all
linked documents’ option.

&d Printing with back-
ground

By default, the background
of the page—that may
include images—is not
printed. To print background
images and colours in Inter-
net Explorer, go to Tools >
‘Internet Options...”. Click on
the Advanced tab, and scroll
down to Printing. Here, tick
the box that says ‘Print back-

O
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ground color and images’,
and click OK. Now, you will
be able to print a Web page
with its background images
and colours.

If you use Netscape, go
to File > Page Setup. Under
‘Format & Options’, you will
see a check box labelled
‘Print Background (colors
& images)’. Tick this, and
click OK. Now go to File >
Print and click Print.

Fun with your printer
&d Creating monthly
calendars

Most word processing
applications come with
specific methods to create
calendars. In MS Word, you
can find it by going to Insert
> ‘Object...”, and then choos-
ing ‘Calendar Control.” But
this might not provide the
level of customisation that
you want in order to mark
certain important occasions,
like your anniversary. An
easy solution is available at
http://www.timeanddate.com/ca
lendar/. This Web site has cal-
endars customised for many
countries, which you could
use as your template. Copy
the calendar pertaining to
the months you wish to

= [T
i -

You can print the Outlook
calendar with all notes
and meetings reminders

print, into your word pro-

cessing or image-editing pro-

gram, customise it and

then print them.
Another

way is

to use specialised software

such as Calendar 200X,
which can be downloaded
from www.graffman.net. You
can also use Outlook to print
a calendar. Just switch to cal-
endar, and go to File >
‘Print...". You will be present-
ed with a dialog box, asking
you to choose the printing
style. You can print weekly
or monthly views of your
calendar, with your appoint-
ments marked out.

&d Creating a person-
alised mouse-pad

You can create a personalised
mouse pad, using a 3mm
thick foam sheet, double-
sided adhesive sheets, inkjet
coated-satin finish fabric,
coated paper, glossy-finish
acrylic spray, and a pair of
scissors. First, choose a
design that you can print on
coated inkjet paper. If you
are satisfied with the results,
take a final printout on the
satin-finish fabric. Allow the
ink to dry completely. Then,

spray it with acrylic, and
leave it to dry again. Peel
away the covering from
one side of the adhe-
sive, and apply it to
the flipside of the
fabric. Cut out
the design,
Gl | ol
remove the
other cov-
ering of
the adhe-
sive. Now,
paste it on
the foam
sheet. Cut out
the foam sheet
in the shape of
the design, and your mouse
pad is ready!

Ed card modelling

Card modelling is the art of
creating a scaled model with
card paper. This is somewhat
similar to Origami—the craft
of folding paper. You can use
your printer to print ready-
made Kits, available on some
Web sites, or create them
yourself from scratch. Here
are a few Web sites that
will help you get started:
www.fiddlersgreen.net,  www.
digitalnavy.com, www.paperpar-
adise.com and www.cardfaq.
org/fag. All you need in order
to create these paper models
is a computer, printer, scis-
sors, glue and good quality
printing paper.

&d Computerless printing
Thus far, you’'ve needed a
computer to act as an inter-
face between your digital
camera and your printer.
Now, with newer cameras
and printers, you can print

photographs from digital
cameras without a PC! Some
of the latest printers provide
you with a special slot for the
memory card of your digital
camera. You can download
your pictures to the printer,
preview them on the print-
er's LCD, choose the ones
that you want printed, make
adjustments, and then print
them. HP has come up with
its Photosmart series of
cameras and printers, which
provide you with this
functionality.

Some printers do not
require a memory card to be
inserted; the camera is direct-
ly attached to the printer via
a cable. Canon’s Powershot
series is one such example.
You can customise photo-
graphs by using the camera
controls and the LCD, and
print directly to the printer.

&d page setup
Most of the printing software
provide you with a ‘Page
Setup’ feature. This lets you
determine how your page is
going to print. The first
thing that you can set is mar-
gin. The margin is the dis-
tance of the printed material
from the edge of the paper.
If you were printing formal
documents, you would
prefer larger margins—espe-
cially the left margin. Other-
wise, you can opt for smaller
margins. Remember that you
cannot set the margins to be
zero—most applications are
smart enough to warn you if
you try to do so.

The next customisable
thing is the gutter. The gutter
identifies a blank space on
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the paper that will be
trimmed off or bound into
the bind of a book. Set this
option only if you plan to
bind the pages. You can set it
to be on the top or on the
left of the page.

You can also choose the
Page Orientation. It can be
Landscape or Portrait. In
Landscape prints, the width
is more than the height. For
Portrait prints, the height
exceeds the width.

Troubleshooting
Inkjet Printers
If horizontal or vertical lines
appear on your printouts,
the first step would be to run
the print head cleaning util-
ity three or four times. In
most cases, this solves the
problem. Check the paper if
the printouts appear faint.
The paper should not be
damaged, old, or loaded
incorrectly. If you use spe-
ciality paper such as photo
paper, make sure you're
printing on the correct side.
Also, check the printer’s
manual for information
regarding the compatibility
of the paper with the printer.
To unblock a cartridge’s
print head, place the print
head in a shallow bowl of
hot water for 20 to 30 min-
utes. This will soften the
dried ink so that it flows
through the print head. You
should see the ink bleed out.
Repeat if necessary. Next,
insert the cartridge into the
printer, and run the print
head cleaning utility. If soak-
ing the cartridge in water
hasn’t cleaned and dissolved
the dried ink, place the print

m tips and tricks

head part of the cartridge in
a shallow bowl containing a
mixture of very hot water
and bleach (or ammonia) in
equal amounts—just enough
to cover the print head, for
two or three minutes. This
should hydrate the dried ink,
causing it to flow through
the print head, and the ink
should bleed out. Repeat if
needed. Now, insert the car-
tridge into the printer, and
run the printer’s print head
cleaning utility.

Laser Printers
Streaks appear on
printouts when the
drum cleaning blades
make improper con-
tact with the drum
surface. These
blades are made of
rubber, and so
require replace-
ment. If the streaks look like
thin pencil lines, the drum
itself has scratches, and must
be replaced. Try cleaning the
drum with alcohol. Wipe
it gently with a soft tissue.
If this doesn’t work, you
have to change the drum.
Do check the Fuser unit,
where the toner is fused with
paper. Be careful, as this
may be very hot. You will
need to clean the upper heat
roller, which is usually black
in colour.

Sometimes, a brand new
cartridge may not work prop-
erly. A reason for this could be
that there is no pool of ink at
the exit port (the pre-cham-
ber) that the built-in print
head can suck from. Some of
the sponge-filled cartridges
can develop air pockets at the

bottom of the cartridge that
can block the flow of ink.
Wrap the cartridge in a towel
or cloth, and place it in a plas-
tic bag. Hold it in your hand,
with the head or exit ports
pointing down. Extend your
arm, and swing the cartridge
down towards the floor rap-

idly, as if you
'\1 would if you
= = were

throw it. Repeat this a couple
of times. Then, remove the
cloth wrapping. There should
be a visible spot of ink from
each chamber. Repeat if there
isn’t. Now, place the cartridge
back in the printer.

Network Printing

&d Installing Network
Printers

In order to access a shared
printer on a network, you
need to install it first. You
can install any number of
printers on your machine.
You’ll need to first locate the
computer that has put the
printer up for sharing, using
Network Neighbourhood.
Right-click on the printer
icon within that computer
and click Install. Alternative-
ly, double-click the printer

icon—this will bring up the
Add Printer Wizard. Follow
the on-screen instructions to
install the network printer.

kd Sharing a local printer

If you want to share the
printer that’s connected to
your computer, go to Control
Panel > Printers. Right-click on
the printer icon, and click
Sharing. Here, select ‘Share
As,” and type in the name of
the printer in the Share
Name field. Click OK.

Ed controlling net-
work printing
If your computer
has Windows 98 and
the print server is
running Windows NT
or 2000, you don't
have much control
over the printing
process. One solution to
this would be to install a
Remote Procedure Call Print
Provider (RPCPP). To install
RPCCEP, insert your Windows
98 installation CD into your
CD-ROM drive, go to Start >
Settings > Control Panel and
double-click Network. From
the configuration tab, select
Add. In the ‘Select Network
Component Type’ dialog
box, choose Service and then
click Add. Then click Have
Disk. In the ‘Copy Manufac-
turer’s File From’ box, type in
‘E:\tools\reskit\netadmin\rpcpp
" (where E is the drive letter
of your CD-ROM). Then
click OK. Click OK again
after the installation, and
reboot your machine.
After you’'ve done this,
you’ll be able to choose the
remote printer to send your
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job to, as well as being able
to see the print queue. You
can also cancel any print
jobs by going to Start > Set-
tings > Printers.

&d Installing additional
drivers

If you’re sharing your print-
er, you’ll want users running
any version of Windows to
be able to use it. If you're
running Windows 2000 or
XP, it is advisable to install
additional drivers, so that
others don’t have to look for
drivers before using your
printer. To do this, go to Start
> Control Panel > Printers.
Right-click the printer icon
and choose Properties. In
the Sharing tab, click the
'‘Additional Drivers..." but-
ton. Follow the on-screen
instructions to install the
drivers. Now all users will be
able to install the drivers by
just double-clicking the
printer name.

&d Disabling printer
announcements

If you are sharing a printer
on a Windows 2000/NT
machine, it will announce
to the other print servers on
the network that it has a
printer available, every 10
minutes. These announce-
ments can cause excessive
network traffic. To disable
them, go to Start > Run and
type in ‘regedit’ to open up
the registry editor. Navigate
to HKEY_LOCAL MACHINE\
SYSTEM\CurrentControlSet\Con
trol\Print, and add a new
value with the name as
DisableServerThread, and
the type as ‘REG_DWORD'.

Enter a value of 1. This
disables the announce-
ments, but also means
that the printer will not be
visible when one is brows-
ing the network. It can
still be accessed by entering
the name in manually.
To turn the announcements
back on, change the value
in the registry back to 0.

Instead of disabling the
announcements altogether,
you can change the time
interval between announce-
ments. Simply add a new key
named ServerThreadTimeout
at the same location as
above. Enter the value for
this key in milliseconds. For
example, if you want to
extend the interval to one
hour, enter the value
3600000’.

Ed Restricting printer
times

You can set a schedule for
when a printer will be avail-
able for use. In Windows
2000 and XP, go to Start >
Control Panel > Printers, right-
click on the printer, and
choose Properties. On the
Advanced tab, there are two

e =

S ——
Bt e B P
el
T g =
s
L

— grma=n o

= Al ...

You can restrict the times when
a printer will handle jobs

choices near the top: ‘Always
available’ and ‘Available
From...’, where you can set
the time during which print
jobs can be printed. Users
can still submit jobs any
time they want, but the jobs
will not be printed except
during the times set for the
printer as available.

&d Command Line Control
You can use the Net Print
command to control what
print jobs are currently
running on a computer.
The syntax for the Net Print
command is NET PRINT
\\computername\sharename
[N\\computername]job_id[/
HOLD|/RELEASE| /DELETE].

Here the vertical bars
mean ‘or’, job_id is the iden-
tification number of the job
and the optional fields are in
square brackets. If you type
in just the command with-
out any options, it will dis-
play the current print jobs. If
you don’t remember the
share name of the printer,
type in ‘NET VIEW \\computer-
name’ to list all the shared
resources.

Miscellaneous Tips

&d Printing shortcuts

You don’t have to launch
an application and then
go to File > Print in order to
print a file. Go to Start > Set-
tings > Printers. Select the
printer of your choice.
Right-click the selected
printer, and select ‘Create
Shortcut’. Windows will tell
you that it can’t create the
shortcut here, and will ask
you if you want it on your
desktop. Click Yes. Then,

whenever you want to print
in a hurry, just highlight
the file you want to print,
and drag it onto the printer
shortcut on your desktop.

You can also add a short-
cut to the Send To menu of
the Explorer for immediate
printing. To do this, open
C:\Windows\SendTo, and cre-
ate a shortcut there for
your printer. Next time you
want to print a file, simply
right-click the file in the
explorer window, and
choose your printer from
the Send To menu.

&d Economic printing

To save toner or ink, it’s a
good idea to keep your
default print settings to
Draft, or EconoMode—espe-
cially when you don’t always
need high quality prints. To
do this, go to Control Panel >
Printers, and choose the print-
er properties by right-click-
ing the printer icon. You can
later change the settings
temporarily through the
Print dialog of the applica-
tion that you are printing
from, as and when you need
high quality prints.

Further, save paper by
printing on both sides of the
page. If your printer doesn’t
support two-sided printing,
feed the paper manually, and
flip it over to print on the
other side. You can also use
software such as FinePrint
(www.fineprint.com) for dou-
ble-sided prints. Do remem-
ber to set the page margins
to the minimum value s
upported. This will allow
more matter to be printed on
fewer pages.
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&d Two printers

Generally, black text print-
outs are taken in economy
mode, while images are
printed using the best quality
mode. This requires you to
change the printer options, to
suit the print job at hand.
Avoid this by installing
another copy of the printer,
but with a different name. Do
this by going to Control Panel >
Printers, and clicking Add New
Printer. Now, use different
default print settings for these
two printers. You can choose
either of them, to suit your
printing needs.

&d speed printing
Windows normally spools
print jobs before sending
them to the printer. Spooling
involves writing the data to
be printed, to a temporary
file. This allows you to work
while the printing in
progress. However, this slows
down the printing process.
On most printers, you can
turn off the spooler by going
to Start > Settings > Printers.
Right-click on the printer
icon, select Properties, and
then click Details. Click
‘Spool Settings’ at the bot-
tom of the dialog box. Select
the ‘Print Directly to Printer’
option. This will tie up your
application until the printer
has all the data, but your
print job will be done faster.
This option is handy if your
print spooler crashes, and
you need to print before you
reboot your PC.

&d Print-related software
The standard print dialogue
box doesn’t provide all the

m tips and tricks

flexibility and customisa-
tion that you would like to
have. There are various soft-
ware that let you do them.
One such software s
FinePrint (www.fineprint.com).
FinePrint is a Windows
printer driver that provides
you with advanced printing
capabilities. It has some
very useful features, such as
the ability to add blank
pages, and delete pages.
The ‘Ink Saver’ provides
options to convert coloured
text to black, and to skip
graphics. You can print
multiple pages on a single
sheet of paper, add water-
marks, headers and footers,
and you can even insert
customised letterheads. It
also allows you to design
your printouts as an image,
and also to retain the
text format maintained in
the Web page that you’re
printing from.

Another useful software
is Directory Printer (www.gal-
cott.com). With this, you can
print the directory structure
of your hard drive. It can
print all the folder names and
file names. It can also export
the structure to a text file.

PaperlessPrinter  (www.
rarefind.com) allows you to
convert printable documents
to HTML, JPEG and BMP for-
mats. You can use it to pub-
lish documents in HTML,
JPEG or BMP, preserving their
look and content—complete
with fonts and graphics. You
can distribute your HTML
documents by e-mail, or
store them on the Web, an
intranet, a file system, or
on a CD.

&d Stuck Print Jobs
Sometimes a print job gets
stuck in the print queue.
Viewing the queue shows
that the job is being deleted,
but it never is actually delet-
ed, and other jobs don’t
move forward. To resolve
this, you don’t have to
restart the print server, but
only the print spooler. To do
so, if you are using Windows
2000 or XP, open up the DOS
prompt, and type in the
command ‘net stop spooler’.
Wait until the service stops,
and then type in ‘net start
spooler’. You can also do this
by going to Start > Settings >
Control Panel > Administrative
Tools > Services, highlighting
the Spooler service, right-
clicking it and choosing
Restart. Now you should be
able to delete a stuck print
job, if it is not deleted auto-
matically.

&d Cleaning up old
printer files

By default, any print jobs
sent to a printer will be tem-
porarily spooled to a folder
on the hard drive. Usually,
these files are deleted when
the job has printed. Some-
times, these temporary files
don’t get deleted. If you're
not expecting anything to be
printed, you may safely
delete any files in that folder.
The default folder location is
%systemroot%\system32\spool\
printers, where %systemroot% is
usually either ‘C:\windows’
or ‘C:\winnt.’

If you want to change the
location of this folder—
because you want to free up
space on your drive, or for

any other reason—go to Start
> Settings > Control Panel, and
click Printers. Now go to File
> Server Properties. Under the
Advanced tab, you’ll see a
field that says ‘Spool Folder.’
Here you can type in the
new location path of the
spool folder.

&d Printer pooling

If you are using Windows
2000 or XP, and using sever-
al identical printers, you
can create a pool of the
printers, that will enable
Windows to balance the
print jobs. To do this, con-
nect all the printers to your

Create a pool if you have
multiple, similar printers

machine on different ports.
Install the drivers for one
printer. Now go to Start > Set-
tings > Control Panel, and dou-
ble-click Printers. Right-click
the printer name and click
Properties. Under the Ports
tab, tick ‘Enable printer pool-
ing.” Now tick all the ports to
which your printers are con-
nected. Click OK. Windows
will automatically handle
the allocation of print jobs
across the printers.

O
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Warcraft lll: The Frozen Throne
The iceman cometh...

he Frozen Throne—the successor to

I the best selling Warcraft I11: Reign of

Chaos took a year to make, but is

well worth the wait. This game is an inte-
gral part of the Warcraft experience.

The expansion pack attempts to com-
plete the stories of two characters—Illidan
and Arthras. The campaign starts off with
the Night EIf sentinels, moves on to the
Blood Elves of the human alliance, and
then wraps up with the undead scourge.

Control the Beastmaster (the new
hero for the Horde), and a small force of
Orcs, as you complete various quests
across one of 35 missions. The enemies on
the map re-spawn frequently, and make
the campaign tedious.

Battles look great in the game's 3D engine

The standard base building missions
are almost absent; Instead, you have
extremely limited resources and troops to
fulfil your objective. At many stages, you
will have to control multiple bases instead

of one. The campaign packs in a lot of sur-
prises and unique twists. The enemy Al
has also been improved.

There are three new types of in-game
terrains. New units balance the races from
particular strategies. The game also
includes simplistic naval combat.

Multiplayer gaming has always been a
strong point in Blizzard games. The game is
fully supported by Battle.net. The game has
aseparate section on the network but Frozen
Throne players can join regular games.

The game is polished and relatively
bug-free. It also provides great replay
value, due to the difficulty settings and
custom games.

(Courtesy Skoar)

Genre: Real Time Strategy = Developer: Blizzard Interactive = Publisher: Blizzard Interactive = Distributor: World Wide CD Roms =
System Requirements: 400 MHz CPU, 256 MB RAM, additional 550 MB disk space, 8 MB 3D video card, DirectX 8.1 = Price: Rs 999

Web site: www.blizzard.com

Rating: [T

his book gives you an insight into the

working of the hacking community.
Stealing the Network: How to own the Box has
ten chapters, each written by a different
author. Each chapter combin es fiction
with real technology, and highlights a dif-
ferent aspect of network security. All chap-
ters start with a story that justifies the rea-
son for the hack, and then dives into tech-
nical jargon which explains the tools and
method used to commit the hack. The
book is written solely for those with a thor-
ough understanding of networking.

It throws all sorts of advanced net-
working terms and concepts at you, such

as ICMP, Class A, etc., without
offering any introductions or
explanations. For those who have
an understanding of networking,
this book is a real eye opener.
There is a chapter that explains
how a hacker can use a networked
printer to commit malicious acts—
hackers can store data in the print-
ers memory and even run a Web
server off it.

The book also reveals how ignorant
and careless we are about network securi-
ty; Chapter seven describes how a hacker
visits a software expo with a stack of CDs,

o Stealing the Network: How to own the Box
For the hacker inside you

labelled ‘Customer list’, ‘Sales
Data’, etc, and casually leaves
these CDs in different vendor
booths. Out of sheer curiosity,
vendors pop them into their
CD drives, unknowingly releas-
ing the hacker’s Trojans into
their PCs. The book goes a step
further, describing how to make a fake
gelatin finger with someone else's finger-
print to fool a biometric security system.
This book is highly recommended
to those with basic network knowledge,
and a desire to learn about network
security flaws.

Publisher: Shroff Publishers and Distributors Pvt. Ltd. = Author: R Russell, T Mullen, FX, D Kaminsky, J Grand, K Pfeil, | Durbrawsky, M Burnett,
P Craig = Distributor: Computer Bookshop (India) Pvt Ltd = Phone: 022-22317922 = Fax: 022-22623551 = E-mail: orders@cb-india.com

Web site: www.cb-india.com = Price: Rs 300

Rating: [ O

[F 145

SEPTEMBER 2003



arcade = .
m reviews

W C++ for You++
Enchiridion of C++ Programming

here are way too many books that
I offer an introduction to C++ pro-
gramming. What sets C++

for You++ apart is that it doesn’t
give long essays describing simple
concepts, or bamboozle you with
advanced explanations. In this
dichotomous book, the first section
contains the explanation of C++
programming, and the second
explains implementation details,
such as classes and data structures.
The book starts off with an intro-
duction to computers in general,
touching upon both hardware and
software briefly. The second chapter
introduces a C++ program contain-
ing all the basic elements such as Pre-
processor, loops, library functions, etc.
This lets you to get a feel of C++ right from

the beginning.
From here, all
the concepts
are explained
in detail, in
separate chap-
ters. There is
an exercise
with  answers
provided at the
end of each
chapter.

The second
section  starts
with a chapters
on linked list,
stacks, queues, etc and
moves in that direction. Towards

the end the authors deal with algorithms,
starting with the analysis of algorithms

and finishing off with chapters on search-
ing, hashing and sorting. A sore point of
the book is the numbering of the pages.
Each page is numbered as XXX-DD, where
XXX is the abbreviation of the chapter
name and DD gives the page number
within that chapter—making it difficult
to reach to a specific page directly.

The book is definitely not recom-
mended for those who are already fluent
in C and want to learn C++. Concepts
such as Object oriented programming
and related concepts are treated very
lightly in the Chapter 22. Also, the book
places more emphasis on practical imple-
mentation rather than the theoretical
aspects of programming. The book is
aimed at those who want to start off by
learning C++, and the book serves this
purpose pretty well.

Rating: I B10]

Publisher: Vikas Publishing House Pvt Ltd = Author: Maria Litvin, Gary Litvin = Distributor: Vikas Publishing House Pvt Ltd
Phone: 91-11-24314605 = Fax: 91-11-24310879 = E-mail: orders@gobookshopping.com = Price: Rs 295

Developed by Westwood studios, Gen-
erals is a massive effort to resurrect
the dying Command & Conquer series.
The game is easily the best one in this par-
ticular series.

Units have been modelled neatly, and
their motion is fluid. From minute touch-
es, such as track marks, to intricate explo-
sions, the effects are simply marvelous. All
the units have a distinct voice-over, and a
unique weapon attack effect.

All the factions have different units
that use a totally different strategy and
attacking style. Use a set of small strikes
targeted at specific units and structures.

A new feature is the very obvious Gen-

Command & Conquer Generals
Stop clickin® around, general!

Amazing explosion effects are quite
common in this game

erals system, which can be used to

upgrade units, buildings and strategies.
The campaign missions are loosely

based on the erratic story. This results in a

progressively challenging game with spe-
cific objectives.

Generals uses the left mouse button
for all commands, unlike other strategy
games, which use both left and right
mouse buttons—this takes some getting
used to. However, unlike previous ver-
sions, this one has the control interface on
a bottom bar. Also, a change in the battle
dynamics has been introduced by includ-
ing the ‘Fog Of War’, to hide areas where
your units are not stationed.

The game has sparkling 3D visuals,
and the sound effects are a real treat. To
sum up, Generals is a great game to play
that offers immense replay value.

Rating: (M O

Genre: RTS = Developer: Westwood Studios = Publisher: EA Games = Distributor: Gayatri Impex = System requirements: 800 MHz CPU, 128 MB RAM,
1.8 GB hard disk space, 32 MB GeForce2 video card, DirectX 8.1 = Price: Rs1,499 = Phone: 022-23870260 = Fax: 022-23863367
E-mail: sales@gamemasti.com = Web site: www.gayatrimmpex.com
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A photographer,
a party and Singapore

pered with the search for the perfect RAM. It’s been 10
months since the first batch of Media One students
enrolled, and it’s already graduation time. Sigh, they grow so fast!
And since any reason is a reason to party, we had a fully-fledged
graduation ceremony with guest speakers, and all, i.e. free food!
Armed with the T of technology and the M of media, Media
One students foray into their new lives, while some stay with us
are employees in our various departments.

N ever a dull month, this one’s been rollercoaster ride, pep-

License to shoot

Speaking of professionals, we had an interesting guest this
month—Sherwin Crasto, the senior news photographer from of
Reuters, who came to tell us a thing or two about digicams for
our cover story. So he did, and how!

But like all good stories, let’s start at the beginning. With a
field as interesting as photography, and a technology as advanced
as the one used for digital cameras, we needed the tests to be
exhaustive and authoritative. And who could be more of an
authority on digicams then the guys who tested 31 of them—
someone who shoots using them exclusively, of course! So we
dialled a few numbers and Jiten Gandhi, our in-house photog-
rapher-cum handy man, cum ‘knower-of-all-important-people-
who-hangout-in-Mumbai’s-press-club’ came to our rescue.
Within a few calls he assured us that Sherwin would come down
to the Nerul office, to share his wisdom with us. And we waited.
And we called. And we waited, but Sherwin the Merlin, was
always on some assignment or another. Aliasgar, the test-centre
co-ordinator who was supposed to oversee the digicam test began
to sprout ulcers. He would look at Jiten bhai for reassurance. So
Jiten bhai pinned down a time, and fixed an appointment.

Sherwin is a soft-spoken man (except while driving),

The Media One team with their mentors
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who drives faster than he can click, and enchanted us with
tales of danger, and the adventures he has on the job. So much
so that Aliasgar was all but out the door to get a camera, and
change his career.

In search of the perfect RAM

Singapore, the multi-cultural island is a haven for geeks with its
cheap computer components, the latest gadgets and Simlin Square.
It was also the place where Microsoft held its workshop for Office
2003. Mitul, from the Test Centre was put on the job of going to
Singapore to evaluate the gadget scene there, note all the latest
goodies, buy the most RAM he could fit into his luggage, and if he
still had the time, to attend the workshop.

Even the best laid (travel) plans go awry. As excited as Mitul
was to be one of the four people invited
from India, and ECNR stood between him
and Singapore. So Mitul ran around for
three days to make it to the airport on the
evening of the 6th (his plane was to leave
at 12 am), only to find that the flight had
been delayed. Finally in Singapore, Mitul
faced another crisis, that of vegetarian food.
While the other journalists feasted to exot-
ic oriental cuisine that more often than not
included pieces of indistinguishable meat,
Mitul and fellow veggies tried hard to push
boiled vegetables devoid of any salt of pep-
per, down their gullet. Finally the chef
whipped up some plain pasta with veggies,
much to their relief.

This conquered, Mitul extended his stay
by a few days to shop for all the peripher-
als and components that he dare not come
home without!
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A My PC is packed,
I’'m ready to go...
Submitted by
Sreyans Bardia
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Now that’s thoughtful! 4\

Submitted by
Arindam Das

Mera hardisk tumhare paas hai
Screensaver sajake Rakhna
Password Apna Apna

Hum aapke memory mein rahate hain
Programmer no 1
Mouse ka gulam

Java wale job le jayenge

If Hindi-film names were IT-inspired...

Submitted by
Sandeep Achar

Computer Cupids

Tumse mila main kal toh,

use it for this too

Submitted by
Deepesh Aggarwal

Virgo

August 23 - September 23

Are you sick and tired of being average? Do
people say you lack quality? Are you just too
lethargic to be able to keep up? Are you tired
of not being able to share the XPerience? Well
the stars have some more bad news for you,
you're outdated and are going to be upgraded
into oblivion; destined to be king of the junk
yard, or a Linux fileserver.

4 Didn’t know you could

mere dil mein hua ek sound,
Lekin aaj tum mili to kehti ho:
Your file not found!

Aisa bhi nahin hai ke,

| don't like your face,

Par dil ke computer mein,
nahin hai enough disk space.

Ghar se nikalti ho tum jab,
pehenke evening gown,

Too many requests se,

ho jaata hai mera server down.

i Tumhaare liye pyaar ki application,

- create main karoonga,
Tum usse debug karna,

—

wait main karoonga.

Tumhaara intezaar karte karte,
main so gaya,

f Yeh dekho mera connection,
time out ho gaya.

bite back!

Your chance to

Highlight the lighter side of computing. Mail your contributions to: Backbyte Digit,

Plot D-222/2, TTC Industrial Area, MIDC, Shirvane, Nerul, Navi Mumbai 400 706 or
e-mail us at backbyte@jasubhai.com
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Submitted by
Harshit Garg
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